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Homepage

The intent of the homepage is to highlight only the most important information to site visitors.
The page has been designed so that it is 100% self-sufficient, requiring no updates by the
Secretariat. If there is a need for a content change, a request needs to be made to the Web
Admin using the Web Admin Change Request process.

The following screenshot illustrates the contents of the Homepage:

ICAN N l GAC NEWS ABOUTTHEGAC GACADVICE MEETINGS & RECORDS WORK EFFORTS

GOVERNMENTAL ADVISORY COMMITTEE
Internet Corporation of Assigned Names and Numbers

/ The GAC serves as the voice of Governmaents and Intermational Oganizations in ICANN's multi-stakeholders representative structure,

Our key role is to provide advice to ICANN on issues of public policy, especially where there may be an interaction between ICANN's activities or
polices and national laws or international aggrements. We discuss issues with the ICANN Boardand other ICANN Supporting Organizations,
Advisory Commiztees and other groupsand deliver regular Advice. About the GAC

IMPACT CURRENT WORK MEMBERSHIP
Over its 17 years history , The GAC has The GAC Is currently engaged in 0 activities There are 171 Members in the GAC.
delivered 55 Communiques &0 spanning 0 topics Membership is constantly evolving, New
Correspondences including a total of 0 pieces Nembers ane alwarys welkkome.
of Advice that help shape intermet policies and These eforts are discussed and executed by
povernance GAL Working Growps prior 1o reaching Neet Our Members and Observers
consencus by the GAC as a whole
Learn about the role of the GAC Learn how to join the GAC
NEWS LUPCOMING VHIETINGS
/ ¢ 21 A Wews & Nefat oy There are ne meetings to show \
Soe 1he GAC Colendiar

ICANN COMMUNITY LEGAL HN

o LY EEE OEE DN
ICANN o

Note the following elements of the Homepage:

o Ecosystem Navigation

e Site Navigation

¢ Introduction / Hero Space: This element includes the page Title and some overview
statements about who the GAC serves and their key role in the ICANN ecosystem.
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e Impact: This element dynamically counts the number of communiques, incoming
correspondences, outgoing correspondences and pieces of advice that are published
publically. Any item set to private will not be represented in this counter. The Learn about
the role of the GAC link navigates end users to the Role of the GAC page within the
About the GAC section of the site.

e Current Work: This element dynamically counts the number of activities and topics that
are published publically. In addition, if the end user is logged into the site, they will see
the counter including private activities and topics.

e Membership: This element is static and gives a count of the number of members that
have joined the GAC. The Members and Observers link navigates the end user to the
GAC Members page, and the Join the GAC link navigates the end user to an instruction
page about how to Join the GAC.

¢ News: This element aggregates Announcements and Notifications dynamically in
reverse chronological order. The See All GAC News & Notifications link navigates end
users to the News page.

¢ Upcoming Meetings: This element aggregates Sessions dynamically in reverse
chronological order. The See the GAC Calendar

e Site Footer

Ecosystem Navigation

The Ecosystem Navigation is the top navigational bar on the site. Currently, it will only provide
navigation within the GAC site until other sites are integrated into the dotCMS platform.

The following screenshot illustrates the contents of the Ecosystem Navigation:

’.\v:?:\ ICANN.org English 4ya) Espafiol Frangais Pyccxun HX S|(eSear(hQ Login/Register {:}

Note the following elements of the Ecosystem Navigation:

e Link to ICANN.org: When ICANN.org is selected, you will be automatically navigated to
https://www.icann.org/

e Language Preference: The user will have the option of selecting one of the following 6
UN languages listed below. When a language preference is selected, the site and its’
navigational elements will display in the language preference selected.

o English

Arabic

Spanish

French

Russian

Chinese

o O O O O
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e Site Search

e Login/Register: This element allows the user to enter their email address and password
to log into the site. If the user has forgotten their password they can select the Password
Help link. If the user does not have a log in, they can select the Join the GAC link.

Password Help

The Password Help link allows GAC Members that have forgotten their password an opportunity to reset
their password so they can continue logging into the website.

The following screenshot illustrates the Password Help link:

§53

< 2 ICANN.org English 4uad Espafiol Frangais PYCCKMH & Login/Register §
ICAN ‘N |GAC NEWS ABOUT THEGAC GACADVI( { Q ICANN ACCOUNT LOGIN 3|
((Q’ EMAIL ADDRESS :
ICANN L |
A ] 4 Al Y h M4 Bl y ‘
GOVERNMENTAL ADVIS PASSWORD
Internet Corporation for Assigne
. . LOGIN
The GAC serves as the voice of Governments and International Governmental Or
| PASSWORD HELP |
Our key role is to provide advice to ICANN on issues of public policy, especially JOIN THE GAC

policies and national laws or international agreements. We discuss issues wi
Advisory Committees and other groups and deliver regular Aavice. ADOUT the GAL

PASSWORD RESET

To reset a password, follow the steps below:

1. Launch the GAC website.
2. Select the Login/Register link in the Ecosystem Navigation.

\ ICANN.org English 4uxa) Espafiol Frangais Pycckmi X ‘:-i:cbmrchq

ICAN N I G A c NEWS ABOUTTHEGAC GACADVICE MEETINGS &RECORDS WORKEFFORTS

GOVERNMENTAL ADVISORY COMMITTEE

3. Select the Password Help link in the ICANN Account Login pop-up.
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ICANN.org

ICA N N | GvA&C NEWS ABOUTTHEGAC GACADVI( ( j ICANN ACCOUNT LOGIN 3]
A—@ EMAIL ADDRESS :
R . -  ICANN Lo |
GOVERNMENTAL ADVIS PASSWORD
Internet Corporation for Assigne
. . LOGIN
The GAC serves as the voice of Governments and International Governmental Or
|PAS$WORD HiLPl
Our key role is to provide advice to ICANN on issues of public policy, especially JOIN THE GAC

policies and national laws or international agreements. We discuss issues wi
Advisory Committees and other groups and delver regular Agvice, ADout the GAL

4. The user will be automatically navigated to the Okta page and prompted to enter their
Email Address / Username to locate their account.

okta

Reset Password

Emall address or username

Back Send Ema

Figure 1: The user must enter the same email address they use to access the GAC website.

5. Once the user enters their email address, select the Send Email button to send the user
an email that contains a link to reset their password.
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okta

Reset Password

Emall address or username

g“(.;

Figure 2: An email will be sent to the user’s email address provide with a link to reset their password. In addition, an email sent
confirmation message will display.

6. Select the Back button to be navigated to the Okta Sign In page.

okta

Email sent!

7. The user will need to access their email, locate the email from Okta and select the link in
the email to reset their password.

8. The user will need to answer their second factor authentication question to proceed with
resetting their password.

9. Once the user answers their second factor authentication they will be prompted to enter
a new password and then enter the new password a second time to confirm it.
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okta

Reset your Okta password

Your password must have at least 12 characters, a
lowercase letter, an uppercase letter, a number, a
symbol, no parts of your username. Your
password cannot be any of your last 10
passwords

Sign Out

10.0Once the New password has been entered and repeated, select the Reset Password
button to reset your password.
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okta

Reset your Okta password
Your password must have at least 12 characters, a
lowercase letter, an uppercase letter, a number, a
symbol, no parts of your username. Your
password cannot be any of your last 10
passwords

Reset Password

Sign Out

11.0nce the Reset Password button has been selected, you will be automatically logged in
and navigated to Okta where you can then select the GAC website.

Join the GAC

The Join the GAC link allows a site visitor to view the Join the GAC page which includes information on
Eligibility, Exchange of Letters, Sample Letter and Translations.

The following screenshot illustrates the Join the GAC link:
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PycCkui X Site Search Login/Register §

ICANN.org

ICANN|GAC

NEWS ABOUT THEGAC GAC ADVI( { ICANN ACCOUNT LOGIN =
A& EMAIL ADDRESS :

GOVERNMENTAL ADVIS PASSWORD:

Internet Corporation for Assigne

LOGIN
The GAC serves as the voice of Governments and International Governmental Or
. i . X X . i PASSWORD HELP
Our key role is to provide advice to ICANN on issues of public policy, especially JOIN THE GAC

policies and national laws or international agreements. We discuss issues wi
Advisory Committees and other groups and deliver regular Agvice. ADoUT the GAL

The following screenshot illustrates the Join the GAC page:

.

JOil'l the GAC G Page Title
Eligibility

Exchange of Letters

Sample Letter

Anchor Links

Join the GAC section

ENQIbility SECtion  s——lp

ICANN.org English “xad Espanol Frangais PyCCKMA 254

ICANN|GAC

NEWS ABOUTTHEGAC GACADVICE MEETINGS &RECORDS WORK EFFORTS

| Join the GAC |

New GAC members are always most welcome.

ICANN relies on its Governmental Advisory Committee (GAC) for guidance and advice to the ICANN Board on
public policy aspects of ICANN's work, particularly with regard to the Internet’s domain name system.

The GAC has 171 governments as Members and 35 Intergovernmental Organizations (IGOs) as Observers,
Membership is open to all national governments and distinct economies. There are no membership fees or
charges.

Eligibility

Members of the GAC must be national governments, multinational governmental organisations and treaty
organisations, or public authorities.

Each may appoint one representative and one alternate representative to the GAC. The accredited representative
of a Member may be accompanied by advisers.

The accredited representative, alternate and advisers must hold a formal official position with the Member’s
public administration. The term ‘official’ includes a holder of an elected governmental office or a person who is
employed by such government, public authority or multinational governmental or treaty organisation, and whose
primary function with such government, public authority or organisation is to develop or influence governmental
or public policies.

For further details about the membership rules, please refer toIAnicle IV of the GAC Operating Principles\l

—
/

Link to Operating Principles
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Exchange of Letters

In order to become a member of the GAC you must:
« Send a signed letter, on official letterhead, addressed to the GAC Chair. A sample letter is provided over the

page.
Exchange of Lottors $¢1i0n em—— « State the name and full contact details of the appointed GAC Representative, The letter may also inform

GAC leadership of a designated alternate Representative and of any designated Advisors,
« Electronically scan the letter and attach it to an email. Send the email zo_csec@ BAC.ICaNN.OTE
The request will be reviewed by the GAC Chair and Vice Chairs,

Once the request has been approved, the person or persons designated as rep, tatives will be added to the
GAC e-mail list, and be provided with access to the Members Only part of the, website.

Secretariat Email link

Sample Letter

[Official Letterhead)

Mr. Thomas Schneider

Chair, Governmental Advisory Committee

Internet Corporation for Assigned Names and Numbers

Sample Letter section =3 | Re: Membership request and nomination of GAC representative(s) on behalf of [national government]
Dear Mr. Schneider,

The [ministry, department or agency] is the national authority of [country or distinct economy with two-letter
code xx] that looks after matters related to Internet governance, including those under the purview of ICANN. The
[ministry, department or agency] formally requests membership to participate in ICANN's Governmental Advisory
Committee (GAC) and is pleased to appoint [GAC Representative name (s)) as the representative(s) on behalf of
[national government).

Please find the relevant point(s) of contact information below:
Prefix or Title:

First name:

Phone 2:
Sincerely,

[Letter to be signed by relevant government minister or senior official with lead responsibility for ICANN/GAC
issues as designated by the requesting national government|]

Note the following elements of the Join the GAC link:

e Page Title: This element is the title of the page
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e Anchor Links: This element is the link that will automatically navigate the user to the
section that corresponds with the selected link

e Join the GAC section: This element provides a brief overview of the GAC

e Eligibility section: This element provides information regarding eligibility for potential
GAC members

e Link to Operating Principles: This element is a link that navigates to the latest publically
published Operating Principles

e Exchange of Letters section: This element is a section that provides potential GAC
members a list of requirements needed in order to become a GAC member

e Secretariat Email link: This element is a link that will allow potential GAC members to
email the Secretariat

e Sample Letter section: This element provides a sample of the letter potential GAC
members need to submit in order to become a GAC member

Site Navigation

The Site Navigation provides links to all the main sections of the site. Each main section has
sub-navigation (sub-sections) that will allow the user to select content that is associated with
each section.

The following screenshot illustrates the contents of the Site Navigation:

ICANN | GAC NEWS ABOUTTHEGAC GACADVICE MEETINGS &RECORDS WORK EFFORTS

Note the following elements of the Site Navigation:

¢ |CANN | GAC link: When this link is selected, the user will be automatically navigated to
the Homepage.

e News: Selecting the News link will automatically navigate you to the News section of the
site where Announcements and Notifications can be viewed.

e About the GAC: Selecting the About the GAC link will automatically navigate you to the
About the GAC section of the site where Role of the GAC, Operating Principles,
Leadership and GAC Members can be viewed. Hovering over the About the GAC
section link will display all sub-sections as well as a Learn More section that will display
the following links:

o Get an Introductions to the DNS: Selecting this link will automatically navigate you
to the http://learn.icann.org/p/the-beginner-s-guide-to-dns page.

o Find Clarification of Terminology: Selecting this link will automatically navigate
you to the https://www.icann.org/resources/pages/glossary-2014-02-03-en page.
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o Learn More About Policy Development: Selecting this link will automatically
navigate you to the https://www.icann.org/policy page.

ICA N N I GAC NEWS ABOUTTHEGAC GACADVICE MEETINGS &RECORDS WORKEFFORTS
Role of The GAC LEARN MORE
Operating Principles Get an Introduction to the DNS
Leadership Find Clarification of Terminology

At anv gi\'cn tim Members & Observers Learn More About Policy Development
a range of issues o
Figure 4: About the GAC section, sub-sections and Learn More section when About The GAC is hovered over

IDURES

e GAC Advice: Selecting the GAC Advice link will automatically navigate you to the GAC
Advice section of the site where Communiqués, Correspondence, ltemized Advice and
Principles & Guidelines can be viewed. Hovering over the GAC Advice section link will
display all sub-sections as well as a Learn More section that will display the following
links:

o Track Board Resolutions: Selecting this link will automatically navigate you to the
https://features.icann.org/resolutions page.

o Explore Topics & Work Efforts Driving GAC Advice: Selecting this link will
automatically navigate you to the ...

o Learn More About Policy Development: Selecting this link will automatically
navigate you to the https://www.icann.org/policy page.

ICAN ‘N | GAC NEWS ABOUTTHEGAC GACADVICE MEETINGS & RECORDS WORK EFFORTS
W Communiqués LEARN MORE
Correspondence Track Board Resolutions
Itemized Advice Explore Topics & Work Efforts Driving GAC Advice

At any given time, the GAC works to ¢ Principles & Guidelines Learn More About Policy Development
a range of issues related to the functi

Figure 5: GAC Advice section, sub-sections and Learn More section when GAC Advice is hovered over

e Meetings & Records: Selecting the Meetings & Records link will automatically navigate
you to the Meetings & Records section of the site where Calendar, ICANN Meeting
Agendas and ICANN Meeting Minutes can be viewed. Hovering over the Meetings &
Records section link will display all sub-sections as well as a Learn More section that will
display the following links:

ICANN |TYPE THE DOCUMENT TITLE | MONTH YEAR | 15



o Attending Your First GAC Meeting: Selecting this link will automatically navigate
you to the https://gacbeta.icann.org/meeting-services/attending-your-first-gac-
meeting page.

o Travel Assistance: Selecting this link will automatically navigate you to the
https://gacbeta.icann.org/meeting-services/travel-assistance page.

o Guidelines For High Level Government Meetings: Selecting this link will
automatically navigate you to the https://gacbeta.icann.org/meeting-
services/quidelines-for-high-level-government-meetings page.

ICA N N | G AC NEWS ABOUTTHEGAC GACADVICE MEETINGS & RECORDS WORK EFFORTS

Calendar LEARN MORE
ICANN Meeting Agendas Attending Your First GAC Meeting
ICANN Meeting Minutes Travel Assistance
At any given time, th Guidelines For High Level Government Meetings

a range of issues rela

Figure 6: Meetings & Records section, sub-sections and Learr; More section when Meetings & Records is hovered over

e Work Efforts: Selecting the Work Efforts link will automatically navigate you to the Work
Efforts section of the site where Work Topics, Activities and GAC Working Groups can
be viewed. Hovering over the Work Efforts section link will display all sub-sections as
well as a Learn More section that will display the following links:

o GAC Working Group Procedures: Selecting this link will automatically navigate
you to the https://gacbeta.icann.org/member-resources/working-group-procedures
page.

o Explore Topics & Work Efforts Driving GAC Advice: Selecting this link will
automatically navigate you to the ...

o Learn More About Policy Development: Selecting this link will automatically
navigate you to the https://www.icann.org/policy page.

ICAN N | GAC NEWS ABOUTTHEGAC GACADVICE MEETINGS &RECORDS WORK EFFORTS

Work Topics LEARN MORE

Activities GAC Working Group Procedures

GAC Working Groups Explore the Topics & Work Efforts Driving GAC Advice
Atany given tim Learn More About Policy Development

arangc ofissues
Figure 7: Work Efforts section, sub-sections and Learn More section when Work Efforts is hovered over
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Site Footer

The Site Footer provides links to several resources that are accessible site wide. If there is a
need for a content change, a request needs to be made to the Web Admin using the Web
Admin Change Request process.

The following screenshot illustrates the contents of the Site Footer:

ICANN COMMUNITY LEGAL HELP
{ ) ICANN H ASO Privacy Policy Site Map
f@ The ICANN Board At-large Cookie Policy Contact The GAC
& ICANN Ombudsman SENSO Terms of Service ICANN Glossary
GNSO ICANN Global Support
- NomCom
ICANN RSSAC
SSAC

Note the following elements of the Site Navigation:

e |CANN section

o ICANN.org (Homepage) link: Selecting this link will automatically open
https://www.icann.org/ site in a separate browser window

o The ICANN Board link: Selecting this link will automatically open
https://www.icann.org/resources/pages/board-of-directors page in a separate
browser window

o ICANN Ombudsman link: Selecting this link will automatically open
https://www.icann.org/ombudsman page in a separate browser window

e Community section

o ASO link: Selecting this link will automatically open https://aso.icann.org/ site in a
separate browser window

o At-large link: Selecting this link will automatically open https://atlarge.icann.org/
site in a separate browser window

o ¢ccNSO link: Selecting this link will automatically open http://ccnso.icann.org/ site
in a separate browser window

o GNSO link: Selecting this link will automatically open http://gnso.icann.org/en/ site
in a separate browser window

o NomCom link: Selecting this link will automatically open
https://www.icann.org/resources/pages/nomcom-2013-12-13-en page in a
separate browser window

o RSSAC link: Selecting this link will automatically open
https://www.icann.org/groups/rssac page in a separate browser window
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o SSAC link: Selecting this link will automatically open

https://www.icann.org/groups/ssac page in a separate browser window
e Legal section

o Privacy Policy link: Selecting this link will automatically open
https://gacbeta.icann.org/legal/privacy-policy page

o Cookie Policy link: Selecting this link will automatically open
https://gacbeta.icann.org/legal/cookie-policy page

o Terms of Service link: Selecting this link will automatically open
https://gacbeta.icann.org/legal/terms-of-service page

e Help section

o Site Map link: Selecting this link will automatically open
https://gacbeta.icann.org/site-map page

o Contact The GAC link: Selecting this link will automatically open your default mail
application and address an email to gac-staff@icann.org

o ICANN Glossary link: Selecting this link will automatically open
https://www.icann.org/resources/pages/glossary-2014-02-03-en page in a
separate browser window

o ICANN Global Support link: Selecting this link will automatically open
https://www.icann.org/resources/pages/customer-support-2015-06-22-en page in
a separate browser window

News

News is comprised of Announcements and Notifications and all are aggregated and display in
the News section for all site visitors to view.

The following screenshot illustrates the contents of the News Index:
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ICANN.org

ICANN|GAC

Include Chechkboxes

NEWS ABOUTTHEGAC GACADVICE

MEETINGS & RECORDS WORK EFFORTS

News Article | Notification

GAC News & Notifications

INCLUDE:
B ArRmiCLES
PUBLISHING NOTIFICATIONS

Anchor Links s———ip

Welcome to our Beta website - Tell us what
you think!

ICANN Holds First Capacity Development
Workshop for Pacific GAC Members

Create GAC Website Training Materials

GAC Elections at ICANNST

Draft survey to GAC Members from all
around the world

ICANNST GAC Meeting Minutes

Announcing New Nominees for GAC
Leadership

Welcome to our Beta website - Tell us what you think!

Welcome to the Beta version of the new GAC website - intended for final public testing before the launch of
the first *real” version of the new website. During this Beta phase, we will be fine-tuning the site’s content,
navigation and layout based on feedback we receive from you, our GAC Member community,

By now, all GAC Members should have received notifications to create their accounts for the website. if you
have not received such a notification, please reach out to your GAC support staff or our tech-support team
at tech-support@icann.org. LOgging on to the site will give you access to GAC Members only content, so be
sure to let us know if you are encountering any issues related to logging on.

NOTE THAT THIS IS NOT THE FINAL VERSION OF THE SITE

You may encounter occasional broken links or error messages. If so, please let us know! This is what the
Beta phase is intended for, and your feedback will enable us to greatly improve the new site,

We are working hard to finalize the new site as quickly as possible and will keep you informed via news
announcements, like this one, on our progress. In the meantime, we hope this Beta site constitutes an
improvement over the previous site and helps show you the direction intended to improve the operational
and organizational parts of the GAC website.

For those who have feedback that they wish to provide on the Beta version, please don't hesitate to reach
out. You can log on to the site and see a Feedback button on the right hand side of the page, or you can

simply send an email to: gac feedback@icann. org.

Happy navigating,

Note the following elements of the News Index:

¢ Include Checkboxes: This element is inclusive of Articles and Publishing Notifications
checkboxes. Selecting Articles will display Announcements and selecting Publishing
Notifications will display Notifications

e Anchor Links: This element is the link that will automatically navigate the user to the
section that corresponds with the selected link

¢ News Articles / Notifications: This is the content that is specified in the Announcement
content and Notification field in specific content

Announcement
The Announcement content allows Secretariats to write and publish custom news

announcements that are not triggered by custom content types so important news items can be

shared on the GAC site.

The following screenshot illustrates the contents of the Announcement:

[Announcement screenshot]
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Note the following elements of the Announcement:

Creating an Announcement

To create Announcement content, follow the steps below:

1. Log into dotCMS Admin
2. Select the Content tab in the top navigation

Site Browser Content
Pages, Folders & Files Manage your Site

& gacdev0 Site Browser

3. Select Announcement - GAC from the Type dropdown list

Observe Site Browser Content
Observe Pages, Folders & Files Manage your Site
- gacdevO Content Search
Type: | Announcement - GAC -
Search:

{ Search v &y Clear Search

4. Select the Add New Content button on the top right

offichal
Search Dateand Create
Ile URA Tithe Time Netification  Last Ednor Last [dit Date

® M us Adex Demo Asnourcerrent ser derre prmeuncenert WIUN016  wue Adex Hatson B 14/2016 B 1M
. Search ~ 2 Oear Search 1: 300

5. Complete the following required fields:
a. Title
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b. URL Title (automatically created based upon the Title)
c. Body
d. Official Date and Time

6. Select Cancel to negate adding the content
Actions

kd Save
& Save / Publish

Assign Workflow

¢ Cancel

OR

Select Save which will save the content and not publish it
Actions

kd Save

& Save / Publish
Assign Workflow

¢ Cancel

OR

Select Save / Publish which will save and publish the content
Actions

kd Save

& Save / Publish

Assign Workflow

¢ Cancel

NOTE:
e Once Save / Publish is selected, the Announcement will be published in the News
section of site.
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e Announcements display in descending order based upon their Publish Date.

Notifications

The Notification content allows the Secretariat to write custom notifications as part of the
publishing process of key content types which allows GAC Members to get quick notifications
when content is created throughout the website. Notifications can be created on the following
content types:

Correspondence Incoming
Correspondence Outgoing
Minutes

File Asset

Activity

Working Group
Communiqué

The following screenshot illustrates the contents of the Announcement:
[Notification screenshot]
Note the following elements of the Notification:

Creating Notifications
To create Notifications content, follow the steps below:

1. Log into dotCMS Admin
2. Select the Content tab in the top navigation

Site Browser Content
Pages, Folders & Files Manage your Site
& gacdev0 Site Browser

3. Select Content (Generic), Correspondence Incoming — GAC, Correspondence
Outgoing — GAC, Minutes — GAC, File Asset, Activity - GAC, Communiqué — GAC
or Working Group — GAC from the Type dropdown list
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Observe Site Browser Content
Observe Pages, Folders & Files Manage your Site
& gacdevO Content Search
Type: | Minutes - GAd [ ~]
Search:

{ Search ~ &y Clear Search

4. Select the Add New Content button on the top right

& oscdevd ) Content Search Change She |~
]
Tyse: [Minutes - GAG = Powing 1-24 of 24 Export 8
Offical
Search Privacy Sreale Oate and
Titie URL Thie Setling  Notification  Time Aast Edher Aast BN Date
- —— = n T —— - (o uS This & test Jrd now this-is-test- 3rd-nov Pabic true ;Z'.;\l:.;J‘.L GAC Secretariat LU/V2016 2:58M
5. Complete the required fields (headings in red) for the content type selected
6. Select the Yes radio button under the Create Notification heading
I |
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Observe Site Browser Content
Observe Pages, Folders & Files Manage your Site
& gacdev0 Content Search Add/Edit Minutes - GAC
Content

&1 Minutes - GAC

WiEnglish (US) >
p

Workflow . L:

Step: Initial State

Assignee: Nobody Privacy Setting:
(@ Private
() Public
Actions
kd Save Create Notification:
& Save / Publish ® No
O Yes

Acclnn Warkbflau

7. Select Cancel to negate adding the content
Actions

kd Save
& Save / Publish

Assign Workflow

¢ Cancel

OR

Select Save which will save the content and not publish it
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Actions

kd Save

& Save / Publish
Assign Workflow

& Cancel

OR

Select Save / Publish which will save and publish the content
Actions

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE:

e Once Save / Publish is selected, the Announcement will be published in the News
section of site.

¢ Notifications display in descending order based upon their Publish Date.

e Communiqué — GAC will always automatically create a Notification.

¢ A Notification can be created for content that has already been published by selecting
the content in question and selecting the Yes radio button under the “Create
Notification” heading.

About the GAC

The intent of About the GAC is to organize all content that fall under About the GAC as a
category of content. The major content included within About the GAC includes:

Role of the GAC
Operating Principles
Leadership & Support
GAC Members
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Introduction Header

The Introduction Header is meant to orient site visitors to the About the GAC page and give
them a basic understanding of who the GAC is and what they do.

The following screenshot illustrates the contents of the About the GAC Introduction:

ICANN | GAC NEWS ABOUTTHEGAC GACADVICE MEETINGS &RECORDS WORK EFFORTS

About the GAC/®]

The GAC is an advisory committee to .
ICANN, created under the ICANN By Laws. It o y ]
provides advice o ICANN on EN'N: |‘lli(’[\1 @ LEARN.ICANNORG \
aspects of ICANN'S  responsibilitios  wit - : - s
/ regard to the Internet Domain Name System ‘II‘II-'\RD\:It(\).l(l(l)(ls\‘:\:“\:}k(())l\\‘\I\; INTHE
DNS). The GAC is not a decision-making | | ~"Sce e 1 ‘ - '

body. It advises ICANN on issues that are | | G2 \
Within KA AP LEARN MORE ABOUT POLICY
DEVELOPMENT

GET AN INTRODUCTION TO THE DNS

Note the following elements of the About the GAC Introduction:

¢ Introduction Text: This element is a brief informational section that informs the user of
the GAC
¢ Introduction Links: This element links to resources to help educate the user about DNS,
ICANN Terminology & Policy Development. The links and destinations are listed below:
o Get an introduction to the DNS @ Learn.ICANN.org: Selecting this link will
automatically open http://learn.icann.org/ page
o Find clarification of terminology @ acronyms in the glossary: Selecting this link
will automatically open https://www.icann.org/resources/pages/glossary-2014-02-
03-en page
o Learn more about policy development: Selecting this link will automatically open
https://www.icann.org/policy page
e Collapse Introduction: Selecting “X” will collapse the Introduction section

e Expand Introduction: Selecting “i” will expand the Introduction section

Updating the Introduction Header

To update the Introduction Header content, follow the steps below:
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Log into dotCMS Admin.
2. Click the Site Browser tab from the top navigation.

Site Browser Content
Pages, Folders & Files Manage your Site

Figure 34: Navigating to the Site Browser page within the Admin site will show all the editable pages that you are able to modify.

3. From the Observe page, from within the left pane, click on the about folder.
Site Browser ‘c:-:um
@ Fconed Site Rrowser Change Sihte
Sites and Folders M Englsh (US) - + ASd New ~
‘9 gecevd Name Meny  Status Mod User Mod. Date
 leadership-and-sepoort - W (on_US) About the GAL AmE Mits 10 ™~
actrery " members - B (0n_US) About the GAC Devesn Sarwar
advce " role-of-sre-gac ® A N (en US) About the GAC Mare S
sgendes " iedes . B (0n_US) About the GAC Marc Saivaserrs
epdication

4. Double click the index html page in the right pane to open the

page.
Site Browser Content
Pages, Fokders & Fles  Marage your Ste
@ seccend Site Rrowser Change Site
Sites and Folders W Englsh (US) - + Add New ~
‘9 gectevd Name Meny  Status Mod User Mod. Date
2 sbout = leadership-ard-svpoont - W (on_US) About the GAC At Mits 10, P~
actiety T members - W (o0 _US) About the GAC Devesh Satwar
edvie = role-ofsre-gac ® A  N(en US) About the GAC "
sgendes E] B B (0n_US) About the GAC

epdication

Figure 3: Double clicking index from the right pane will open the page in its Live Editor which allows the Secretariat to modify the
contents of this page.

5. From the live editor mode, select Lock for Editing

Preview Live

{4, Lock for Editing
@ Publish Page

=2 Remote Publish Page
& Add To Bundle

6. Select the Edit Content button on the content section that needs editing
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The GAC is an advisory committec—

GET AN INTRODUCTION TO

A J il CANN
to ACANN, jerested ‘under the) ICANN BSryp hNS @ LEARNIGANN.ORG

ByLaws. It provides advice to ICANN on

public  policy aspects of ICANN’s
responsibilities with regard to the Internet
Domain Name System (DNS). The GAC is not
a decision-making body. It advises ICANN on

FIND CLARIFICATION OF
TERMINOLOGY @ ACRONYMS IN THE
GLOSSARY

issues that are within ICANN’s scope. THIS
SHOULD BE SAME HEADER FOR ALL
ABOUT THE GAC TABS..

LEARN MORE ABOUT POLICY
DEVELOPMENT ABOUT THE GAC
INTRO

Figure 4: Clicking the Edit Content button will open a text editor that allows the Secretariat to change the contents of the
Introduction section.

7. After clicking Edit Content, the editor will be displayed. Lock the page for editing by
clicking on Lock for Editing under the Actions menu.

Home m lcwm Content

Tanka A Ceshdoad e idena A F Manage your Ste
Gicbal Page pacdev Site Browner Add/Eanr Content (Generic)
Comtent History

£ Content (Generi)
Tithe:
Wi English (US)
About The GAC intro text

Waorkflow
URL Titte:
Shepe el Ste about-the-gac-intro-text
Assignee: Nobody
Topic
Actions Click Mere to Select Categories
[ § Lock for Edting ]
&« Cancel Sody:
File~ Edt+ st~ Vew~> Fomat~ Tools~

Fomats~ B 7 ¥ & E X A B - -3 A ® E & &2 v~

Tho GAC s an adviscry commitioe 10 ICANN, created under the ICANN ByLaws. & provides advice 10 ICANN on pubdc polcy aspocts
ICANN'S responsidiities with regand 10 e Imemet Domain Name System (DNS). The GAC is not a dedision-making body FMDGAMM
S that are within ICANN'S scepe. THIS SHOULD BE SAME HEADER FOR ALL ABOUT THE GAC TABS.

8. Modify only the Body editor’s content as shown by the figure below.
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Home Site Browser Content
Tasks & Cushoa~d  Pages, folders & Fles  Manage your Ste

& Gicbal Pege pacdev0 Site Browser Add/Edn Content (Generic)
Comtent History

& Content (Generk)

Tithes

W Enghish (US) »
About The GAC intro text

Waorkflow

URL Tithe:

e about-the-gac-intro-text

Assignee: Nobody

Topic:
Actions Click Mere to Sefect Categories

A Lock for Edting
Body:

& Cancel
Fila~ Edt~ Inset~ Vew~ Format~ Toos ~

Fomats~ B /7 VU & E X A B - -3 A W E &L &2 -
The GAC s an advisory commitioe 10 ICANN, created under the ICANN ByLaws. & provides advice 1o ICANN on pubdc polcy aspocts of

ICANN'S fesponsidiitios with fegand 1 e Inemet Domain Name System (DNS). The GAC is not a decision-making body. it asvises ICANN en
Baues that are within ICANN'S scepe. THIS SHOULD BE SAME HEADER FOR ALL ABOUT THE GAC TABS.

Site Browser Content
Tesis & Danstboard  Pages, Foiders & files  Masage your Ste

& Giodel Page gecdevd Ste Browser Add/tdit Content (Generic)
Content History

£ Content (Generic)

Title:
W Enghsh (US) -2
About The GAC Intro links
Workfow
URL Title:
Step: [nitlal State DR he-Qac-intro-links
Assignee: Nobody
Locked: GAC Secretanat Tople:
Seconds Ag:
Click Here to Select Categories
Actions
Body:

o Refesse Lock

o Seve Fle> Edt~ Iset~ View~ Fomat~ Tools ~

@ Seve/Pudisn fomats~ B /7 Y S5 E X 3 B E-E-3 A ® & L 2 v~
Assign Work®ow

& Concel

9. Once the edits have been made, you can either select Cancel to negate the edits.

e —
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Actions

i’ Release Lock
kd Save
& Save/ Publish

Assign Workflow

& Cancel

OR

Select Save which will save the edits and not publish them.
Actions

i’ Release Lock

kd Save

& Save/ Publish
Assign Workflow

& Cancel

OR

Select Save / Publish which will save and publish the edits.

Actions

i’ Release Lock

kd Save
& Save/ Publish

Assign Workflow

& Cancel

10. Select Release Lock to release the lock on the content.

e ——
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Edit Preview Live

|. £ Release Lock |

@ Publish Page

> Remote Publish Page

& Add To Bundle
Assign Workflow

NOTE: Once Save / Publish is selected, the Introduction Header content will be published in the
About the GAC section of the site.

Role of the GAC

The intent of the Role of the GAC page is to give a high-level overview of the why, what and
how the GAC operates. It is written with the newcomer in mind. The Role of the GAC page is
the default page within the About the GAC section of the site. Therefore, if a user clicks on
About the GAC from the site navigation, or browses to “/about” they will be defaulted to the
Role of the GAC page.

The following screenshot illustrates the contents of the Role of the GAC page:

Role of the GAC Operating Principles Leadership  GAC Members

GAC advice has a particular status under the ICANN ByLaws. Its advice must be duly taken into account by the ICANN Board, and where the Board proposes actions
inconsistent with GAC advice it must give reasons for doing so and attempt to reach a mutually acceptable solution.

The GAC appoints a non-voting liaison to the ICANN Board. This is normally the GAC Chair,
Why does ICANN have a Governmental Advisory Committee?

ICANN Is a multi-stakeholder entity in which governments need to participate alongside the domain names industry, the technical community, business and non-
commercial users, and civil soclety. The GAC was established in 1999, in parallel with ICANNs first public meetings, and has operated continuously since then.

ICANN looks to the GAC for advice on public policy aspects of specific issues for which ICANN has responsibility. This is an important dimension of ICANN's work.
How does the GAC operate?

The GAC determines its own operating procedures and these are set out in the GAC Operating Principles. GAC face-to-face meetings are held in conjunction with ICANN
meetings, which currently occur three times a year,

Advice from the GAC to ICANN is determined on the basis of consensus. Advice is conveyed to the ICANN Board, usually in the form of a communiqué issued at the end of
each GAC meeting. Each communiqué and the minutes of GAC meetings are made available online.

The GAC also works inter-sessionally on priority issues, usually via teleconferencing. In addition, working groups are used to focus on particular areas such as working
methods and issues for future gTLDs,

The work of the GAC is supported by a dedicated Secretariat provided by ACIG (an independent consulting firm) and by ICANN staff.

What are the benefits of GAC Membership?
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The Internet domain name system is a key part of critical Internet infrastructure for the global digital economy. Governments and inter-governmental organisations (IGOs)
who participate through the GAC benefit from:

The opportunity to provide advice direct to the ICANN Board on public policy aspects of the operation of the Internet domain name system.
Contributing at an early stage of ICANN’s policy development processes to ensure consistency with laws and public interest.

Access to face to face meetings and online discussion with other GAC members and observers, including national governments and inter-governmental
organisations, which inform development of GAC advice.

Access to relevant subject matter experts within the GAC and across ICANN, enabling GAC members to remain informed about technical innovation in the domain
name system and its future evolution.

Updating the Role of the GAC

The contents of the Role of the GAC page is managed by the Secretariat. The following steps
highlight the process by which the secretariat may update the Role of the GAC page:

1. Log into dotCMS Admin.
2. Click the Site Browser tab from the top navigation.

Site Browser Content
Pages, Folders & Files Manage your Site

& gacdev0 Site Browser

Figure 5: Navigating to the Site Browser page within the Admin site will show all the editable pages that you are able to modify.

3. On the Site Browser tab, within the left pane, click on the about folder.

Marage s Ste

o Gacoeed Site Browser

Sites and Folders

W Englsh (US) -
‘9 gecdevd Name Meny  Status
IE T leadership-and-svppon - - About the G
» activey = members B ™ (e b he GA
advice " role-of-sre-gac - - (e Abx
agerdas " irdes . - (e About the G
spphcation

Figure 6: Clicking the about folder in the left pane will show the folders contents in the right pane. Notice that it includes the role-
of-the-gac html file.

4. Double click the role-of-the-gac html page in the right pane to open the live editor
interface for the page.
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Site Browser Content
Pages, Folders & Fles  Marage your Ste
& Gacond Site Browser
Sites and Folders W Englsh (US) -
9 gaccevd Name Meny  Status Mod Mser
1 sbout T leadership-and-svpoort . S (en_US) About the GAC Ame Miss
- activy T members . W (o0 _US) About the GAC Devesh Satwan
advce L J B (en_US) About the GAC Mare Saivetierrs
2] agerdas " o . B (on_US) About the GAC Marc Satvatierrs OS/12/2016 0F: 14: 04 PN
epsication

Figure 7: Double clicking role-of-the-gac from the right pane will open the page in its Live Editor which allows the secretariat to
modify the contents of this page.

5. From the live editor mode, select Lock for Editing.

Preview Live

(4 Lock for Editing

& Publish Page
= Remote Publish Page
& Add To Bundle

6. Click on the Edit Content button in the Body of the page.
. toe | Preview I Une . Role of the GAC Operating Principles Leadership  GAC Members

Release Lock

4
Asd Cortent
@ P Page —+ -

ASt3n WorsAgw

GAC advice has a particular status under the ICANN ByLaws. its advice must be duly taken into account by the ICANN Board, and where the Board proposes actions
& Page Propertes inconsistent with GAC advice it must give reasons for doing 50 and attempt to reach a mutually acceptable solution,

M Mo Stansmes The GAC appoints a non-voting liaison 1o the CANN Board. This is normally the GAC Chair,

% Create New Page Why does ICANN have a Governmental Advisory Committee?

ICANN is a multi-stakeholder entity in which governments need to participate alongside the domain names industry, the technical community, business and non-

Viewing as
commercial users, and civil society, The GAC was established in 1999, in paraliel with ICANN's first public meetings, and has operated continuously since then,
ICANN locks to the GAC for advice on public policy aspects of specific isswes for which ICANN has responsibiity, This is an important dimension of ICANN's work,
How does the GAC operate?
Oalouk Vishor hd The GAC determines its own operating procedures and these are set out in the GAC Operating Principles. GAC face-to-face meetings are held in conjunction with
ICANN meetings, which currently occur three times a year,
W Enghsh (US) -

Advice from the GAC to ICANN is determined on the basis of consensus, Advice is conveyed 10 the ICANN Board, usually in the form of a communiqué issued at the
end of each GAC meeting. Each communiqué and the minutes of GAC meetings are made avallable online.

& Admin Screen The GAC also works inter-sessionally on priority ssues, usually via teleconferencing. in addition, working groups are used to focus on particular areas such as working
methods and issues for Aature gTLDS,

The work of the GAC is supported by a dedicated Secretariat peovided by ACIG (an independ: Iting firm) and by ICANN stalf,

NOTE: It is important to click the correct Edit Content button. There are several on the
page, and the secretariat must know which one they are clicking on, as indicated by the
Edit Content button closest to the content you wish to edit.
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7. Once the editor is displayed, select Lock for Editing.

Site Browser Content
Pages, Folders & Fies  Marage your Se

o Global Page pacdev0 She Begwser Add/Bax Content (Ganeric)

Content  Mistory  References

Tithe:
&1 Content (Generic)
- The Role of the GAC
M English (US) -

URL Tithe:
Workflow the-role-of-the-gac

Step: Intial State

T ]

Assignee! Nooody ople
Clck Here to Sefect Categories

Actions

Body:

I_j Lack for Edting
Flo~ Eft~ Insat~ Vew~ Format~ Tools ~

Fomets~ B /7 ¥ & E X A B =-i-3 B W E & 2 -~

GAC aavice has a partiodlar status under the ICANN ByLaws. Its advice must be auly taken o account by the ICANN Boand, and where e
Board proposes BCSons INConsistent with GAC asvice It must Give reasons for doing S0 and Rempt 15 reach & ssutually soceptable solution.
The GAC appoints a non-voiing Salson 1o the ICANN Board. This is normally the GAC Chawr.

Why does ICANN have a Governmental Advisory Committee?

ICANN Is 2 mult-stakehoider entily In which 9o the domain names industry, the Sechnical commenty,
Dusiness and non-commercial users, and o sockety. TNGAC-.MGHM n paralicl with ICANN's first pubio meetings, and
Pas cpenied contisucusly since then.

ICANN looks %0 the GAC for advice on public poicy aspects of specific issues for which ICANN has responsitity. This is an important
dmension of ICANN's work.

How does the GAC operate?

@ Cancel

8. Once the page is locked for editing, modify only the Body editor’s content as shown by
the figure below.

Site Browser Content
Pages, Fosders & Fles  Manape your e

o Godel Page Qacoevd Ste Browser Add/ Edit Coment (Generic)

Content History References

Title:

%) Content (Generic)
The Role of the GAC

W Enghsh (US) -

URL Title:
Workflow the-role-of -the-gac

Step: Initial State
Tople:

Assignes: Nobody
Locked: GAC Secretanat

Qlick Here to Select Categories

Body:
> Rt o Fle* Edt~ Iset~ View> Fomat~ Tools~
of Refease
B e fomats~ B 7/ YU S E E 3 B E-E-3 W ® E L B v~
@ Save / Pusisn ICANN locks 10 the GAC for advice 0n public policy spocts of Spoclic issues for which ICANN has responsbiity. This is an imponast
- dimansion of ICANN'S work
Assign Workfow
PO How does the GAC operate?
The GAC determines its own operaing procedures and these are set out in he GAC Operating Principles. GAC face-10-face meetings are

Mnmmn}\mmmmmmman
Advice fom the GAC 10 ICANN is determined on the basis of consansus. Advice is conveyod 10 the ICANN Board, usualy in the form of a
ComMuniué suod i the end of each GAC meeting. Each communiqué and the minutes of GAC meetings are made avalable online.
The GAC also works imer-sossionally on priorily Issues, wsually via teleconferencing. n adason, working roups ane wsed 10 focus on
partioular areas such as working methods and issues for future gTLDs.

bya [ by ACIG (an % frm) and by ICANN staft

The work of e GAC &
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NOTE: When populating the Body, please use H2 tags for new sections and paragraph
text for the rest of the content.

9. Once the edits have been made, you can either select Cancel to negate the edits.
Actions

Release Lock
kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will save the edits and not publish them.
Actions

Release Lock

kd Save

& Save / Publish
Assign Workflow

& Cancel

OR

Select Save / Publish which will save and publish the edits.
Actions

Release Lock

kd Save

& Save / Publish

Assign Workflow

& Cancel

10. Select Release Lock to release the lock on the content.
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Edit Preview Live

[ £ Release Lockl

Publish Page
Remote Publish Page

Add To Bundle

By @

Assign Workflow

NOTE: Once Save / Publish is selected, the Role of the GAC content will be published in the
About the GAC section of the site.

Operating Principles

This is content will be updated from time to time that presents the Operating Principles that the
GAC follows. This is an official document of the GAC and can be presented privately/publicly. In
addition, historical versions of the public document will be maintained as new versions are
published. The most recent public version will display when the Operating Principles title is
selected and the title of the most recent Operating Principles will display in the Edition
dropdown box. Past public versions of Operating Principles can be selected from the Edition
dropdown box.

The following screenshot illustrates the contents of the Role of the GAC page:
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Role of the GAC Operating Principles Leadership GAC Members

EDITION
CURRENT: 16 MAY 2016 | ¢&—EN

Send for Translation

[Operating Principles| +——
l()l)l‘:R.\'l‘l.\(; I’Rl.\(:“’l,l‘:S]

Article | - Scope of the Governmental
Advisory Committee
\ Article Il - Meetings Article I - Scope of the Governmental Advisory Committee

Article NI - Agenda
Principle1
Article IV - Membership
The Governmental Advisory Committee (GAC) shall consider and provide advice on the
activities of ICANN as they relate to concerns of governments, multinational governmental
Article VI - Representation organisations and treaty organisations, and distinet economies as recognised in
international fora, including matters where there may be an interaction between ICANN's
policics and various kaws and international agreements and public policy objectives,

Article V - Observers

Article VIl - Chair, Vice Chairs, Other Officers
and Committees

Article VIII - Powers of the Chair Principle 2

Article IX - Blection of Chair and Vice Chairs The GAC shall provide advice and communicate issues and views to the ICANN Board,

Article X - Conduct of Business The GAC is not a decision making body. Such advice given by the GAC shall be withouwt
prejudice to the responsibilitics of any public authority with regard 1o the bodies and
Asticle XI - The Secretariat activities of ICANN, induding the Supporting Organisations and Coundils,

Note the following elements of the Ecosystem Navigation:

Edition Dropdown: This element is the dropdown list allows you to select other published
Operating Principles

Send for Translation Button: This element is the button will package the html page and
prepare it to be translated

Title: This element is the title specified in the Title field when creating the Operating
Principles content

Ratified Date: This element is the date specified in the Ratified Date field when creating
the Operating Principles content

PDF Link: This element is the link that will allow the user to view and download the
Operating Principles as a PDF and then print

Anchor Links: This element is the link that will automatically navigate the user to the
section that corresponds with the selected link

Operating Principles Text: This element is the text specified in the Document Sections
related to the Operating Principles

Creating Operating Principles
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To create Operating Principles content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Site Browser
Pages, Folders & Files

& gacdev0

Content
Manage your Site

Site Browser

3. Select Operating Principles - GAC from the Type dropdown list

Site Browser Content
Pages, Fokders & Mies  Marage v
@ secoevd Content Search Change Ste [~

+ Add New Comtent =

showing 1-1 of 1 Expoet )

Ratified Official Date Privacy Bedirect Sache
Search Title Date and Time Setting L VAL I Last Editor Laat Edit Date

. B (en_US Qperatng S16/2016  &/1/2018 Dt ceratng Avet Mt 1/1/2016 712160

) 00AM cpes

, Search * #§ Cear Search
showing 1 -1 0of 1 | pages 1
Advanced

Figure 8: Clicking the operating-principles folder in the left pane will show the folders contents in the right pane. Notice that it
includes a list of Operating Principles.

4. Select the Add New Content button on the top right

Site Browser Content
Pagen, Folders & Mies  Marage v

@ secoend Content Search

Rntified Official Date Privacy Bedirect Sache
Search Title Date and Time Setting L VAL I Last Editor Laat Edit Date

. B (en_US Qperatng S16/2016  &/1/2018 Dt ceratng Avet Mt 1/1/2016 712160

OAM cpes

, Search * #§ Cear Search
showing 1 -1 0of 1 | pages 1
Advanced

5. Complete the following required fields:
a. Title
b. Official Date and Time
c. Privacy Setting (defaults to Private)
d. Url (automatically created based upon the Title)
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Site Browser Content
Page, Fokders & Mies  Marage your Ste

& secoevd Cortert Seerch Add/tdn Operating Principles - GAC

Content

™ Operating Principles - GAC

i Enghish (US) -

Waorkflow
Ratified Date!
Step: Inval State

Assignee: Nobody

Official Date and Time:
Actions

 Save
& Save/ Pubish Privacy Setting:

® Private

Assign Workflow
Public

& Cancel

6. Select Cancel to negate adding the content
Actions

kd Save
& Save / Publish

Assign Workflow

¢ Cancel

OR

Select Save which will save the content and not publish it

Actions

kd Save

& Save / Publish
Assign Workflow

¢ Cancel

OR

Select Save / Publish which will save and publish the content

Change Shte |+
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Actions

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Operating Principles will be published in the About
the GAC section of site.

Relating Content to Operating Principles
After the Operating Principles content has been created and published, the Secretariat can

relate Document Sections to the Operating Principles which will allow them to add a free-form
section that they can used to add documentation / information as needed.

RELATING NEW CONTENT TO OPERATING PRINCIPLES

To relate new Document Sections to Operating Principles, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Site Browser tab from the top navigation.

Site Browser Content
Pages, Folders & Files Manage your Site
& gacdev0 Site Browser

Figure 9: Navigating to the Site Browser page within the Admin site will show all the editable pages that you are able to modify.

3. On the Site Browser tab, within the left pane, click on the operating-principles folder.
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Site Browser Content
Pages, foiders & Fies  Manage your Ste
@ oscdev0 Site Browser

Sites and Folders

Briefs
content. Qereric- migrated

flie-asset

Aews-ronficatons

presentations

PO Pes-ard-guOees

W English (US)
Name

Sparating-principies

Menw  Status

B (en_US) Operating Mincip

Crange She [+

& ASd New ~
Mod, Date

11/01/2016 07:23:11 MM

o Show Archives

Figure 52: Clicking the operating-principles folder in the left pane will show the folders contents in the right pane. Notice that it
includes a list of Operating Principles.

4. Double click the Operating Principles Name in the right pane to open the live editor

interface for the page.

Site Browser Content
Pages, foiders & Fies  Manage your Ste
@ oscdev0 Site Browser

Sites and Folders

Briefy
content. Qereric- migrated
fle-asset

home

presentations

PO Pes-ard-guOees

W English (US)

Name

Menw  Status

B (en_US) Operating Mincip

s

Mad. User

Crange She [+

& ASd New ~
Mod, Date

o Show Archives

Figure 53: Double clicking the Operating Principles Name from the right pane will open the page in its Live Editor which allows the
Secretariat to modify the contents of this page.

5. From the live editor mode, first lock the page for editing.
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Preview Live

{4 Lock for Editing

& Publish Page
= Remote Publish Page
& Add To Bundle

6. Select the Add Content button on the page.

e | proview | Uve Role of the GAC Operating Principles Leadership GAC Members
i Retoane Lock P
@ Nouh Pege
B A0 Yo Buncle [CURRENT: 16 MAY 2016 :]

Assign Workflow

st Taniaion ¢ [rmrema]
A Poor stasatics Operating Principles I1GAC
Lot Template

Ratified May 2016
15 Create New Page

) POF OPERATING PRINCIPLES

Viewing s
Article | - Scope of the Governmental
Advisory Committee Mayaees
Article Il - Meetings
tae Coeme (A} i)

Article Il - Agenda

e ' ‘ , Article I - Scope of the Governmental Advisory Committee
Article IV - Membership .

W Onghsh (US) -

Article V - Observers Principlc 1

@ ASmin Screen Article VI - Representation

The Governmental Advisory Committee (GAC) shall consider and provide adviee on the
Article VII - Chalr, Vice Chairs, Other Officers activithes of CANN as they refate to concerns of governments, multinational governmental
and Committees organisations and treaty onganisations, and distinet cconomics as recognised in
internationad fora, including matters where there may be an interaction between ICANN's
policies and various laws and international agreements and public policy objectives.

Article VIII - Powers of the Chair

7. Select New Content from the Add Content dropdown.
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Eon | Preview | Uve

Retease Lo

Pubish Page

Ben

AdS To Bundie

2a5)n WoreThyw

Page Properties

»

A Teoe Sumstics
fot Templae

% Create New Page

Viewng a3

Defauk Vistor

W Enghsh (US)

@ Azmin Sceen

Role of the GAC

Send for Transiation
Operating Principles

Ratified May 2016
(9 poF
Article | ~ Scope of the Governmental
Advisory Committee
Article Il - Meetings
Article Il - Agenda
Article IV -« Membership
Article V - Observers

Article VI - Representation

Article VIl - Chair, Vice Chairs, Other Officers

and Committees

Article VIIl - Powers of the Chair

Operating Principles Leadership GAC Members

EDITION

[ CURRENT: 16 MAY 2016

i 4 Aad Content

—
GAC Te=e—_]

G Aot waagm

OPERATING PRINCIPLES "

[0

Article I - Scope of the Governmental Advisory Committee

Principle 1

The Governmental Advisory Committee (GAC shall consider and provide advice on the
activitics of KCANN as they relate to concerns of governments, multinational governmental
onganisations and treaty organisations, and distinet cconomies as recognised in
international fora, including matters where there may be an interaction between ICANN's
policies and various laws and intermational agreements and public policy objectives,

8. Complete the following fields of the Document Section to populate the Operating

Principles:
a. Title
b. Body

Site Browser Content
Pages, Foiders & Fies  Manage your Ste
& oscdev0 Site Browner
Content

+ . Document Section

Wi Enghsh (US)

Workflow

Step: [nitial State

Assignes: Nobody

Actions

l Seve
Assion Workfow

& Cancel

9. Select Cancel to negate adding the content.

Add/Ednr Document Section

ICANN |TYPE THE DOCUMENT TITLE | MONTH YEAR

Change Site |~
Tithe:
Body:
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Actions

kd Save
& Save / Publish

Assign Workflow

¢ Cancel

OR

Select Save which will save the content and not publish it
Actions

kd Save

& Save / Publish
Assign Workflow

¢ Cancel

OR

Select Save / Publish which will save and publish the content
Actions

kd Save

& Save / Publish

Assign Workflow

¢ Cancel

NOTE: Once Save / Publish is selected, the Document Section will be created and display in
the Operating Principles content.

RELATING EXISTING CONTENT TO OPERATING PRINCIPLES

To relate existing Document Sections to Operating Principles, follow the steps below:
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Log into dotCMS Admin.
2. Click the Site Browser tab from the top navigation.

Site Browser Content
Pages, Folders & Files Manage your Site

& gacdev0 Site Browser
Figure 10: Navigating to the Site Browser page within the Admin site will show all the editable pages that you are able to modify.

3. On the Site Browser tab, within the left pane, click on the operating-principles folder.

Site Browser Content

Pages, foiders & Fies  Manage your Ske

@ osctev0 Ste Browser Change Shte [+

Sites and Folders W Erglish (US) - & ASd New ~

Briefs Name Menw  Status Mad. User Mod, Date
CORANt-Qanaric-migrated T operating-princigles B W (en_US) Operating rincisles Arrat vtte 11/01/2016 07:21:11 MM
e asset
Bome
mages
on i-l Srom Archived

ROJUIE MANDJE Services

anguage-managed-servi

eou!

Meeting-senvices

meetingn records

MeMDer-resouwrces

minstes

Al rOOTCatons

| eperating-priaciples

presentabions

priacipies-and-guiceines
Figure 52: Clicking the operating-principles folder in the left pane will show the folders contents in the right pane. Notice that it
includes a list of Operating Principles.

4. Double click the Operating Principles Name in the right pane to open the live editor
interface for the page.
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Figure 53: Double clicking the Operating Principles Name from the right pane will open the page in its Live Editor which allows the
Secretariat to modify the contents of this page.

5. From the live editor mode, first lock the page for editing.

Preview Live

Se

Lock for Editing

:
-

@& Publish Page
= Remote Publish Page
& Add To Bundle

6. Select the Add Content button on the page.
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Lot Template
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Ratified May 2016

] PDF
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Article Il - Agenda

Article IV - Membership

Article V - Observers

Article VI - Representation

Article VIl - Chalr, Vice Chairs, Other Officers

and Committees

Article VIII - Powers of the Chair

Operating Principles Leadership GAC Members

IDITION

[ CURRENT: 16 MAY 2016 :]

:

GA(

OPERATING PRINCIPLES

J tax Cavemne Allv)im)

Article I - Scope of the Governmental Advisory Committee

Principlc 1

The Governmental Advisory Committee (GAC) shall consider and provide adviee on the
activithes of CANN as they refate to concerns of governments, multinational governmental
organisations and treaty onganisations, and distinet cconomics as recognised in
internationad fora, including matters where there may be an interaction between ICANN's
policies and various laws and international agreements and public policy objectives.

7. Select Reuse Content from the Add Content dropdown.

£ Retease Lok
@ POk Fage
B Ads To Buncie

Aaskyn WO ow

Page Properties

»

A Teoe Stamstics

£t Templyte

% Create New Page

Defask Vister

o Enghsh (US)

@ Azmin Screen

Role of the GAC

Send for Transiation
Operating Principles

Ratified May 2016
(9 por
Article | - Scope of the Governmental
Advisory Committee
Article Il - Meetings
Article Il - Agenda
Article IV - Membership
Article V - Observers

Article VI - Representation

Article VIl - Chair, Vice Chairs, Other Officers

and Committees

Article VIl - Powers of the Chair

Operating Principles Leadership GAC Members

EDITION
l CURRENT: 16 MAY 2016

OPERATING PRINCIPLES "~

Article I - Scope of the Governmental Advisory Committee

Principle 1

The Governmental Advisory Committee (GAC) shall consider and provide advice on the
activitics of KCANN as they relate to conoerns of governments, multinational gosernmental
onganisations and treaty organisations, and distinet economies as recognised in
International fora, including matters where there may be an interaction between ICANN's
policics and various laws and intermational agreements and public policy objectives,

8. Once the Search pop-up displays, select the Search button at the bottom of the Search
pop-up to execute your search or select the Clear Search button to clear your search

criteria.
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Search: Document Section

Content Type: Document Section

Language | 5 -

Title:
Body:

Host Folder: -

[ A Scarch] I‘r Clear Search l

Figure 11: You can refine your search by entering additional criteria in the Search pop-up and then selecting the Search button

9. Once the search results display, click the Select button to select the content you would
like to reuse.

Search: Document Section

Content Type: Document Section Matching Results (204)

Language Title URL Title
Language - X
SELECT "4 English (US) Laura’s new section laura-s-new-section
s v-enh, - -
Title SELECT Wl English (US) IV. Enhancing ICANN Accountability v-enhancing-icann
accountability
Body: SELECT S English (US) 1. Introduction i~introduction
- - . vil-gac-advice-to-the
- slieh ( y M e n o
Host Folder: = SELECT i English (US) VII. GAC Advice to the Board board
11. Inter-Constituency A ties & l-inter-constituency-
. inter- st ACLivith
\ Search| @ Clear Search SELECT ™M English (US) ey activities-community-

Community Engagement
engagement

NOTE: Once Save / Publish is selected, the Document Section will be related to the Operating
Principles and it will be published in the About the GAC section of site.

Updating Operating Principles
To update the Operating Principles content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Site Browser Content
Pages, Folders & Files Manage your Site

& gacdev0 Site Browser

3. Select Operating Principles - GAC from the Type dropdown list.
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Site Browser Content
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& sectev Content Search
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\ Search + 4 Clear Search

Advanced
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= Add New Content ~

Figure 12: Clicking the operating-principles folder in the left pane will show the folders contents in the right pane. Notice that it

includes a list of Operating Principles.

4. Double click the Operating Principles Name in the right pane to open the live editor

interface for the page.

Site Browser Content
Foges

Foders & Fles  Manage your Sne

@ 9sev0

showing 1-1 of 1

{ Search ~ & Ciear Search

Advanced

Expoet )
Antified offichal Date Privacy Redirect  Cache
Dats and Time Setting L) VAL I Last Editor Laat Edit Date
162016 6172018 Pt Cerating Asvet et 117172016 71210
12:00AM sCpes
showing 1 -1 0of 1 | pages 1
Change Ste |v)
+ Add New Content ~
Export )
Ratified Official Date Privasy Redirect  Cache
and Time Setting un Uy m Last Ednor Last £dit Cate
Subac cperating Amit Metal 11/1/2016 7:210M

12:00AM procipies

showing 1 <1 0of 1 | pages 1

Figure 13: Double clicking the Operating Principles Name from the right pane will open the page in its Live Editor which allows the

Secretariat to modify the contents of this page.

NOTE: You can sort the Operating Principles Name column (ascending or descending)

by clicking on the column heading.

5. Select Page Properties to access the content backend so the content properties can be

modified.
Preview Live
Lock for Editing

Publish Page

Remote Publish Page

By O»

Add To Bundle

What's Changed?

I;.‘

I 4 Page Propeniesl

Page Statistics

Create New Page

ol
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6. After clicking Page Properties, the editor will be displayed. Lock the page for editing by
clicking on Lock for Editing under the Actions menu.

Actions

2 Lock for Editing

& Cancel

7. Modify any of the following fields:
a. Title
b. Ratified Date
c. Official Date and Time
d. Privacy Setting
e. Friendly Name

Site Browser Content
Pagen, Foiders & Nien Marage o
Gicbal Page pacdev0 Contertt Search Add/tdit Operating Priaciples - GAC
Content History
Tithe:
™ Operating Principles - GAC
Operating Principles
Wi English (US) .
Ratified Date:
Waorkflow
2016 -
Step: Intal Szate

Assignee: Nobody
Locked: GAC Secretarist

Official Date and Time:

6/1/2015 * 12 AM
Actions Privacy Setting:
Private
£ Release Lock @ Public
w3 Save
@ Save/ Publsh Urh
operating-principles

Aswign Workflow

8. Once the edits have been made, you can either select Cancel to negate the edits

Actions

Release Lock

Save

-

Save / Publish

Assign Workflow

Friendly Name:

Operating Principles

Cancel
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OR

Select Save which will save the edits and not publish them

Actions

Release Lock

kd Save

& Save / Publish
Assign Workflow

& Cancel

OR

Select Save / Publish which will save and publish the edits

Actions

Release Lock

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Operating Principles will be published in the About
the GAC section of the site.

Leadership

This is content that shows the community who current leaders are, who past leaders were, what
functions the leaders do, about how leaders are selected, how to learn about nominees for
leaders and how to vote for nominees. Members of the GAC community will have the ability to
view current and past leadership roles and individuals that filled those roles so they are aware
organizational structure of the GAC. When an individual Leaderships name/profile picture is
selected, they will be navigated to that user's public profile page.

The following screenshot illustrates the contents of the Leadership page:
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Role of the GAC Operating Principles Leadership GAC Members

IGAC Leadership & Support |

N

GAC Leadership Tise The GAC is an advisory committee to ICANN, created under the ICANN ByLaws. It provides advice to ICANN on
public policy aspects of ICANN's responsibilities with regard to the Internet Domain Name System (DNS).
Current Officers
Section Header | The GAC is not a decision-making body. It advises ICANN on issues that are within ICANN's scope.
Election / Nomination
GAC advice has a particular status under the ICANN ByLaws. Its advice must be duly taken into account by the
Former Leadership Secton Content |ICANN Board, and where the Board proposes actions inconsistent with GAC advice it must give reasons for doing
so and attempt to reach a mutually acceptable solution.
ICANN Support
~ |The GAC appoints a non-voting liaison to the ICANN Board. This is normally the GAC Chair.
Independent Secretariat Support| /<hortinks
Current Officers
GAC Chair Vice Chairs
Olga Cavalli ARGENTINA
GAC VICE-CHAIR, OCT 2014 - PRESENT
o Henri Kassen NAMIBIA
A e GAC VICE-CHAIR, OCT 2014 - PRESENT
Gema Campillos SPAIN
GAC VICE-CHAIR, OCT 2014 - PRESENT
Thomas Schneider
GALC Chair Name, Country, TIe & Tenung s——————l SWITZERLAND Wlmkkhknpm THAILAND
[GAC CHAIR, OCT 2014 - PRESENT GAC VICE-CHAIR, OCT 2014 - PRESENT
Mr. Schneider is the deputy director of
international affairs and the international
information society coordinator at the Swiss
Federal Office of Communication (OFCOM) in the
Swiss Federal Department of the Environment,
Transport, Energy and Communications (DETEC).
GAC Chist IIrmation se—— N Vice Chairs Photos Vice Chairs Name, Country, Tite & Tenure
ares He s an expert in internet governance and in - ’ - " Country. T & T
information society issues, in particular
media/new media regulation, human rights and
consumer protection. He has been coordinating
the Swiss activities and positions related to the UN
World Summit on the Information Society (WSIS)
and internet governance issues since 2003.
ICANN Support
. ___________________________________________________________________________________________| .|
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ICANN Suppart Informatice

ICANN Support Sta¥ Names, Ties

Roles & Emals

—_—

—

Independen Secratanal Suppont

Names, Titles & Emalls

The GAC receives support in its work from a team made up of ICANN staff as well as the Australian Continuous
Improvement Group (ACIG). Working together, these staff provide a range of services to all GAC members and
observers, including organising meetings, briefing, website and email administration, liaison with ICANN and
provide travel support. They are available and more than willing to provide help to any GAC members with the
following support:

Maintaining the GAC mailing list and membership records

Managing incoming and outgoing correspondence for the GAC Chair

Administration of the GAC website

Arranging the translation of nominated GAC documents

Co-ordinating the arrangements for formal GAC meetings including room bookings, liaison with hosts and
technical support

* Making arrangements for inter-sessional GAC meetings including call set-up and administration

For quickest response, please contact GAC ICANN Support at: gac-staff@icann.org

ICANN Support Staff

Olaf Nordling, ICANN SENIOR DIRECTOR, GAC Julia Charvolen, LEAD ADMINISTRATOR, GAC
RELATIONS SERVICES

olaf.nordling@icann.org julia.charvolen@icann.org

Fabien Betremieux, ICANN GAC RELATIONS Gulten Tepe, COORDINATOR, GAC SERVICES
ADVISORY Iten.t: cann.

fabien.betremieux@icann.org

Independent Secretariat Support

ACIG is an independent consulting firm engaged by the GAC to provide additional secretariat support to ICANN's
Governmental Advisory Committee. ACIG's services are currently funded by three GAC members: Norway, the
Netherlands and Brazil. However, the ACIG team reports directly to the GAC Chair,

The ACIG GAC Secretariat works in co-operation with ICANN support staff to the GAC, the GAC Chair and Vice
Chairs. Some of the ACIG's main tasks include:

« Preparing and distributing agendas, briefing or summary papers, and other preliminary material to support
the formal GAC meetings

Providing support to the GAC Chair during GAC meetings

Providing support and advice to the GAC Leadership Team, GAC members, and to the GAC working groups
during the time between GAC's face to face meetings.

Continuously reviewing and improving the way GAC operates

Providing support and assistance to new GAC members

Independent Secretariat Support Staff

Michelle Scott Tucker, ACIG LEAD

michelle@acig.com.au
Tom Dale, ACIG SECRETARIAT SUPPORT

tom@acig.com.au

Tracey Hind, ACIG SECRETARIAT SUPPORT
tracey@acig.com.au >

Note the following elements of the Leadership page:

Title: This element is the title of the Leadership content type.

Section Header: This element is the title of the section headers.

Section Content: This element is the free-form content of each section.

Anchor Links: This element is the links that will automatically navigate the user to the

section that corresponds with the selected link.
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e GAC Chair Photo: This element is the photo of the GAC Chair that has been attached to
the Leadership content.

e GAC Chair Name, Country, Title & Tenure: This element is the GAC Chair Name,
Country, Title & Tenure specified on the Leadership content.

e GAC Chair Information: This element is the free-form GAC Chair information specified
on the Leadership content.

¢ Vice Chairs Photos: This element is the photo of the GAC Vice Chairs that have been
attached to the Leadership content.

¢ Vice Chairs Name, Country, Title & Tenure: This element is the GAC Vice Chairs
Names, Countries, Titles & Tenures specified on the Leadership content.

e |CANN Support Information: This element is the free-form ICANN Support information
specified on the Leadership content.

¢ |CANN Support Staff Names, Titles, Roles & Emails: This element is the ICANN Support
Staff Names, Titles, Roles & Emails specified on the Leadership content.

¢ Independent Secretariat Support Information: This element is the free-form Independent
Secretariat Support information specified on the Leadership content.

¢ Independent Secretariat Support Names, Titles & Emails: This element is the
Independent Secretariat Support Names, Titles & Emails specified on the Leadership
content.

Updating Leadership

To update the Leadership content, a request will need to be sent to the Web Administration
team.

GAC Members

This content displays all the current member states and observer organizations within the GAC
and who (user profiles) represents those members with links to those user's profile pages.

The following screenshot illustrates the contents of the GAC Members page:
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Role ofthe GAC  Operating Principles  Leadership =~ GAC Members

INCLUDE: s Lok ——p- [AT)[ABCDEFGHIJKLMNOPQRSTUVWYZ| 4— *
tor sy | MEMBER STATES & TERRITORIES
) OBSERVER ORGANIZATIONS Country tion H

Afghanistan

SAC Mermber Sir 10 e | GAC MEMBER SINCE: | [FOPULATION: 33370] IUN:Mtp:l/ww.al‘hanlsun-un.org]
Representatives: T T

MuhammadAimalMarjanni GAC Momber Poputat

Ministry of Communications and IT, \

Director General ICT GAC Member Reoresentative Emad Link

I [Bamms] — waer

African Telecommunications Union

GAC MEMBER SINCE: MEMBERSHIP: UN: hge:llltu-uu.oi_"!
Representatives:

Abdoulkarim Soumaila =<

African Telecommunications Union,
Secretary General of the ATU

Back to Top

Note the following elements of the GAC Members page:

e Includes Filter: This element is the filter that allows the user to filter between Member
States & Territories and Observer Organizations.

e All Link: This element is a link that allows the user to view all members on the GAC
Members page.

e Alphabetic Link: This element is a link that allows the user to view members based upon
the first letter of the Member Country.

e Member Country Section Header: This element is the section that displays the Member
Countries name.

e GAC Member Since Date: This element is the date the Member Country has been a
member of the GAC since.

e GAC Member Population: This element is the population of the Member Country.

e GAC Member UN Website Link: This element is a link to the Member Countries UN
website.

e GAC Member Representative(s) Information: This element is the GAC Member
Representative(s) Name and Title.




e GAC Member Representative Email Link: This element is the Email Link to the GAC
Member Representative that will automatically open the users default mail application
and automatically populate the GAC Member Representatives email address in the To
field.

e Back to Top Link: This element is a link that will navigate the user back to the top of the
page when selected.

Updating GAC Members

To update the GAC Members content, a request will need to be sent to the Web Administration
team.

GAC Advice

The GAC Advice section of the site represents a place where site visitors can find GAC Advice
to the Board, Incoming Correspondences to the GAC and Outgoing Correspondences from the
GAC. The maijor content included within GAC Advice includes:

Communiqués
Correspondence
Itemized Advice
Principles & Guidelines

Introduction Header

The Introduction Header is meant to orient site visitors to the GAC Advice page and give them
a basic understanding of GAC Advice and their related artifacts.

The following screenshot illustrates the contents of the About the GAC Introduction:
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GAC Advice[®]
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an interaction between ICANNs policics and ICANN ADVICE TRACKER
public. ";';‘.; international agreements 48| | EXPLORE THE TOPICS & WORK

communicated to the ICANN Board through | | EFFORTS DRIVING GAC ADVICE

ey ;'_,‘,:;;‘E” hue or 4 formal piece of| | | EARN MORE ABOUT POLICY
provides you with full access 1o both types of DEVELOPMENT @ K ’\T\'()R('
GAC Advice as well as the comprehensive
historical Nst of GAC advice provided to the
Board and links connecting that advice to its

outcome using the ICANN Board Advice
Registry wol.

Note the following elements of the About the GAC Introduction:

¢ Introduction Text: This element is a brief informational section that informs the user of
the GAC Advice

¢ Introduction Links: This element links to resources to help educate the user about Board
responses to Advice, Topics & Work Efforts pertaining to GAC Advice and Policy
Development at ICANN. The links and destinations are listed below:

o Track Board responses in the ICANN Advice Tracker: Selecting this link will
automatically open https://www.icann.org/ site.

o Explore the Topics & Work Efforts driving GAC Advice: Selecting this link will
automatically open https://dotcms-staging.icann.org/work-efforts/work-topics
page.

o Learn more about Policy Development @ ICANN.org: Selecting this link will
automatically open https://www.icann.org/policy page.

e Collapse Introduction: Selecting “X” will collapse the Introduction section
e Expand Introduction: Selecting “i” will expand the Introduction section

Updating the Introduction Header

To update the Introduction Header content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Site Browser tab from the top navigation.
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Site Browser Content
Pages, Folders & Files Manage your Site

& gacdev0 Site Browser

Figure 14: Navigating to the Site Browser page within the Admin site will show all the editable pages that you are able to modify.

3. On the Site Browser page, within the left pane, click on the advice folder.

W 9ciev0 Site Browser Change Site -~
Sites and Folders W Engish (US) - & Add New ~
9 oacdend Name Meny  Status Mad. Usar Mod, Date
L .G**.h cormespondence
—
- o T o . W (on_US) Inde Arrit Mizza 11/03/2016 06:15:40 PM
GMTapendence F atvke - W (o US) Advice Arvit Mimta O/07/2016 11:23:07 PM
Rerrired
Figure 35: Clicking the advice folder in the left pane will show the folders contents in the right pane. Notice that it includes the
index html file.
4. Double click the index html page in the right pane to open the live editor interface for the
page.
W 9ciev0 Site Browser Change Site -~
Sites and Folders W Englsh (US) . & Add New ~
9 oacdend Name Meny  Status Mad. Usar Mod, Date
.G“.h corespondence
L edvice Remized
TR . W (on_US) Index Arrit Mizts 11J03/2016 06:15:40 PM
correspondence » advice ° W (on_US) Advice Arvit Mty O7/07/2016 $1:23:07 PM
Rerrired

Figure 36: Double clicking index from the right pane will open the page in its Live Editor which allows the Secretariat to modify the
contents of this page.

5. From the live editor mode, first lock the page for editing.

Preview Live

{4, Lock for Editing

@& Publish Page
=2 Remote Publish Page
& Add To Bundle

6. Click on the Edit Content button in the part of the Introduction section that needs to be
edited.
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The GAC provides advice to the

ICANN Board on policy matters where there
may be an interaction between ICANN’s
policics and various laws, international
agreements and public policy objectives. GAC
Advice is communicated to the ICANN Board
through either a Communique or a formal
picce of Correspondence. This area of the
website provides you with full access to both
types of GAC Advice as well as the
comprehensive historical list of GAC advice
provided to the Board and links connecting
that advice to its outcome using the ICANN
Board Advice Registry tool. * GAC ADVICE
HEADER *

TRACK BOARD RESPONSES IN L

THE ICANN ADVICE TRACKER

EXPLORE THE TOPICS & WORK
EFFORTS DRIVING GAC ADVICE

LEARN MORE ABOUT POLICY
DEVELOPMENT @ ICANN.ORG * GAC
ADVICE HEADER **

Figure 38: Clicking the Edit Content button will open a text editor that allows the Secretariat to change the contents of the

Introduction section.

7. After clicking Edit Content, the editor will be displayed. Lock the page for editing by

clicking on Lock for Editing under the Actions menu.

Actions

& Lock for Editing

& Cancel

8. Modify only the Body editor’s content as shown by the figure below.
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Observe Site Browser Content
Pages, Folders & Fles  Manage your Site

Cbserve
W Global Page gocdevd Site Browser Add/Edit Content (Generic)
Content  History
£ Content (Generic)
Title:
Wi English (US) -
GAC Advice Intro Text
Workflow
URL Title:
it Inith
s gac-advice-intro-text
Assignee: Nobody

Locked: GAC Secretariat :

(Seconds Ago)

Actions

o Release Lock

o Seve

& Save/ Publish
Assign Workflow

Body:
File~ Edit~ Insert~ View~ Format~ Tools~
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mmtﬂwmwwm GAC Advice is communicated to the ICANN Board through either a Communique or a
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historical kst of GAC advice peovided 10 the Board and links connecting that acvice 10 its oulcome wusing the ICANN Board

COMPrahensive
Advice Registry 1ool, ** GAC ADVICE HEADER 14-Now ecit™

& Cancel

Observe Site Browser Content

Observe
v Global Page gacdev)
Content History

& Content (Generic)

WiEnglish (US)

Workflow
Step: Initial State
Assignee: Nobody

Pages, Folders & Flles  Manage your Ske
Ske Browser Add/Edit Content (Generic)

Title:

GAC Advice Intro Links

URL Title:
gac-advice-intro-links

Locked: GAC Secretariat : |Body:
Fle~ Edit~v Insertv View~ Fomat~v Tools ~
Actions
Ffomats- B / VU & E ¥ 3 B - -3 3 ® & L 2 -
o Reiease Lock
TRACK BOARD RESPONSES IN THE ICANN ADVICE TRACKER.
d Save
EXPLORE THE TOPICS & WORK EFFORTS DRIVING GAC ADVICE
& Save /[ Publish an e an 5 o A
o Assign Workflow )
& Cancel
9. Once the edits have been made, you can either select Cancel to negate the edits.
I L}
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Actions

kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will save the edits and not publish them.
Actions

kd Save

& Save / Publish
Assign Workflow

& Cancel

OR

Select Save / Publish which will save and publish the edits.

Actions

kd Save

& Save / Publish

Assign Workflow

¢ Cancel

10. Select Release Lock to release the lock on the content.
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Release Lock

@ Publish Page
& Remote Publish Page

Add To Bundle

',

Assign Workflow

Communiqué

The Communiqué content is a formal document that the GAC creates that details the important
information coming out of their sessions during an ICANN meeting that the GAC wishes to
convey to the Board. DotCMS allows the GAC to leverage the power of the CMS to facilitate the
capture of their Advice in a more structured format so that it can lead a more comprehensive
process of presenting the Communiqué to the Board in a way that can be actionable, traceable
and speaks from a single source of the truth. DotCMS also assists the Secretariat role in
creating new Communiqués, laying out the structure of the Communiqué, authoring the content
of the Communiqué as well as facilitating the presentation of the Communiqué to the right
audiences (private / public). The Secretariat will be able to relate Advice and Sessions to a
Communiqué so information from the related Advice and Sessions display in the Communiqué.

The following screenshot illustrates the contents of the Communiqué:
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/ Mecting with the ICANN Board

The GAC st with the ICANN Boand and discussoct

Note the following elements of the Communiqué:

Communiqué Title: This element is the title specified in the Title field when creating the
Communiqué content

View as a PDF: This element is the link that will allow the user to view and download the
Communiqué as a PDF and then print

Anchor Links: This element is the link that will automatically navigate the user to the
section that corresponds with the selected link

Edition Dropdown List: This element is the dropdown list allows you to select other
published Communiqués

Communiqué: This element is the view of the published Communiqué

Main Section Headers: This element is the section headers that correspond with the
Anchor Links

Section Content: This element is the content that displays in each section

Creating a Communiqué

To create new Communiqué content, follow the steps below:

1.

Log into dotCMS Admin.

2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site

& gacdevO Site Browser
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3. Select Communique - GAC from the Type dropdown list.

Observe Site Browser Content
Observe Pages, Folders & Files Manage your Site
& gacdev0 Content Search
Type:  Communique - GAC -
Search:

4 Search ~ | &y Clear Search

4. Select the Add New Content button on the top right.

Observe  Site Browser Contant
serve Poges, Folders & fies M veur Ste

& oscdevd Content Search

Tvoe —— = showe 40 of

Offcia
Search Pate and Privacy SCreate
Title Location Time Setting  Motificetion  Tempiste
oA Wienus Test L4th now Tormar 1I/I4206  pubic true
\ Search ~ 2 Clear Search 5:00PM

5. Complete the following required fields:
a. Title
b. Official Date and Time
c. Privacy Setting (defaults to Private)
d. Url (automatically created based upon the Title)

hange Site -

o ASd New Contert | ~

Export &

Redirect Sache
umy m Last £dt
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Obsarve  Site Browser Content

Ctmerve Poges, Folders & fies  Macage your Ste

& secoed Cortent Search

Content

= Communique - GAC

MIEngish (US) -

Workflow

Step: Inval State
Assignee! Nobody

Actions

b Save
& Save/ Publish
Assign Workfiow

@ Cancel

Add/tat Communique - GAC

Location!

Official Date and Tiene:

& Private

Public

Create Notification:

. Yo

url:

6. Select Cancel to negate adding the content

Actions

kd Save

& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will save the content and not publish it

Actions

kd Save

& Save / Publish

Assign Workflow

& Cancel

OR
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Select Save / Publish which will save and publish the content

Actions

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Communiqué will be published in the GAC Advice
section of site.

Relating Content to a Communiqué

After the Communiqué content has been created and published, the Secretariat will can relate
Advice and Sessions to a Communiqué so information from the related Advice and Sessions
display in the Communiqué. In addition to Advice and Sessions, the Secretariat will can relate
Document Sections to the Communiqué which will allow them to add a free-form section that
they can used to add documentation / information as needed.

RELATING NEW CONTENT TO A COMMUNIQUE

To relate new Advice, Sessions and Document Sections to a Communiqué, follow the steps
below:

1. Log into dotCMS Admin.
2. Click the Site Browser tab from the top navigation.

Site Browser Content
Pages, Folders & Files Manage your Site

& gacdev0 Site Browser
Figure 51: Navigating to the Site Browser page within the Admin site will show all the editable pages that you are able to modify.

3. On the Site Browser page, within the left pane, click on the communiques folder.
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Site Browser Content
Pages, Foucers & Fles  Marage your Se
& oscden0 Site Browser

Sites and Folders

£ oscsevo N
stout private
ooty public
' advice ICANNSS -GAC Commungue
MCANNST-GAC Commungue
0 rivete adex
pubC
comespondence
Rersired

W Engish (US)

Meny  Status

Y (on_US) 0O

. (o U

W (e LS

5) ICANNST GAC ©

ot

ANNSS GAL Co

ommanc,

Mad. Usar

Figure 52: Clicking the communiques folder in the left pane will show the folders contents in the right pane. Notice that it includes

a list of Communiqueés.

4. Double click the Communiqué Name in the right pane to open the live editor interface

for the page.

Site Browser Content
Pages, Foucers & Fles  Marage your Se
& oscden0 Site Browser

Sites and Folders

W Engish (US) >
£ oscsevo N
stout private
vty pablc
advice ICANNSS -GAC Commungue
~ . communiques MCANNST-GAC Commungue
servete " woe
pubC
comespondence
Rersired

Figure 53: Double clicking the Communiqué Name from the right pane will open the page in its Live Editor which allows the

Secretariat to modify the contents of this page.

5. From the live editor mode, first lock the page for editing.

Preview Live

Lock for Editing

(S

@& Publish Page

=2 Remote Publish Page
& Add To Bundle

6. Select the Add Content button on the page.
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ton | prevew | Lve Communiqués Correspondence Itemized Advice Principles & Guidelines
£ Release Lock

& Nutiah Page EDITION

B A2 To Duncle [ICANNSOGAC(OMMUNDQUE :]

2350 o ow

@ oot Properses Send for Translation PRIVATE: GAC Members Only

ICANNS58 GAC Communique

ot Terrglate N one

5 Create New Page

I. Introduction

j— e e s ICANNS8 GAC COMMUNIQUE

Commwunity Engagement

I, Internal Matters
Copenhagen, Denmark, 15 March 2017
V. Enhancing ICANN Accountability

-

ey - V. Other Issues
V1. GAC Consensus Advice to the Board I. Introduction
W Cngish (US) -
TOmE peusse: The Governmental Advisory Commiittee (GAC) of the Internet Corporation for Assigned
W Acrria Screes Accountability & Tramgarency Names and Numbers  TCANN) met in Copenhagen, Denmark from 1 1o 16 March 2017,

59 GAC Members and 12 Obscrvers attended the mecting,

7. Select New Content from the Add Content dropdown.

I tat | Preview | Lve . Communiqués Correspondence Itemized Advice Principles & Guidelines
€ Reloase Lock
@ Posn Page EDITION:
B A% To Bunce l ICANNSS GAC COMMUNIQUE :I

Astige Workfow

@ Pege Prepernes Send for Translation PRIVATE: GAC Members Only

& Poos statiscs ICANNS8 GAC Communique

£t Temglate \ one

T Create New Page

1. Introduction

e et ———— ICANNS8 GAC COMMUNIQUE

Community Engagement
1. Internal Matters

Copenhagen, Denmark, 15 March 2017
IV. Enhancing ICANN Accountability

V. Other Issues

V1. GAC Consensus Advice to the Board L. Introduction

& Add Contertt

W Cngheh (US) -

TOPICS DISCUSSED: The Governmental Advisory Committee (GAC) of the Internet Corporation for Assigned
@ Aoen Screes Acceuntabiity & Transsarency Names and Numbers (TCANN ' met in Copenhagen, Denmark from 11 to 16 March 2017,

8. An Add New Content pop-up will display allowing you to add a Session, Advice or a
Document Section.

Add New Content X

Advice - GAC
Document Section
Session - GAC
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9. Click on the content type you would like to add from within the Add New Content pop-up.

10. Complete the required fields (headings in red) for the content type selected.

a. Document Section: This content does not have required fields however, the Title
and Body must be completed so the Document Section added has a Title and
support text (Body)

b. Session

i. Title
ii. URL Title (automatically created based upon the Title)
iii. Type (defaults to GAC Meeting)
iv. Status (defaults to Open)
v. Privacy Setting (defaults to Private)
vi. Time Zone (defaults to: UTC+00:00 Coordinated Universal Time (UTC))
vii. Official Date and Time
c. Advice
i. Title
i. URL Title (automatically created based upon the Title)
iii. Privacy Setting (defaults to Private)
iv. Consensus Setting (defaults to Consensus)
v. Official Date and Time
vi. Advice Statement
vii. Rationale
viii. Reference Number

11.Select Cancel to negate adding the content.

Actions

kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will save the content and not publish it
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Actions

kd Save

& Save / Publish
Assign Workflow

& Cancel

OR

Select Save / Publish which will save and publish the content
Actions

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE:

e Once Save / Publish is selected, the Communiqué will be published in the GAC Advice
section of site.

e Selecting Session or Advice will create a piece of Session or Advice content that is
attached to the Communiqué but is also independently accessible and will display in
their respective site sections.

e Selecting Document Section will create a Document Section in the Communiqué, not an
independently accessible piece of content.

RELATING EXISTING CONTENT TO A COMMUNIQUE
To relate existing Advice, Sessions and Document Sections to a Communiqué, follow the steps
below:

1. Log into dotCMS Admin.
2. Click the Site Browser tab from the top navigation.
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Site Browser
Pages, Folders & Files

& gacdev0

Content
Manage your Site

Site Browser

Figure 51: Navigating to the Site Browser page within the Admin site will show all the editable pages that you are able to modify.

3. On the Site Browser page, within the left pane, click on the communiques folder.

Site Browser Content

S Fies  Manage your Soe
@ oscien0 Site Browser
Sites and Folders

atout

Comespondence

Rersired

W Engish (US

Name

private

pablic

CANNSS -GAC -Communaue
SCANNS 7 -GAC Commungue

* o

Menu  Status

Mod. Usar

Change Site [+

& Add New ~

Mod. Date

Figure 52: Clicking the communiques folder in the left pane will show the folders contents in the right pane. Notice that it includes

a list of Communiqueés.

4. Double click the Communiqué Name in the right pane to open the live editor interface

for the page.

Site Browser Content

AFles  Marage your S0

& 9sciev0 Site Browser
Sites and Folders

avout
vty
advice
. communiques
srivete
B
CoTespondence

Rersired

Figure 53: Double clicking the Communiqué Name from the right pane will open the page in its Live Editor which allows the

W Engish (US

Name

private

pablic

CANNSS -GAC -Communaue

MCANNS 7 -GAC Commungue

* o

Secretariat to modify the contents of this page.

NOTE: You can sort the Communiqué Name column (ascending or descending) by

clicking on the column heading.

5. From the live editor mode, first lock the page for editing.
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Preview Live

Se

Lock for Editing

:
-

@& Publish Page
= Remote Publish Page
& Add To Bundle

6. Select the Add Content button on the page.

Communiqués Correspondence Itemized Advice Principles & Guidelines

@ "utmh Pege EDETION

[mnsamcounumquz :]

Send for Translation PRIVATE: GAC Members Only
ICANNS58 GAC Communique

3 one P
-
I. Introduction

Viewing a5 IL Inter-Constituency Activities &

B oo ICANN38 GAC COMMUNIQUE

I, Internal Matters

Copenhagen, Denmark, 15 March 2017
V. Enhancing ICANN Accountability
V. Other Issues

g — L]
Defaut Vator -

V1. GAC Comsensus Advice to the Board L. Introduction

TOPICS DISCUSSED:

The Governmental Advisory Committee (GAC) of the Internet Corporation for Assigned
@ Afrmis Screen Acsountability & Transgarensy

Names and Numbers TCANN) met in Copenhagen, Denmark from 11 to 16 March 2017,

59 GAC Members and 12 Obscrvers attended the mecting,

7. Select Reuse Content from the Add Content dropdown.
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Communiqués

Correspondence Itemized Advice

Principles & Guidelines

£ " EDITION:
® "
| 20 [nunuuwcouuumqut :]
Assgn Workfiom
Send for Transiation PRIVATE: GAC Members Only
ICANNS8 GAC Communique
3 one
L o Add Content
B Come New Foge L Introduction T2 e ot
I Inter-Constituency Activities & A TN = A (" N Q N Z]
— p—— ICANN38 GAC COMMUNIQUE ==
WL Internal Matters
Copenhagen, Denmark, 15 March 2017 =
. Enhancing ICANN Accountability
V. Other Issues — ot
VL. GAC Consensus Advice to the Board I. Introduction
- Enghsh .

TOPICS DISCUSSED:

The Govermmental Advisory Committee (GAC) of the Internet Corporation for Assigned
Acsountability & Transpacency

Names and Numbers  TCANN) met in Copenhagen, Denmark from 11 to 16 March 207

59 GAC Members and 12 Obscrvers attendded the mecting.

8. Once the Search pop-up displays, select Session, Advice or Document Section from
the Content Type dropdown.

Search: Advice - GAC

Content Type: | Advice - GAQ -
Advice - GAC
Language Document Section
Session - GAC
Title:
Host Folder: -
Privacy Private
Setting: Public
Consensus Consensus
Setting: Non-Consensus
Advice
Statement:
Rationale:
Migrated
Advice:

9. Select the Search button at the bottom of the Search pop-up to execute your search or
select the Clear Search button to clear your search criteria.
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Search: Advice - GAC

riivayvy

Setting:

Consensus
Setting:

Advice
Statement:

Rationale:

Migrated
Advice:

GAC:

rivawe

Public

Consensus
Non-Consensus

+

Accountabllity & Transparency
+ ATRT 1

4+ ATRT 2

+ ATRT 3

4+ ATRT 4

+ AoC Review

+ CCT Review

+ Specific Reviews

+ WHOIS Review

I -4, Search I If Clear Search ]

Figure 15: You can refine your search by entering additional criteria in the Search pop-up and then selecting the Search button.

10.Once the search results display, click the Select button to select the content you would
like to reuse.

Search: Advice - GAC

Fiiveyy

Setting:

Consensus
Setting:

Advice
Statement:

Rationale:

Migrated
Advice:

GAC:

riwvew

Public

Consensus
Non-Consensus

+ Accountability & Transparency
+ ATRT 1
+ ATRT 2
+ ATRT 3
+ ATRT 4
+ AoC Review
+ CCT Review
+ Specific Reviews
+ WHOIS Review

@ Clear Search

Matching Results (173)

Language
Sl English (US)
SELECT Sl English (US)
SELECT | ™l English (US)
SELECT W English (US)

Title

2017-03-15 2-
Character
Country/Territory
Codes at the
Second Level

2017-03-15 IGO
Protections

2017-03-15
Mitigation of
Domain Name
Abuse

2017-03-15
Protection of the
Red Cross and
Red Crescent

URL Title

2017-03-15-
2-character-
country-
territory-
codes-at-the-
second-level

2017-03-15-
igo-
protections

2017-03-15-
mitigation-of-
domain-
name-abuse

2017-03-15-

protection-of-
the-red-cross-

and-red-

Privacy
Setting

public

public

public

private

Consensus
Setting

consensus

consensus

consensus

consensus

NOTE: Once Save / Publish is selected, the Document Section, Advice and Session will be
related to the Communiqué and it will be published in the Advice section of site.
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Updating Communiqué

To update Communiqué content, follow the steps below:

1. Log into dotCMS Admin.

2. Click the Site Browser tab from the top navigation.

Site Browser Content
Pages, Folders & Files Manage your Site

& gacdev0 Site Browser

Figure 51: Navigating to the Site Browser page within the Admin site will show all the editable pages that you are able to modify.

3. On the Site Browser page, within the left pane, click on the communiques folder.

Site Browser Content
soes, Facers & Fles  Manage your §
& oscden0 Site Drowser
Sites and Folders W Engish (US) -
g o0 Name
sbout privane
vty patic
advice = IKCANNSS -GAC Commungue
" sou? G Commne
. servete -
Index
B
comespondence
Rersired

Meny  Status

Mod, Unar

Change Site [+

o+ Add New ~

Mod. Date

Figure 52: Clicking the communiques folder in the left pane will show the folders contents in the right pane. Notice that it includes

a list of Communiqueés.

4. Double click the Communiqué Name in the right pane to open the live editor interface

for the page.

Site Browser Content
soen, Focers & Fles  Marage your §
& oscden0 Site Drowser
Sites and Folders W Engish (US) .
g o0 Name
stout privane
vty public
advice = IKCANNSS -GAC Commungue
B communiques T ICANNST-GAC-Communigue
servete -
Index
B
comespondence
Rersired

Meny  Status

Mod, Unar

Change Site [+

o+ Add New ~

Mod. Date

Figure 53: Double clicking the Communiqué Name from the right pane will open the page in its Live Editor which allows the

Secretariat to modify the contents of this page.

NOTE: You can sort the Communiqué Name column (ascending or descending) by

clicking on the column heading.
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5. Select Page Properties to access the content backend so the content properties can be
modified.

Preview Live
Lock for Editing

Publish Page

Remote Publish Page

By @k

Add To Bundle

What's Changed?

LiA

4 Page Properties

‘_ Page Statistics

-

o Create New Page

6. After clicking Page Properties, the editor will be displayed. Lock the page for editing by
clicking on Lock for Editing under the Actions menu.

Actions

4 Lock for Editing

& Cancel

7. Modify any of the following fields:
Title

Location

Official Date and Time
Privacy Setting

Topic

©Qo oW
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Content History

* Communique - GAC

Wl English (US) W/

Workflow
Step: Initial State
Assignee: Nobody
Locked: GAC Secretariat :

(Seconds Ago)

Actions

' Release Lock

kd Seve

& Save / Publish
Assign Workflow

& Cancel

Title:

Alex Test Communiqué

Location:

Los Angeles

Official Date and Time:

11/18/2016 @~ 4:00PM

Privacy Setting:

) Private
® Public

Create Notification:

@ Yes

e —
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Content History

* Communique - GAC
Toggle Editor

Wi English (US) v
Language Variables:
SEO Keywords:
Workflow
Step: Initial State
Assignee: Nobody
Locked: GAC Secretariat :

Toggle Editor

Actions ,
Language Variables:
{ Release Lock Page Metadata:
kd Save

& Save / Publish
Assign Workflow

& Cancel
Toggle Editor

Language Variables:

Topic:

lick Her | ri

8. Once the edits have been made, you can either select Cancel to negate the edits

Actions

o' Release Lock
kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will save the edits and not publish them
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Actions

Release Lock

kd Save

& Save / Publish
Assign Workflow

& Cancel

OR

Select Save / Publish which will save and publish the edits

Actions

Release Lock

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Communiqué will be published in the GAC Advice
section of the site.

Correspondence

Correspondence is comprised of Incoming Correspondence and Outgoing Correspondence.
Both are displayed on the Correspondence Index page.

The following screenshot illustrates the contents of the Correspondence Index page:
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Communiqués  Correspondence  Itemized Advice  Principles & Guidelines

DAl | e RELATED TO:| SELECT ATOPIC H l‘—
Incoming &3| < SEARCH CORRESPONDENCE -——
Outgoing S |
Items Containing Advice | €——
® DATE ¢ 10 FROM ¢ SUBJECT - ¢
Aug 08,2016 Nosh Ross Jane Doe AOH Incoming Correspondence Test With Correspondent

e N " Ny

Aug 09,2016 Jackie Noyer Hihi Jain AOH Outgoing Correspondence 1

Note the following elements of the Correspondence Index page:

All Radio Button: When this radio button is selected, both Incoming and Outgoing
Correspondence will display in the index.

Incoming Radio Button: When this radio button is selected, only Incoming
Correspondence will display in the index.

Outgoing Radio Button: When this radio button is selected, only Outgoing
Correspondence will display in the index.

Items Containing Advice Radio Button: When this radio button is selected, only Outgoing
Correspondence containing Advice will display in the index.

Related To Dropdown List: This list contains topics that Incoming and Outgoing
Correspondence have been tagged with. When a topic is selected, only Incoming and
Outgoing Correspondence tagged with the selected topic will display in the index.
Search Correspondence Field: This field allows the user to type in a keyword / phrase of
what they would like to search for.

Official Date: This is the date that has been specified as the Official Date on Incoming
and Outgoing Correspondence.

Correspondence Recipient: This is the name(s) of the individual(s) that the
Correspondence was sent to.

Correspondence Sender: This is the name(s) of the individual(s) that sent the
Correspondence.

Correspondence Subject: This is the title given to the Incoming and Outgoing
Correspondence.

Incoming Correspondence Indicator: This indicator signifies a piece of Correspondence
is an Incoming Correspondence in the Correspondence Index.

Outgoing Correspondence Indicator: This indicator signifies a piece of Correspondence
is an Outgoing Correspondence in the Correspondence Index.
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Incoming Correspondence

When the GAC receives Incoming Correspondence, they will be able to parse the contents of
the correspondence and publish it to their website. If there are any important Actions or if it
relates to other Advice, the GAC will be able to track these things against the data already in
dotCMS so that site visitors can see these relationships.

The following screenshot illustrates the contents of Incoming Correspondence:

Communiqués  Correspondence Itemized Advice  Principles & Guidelines

Letter from India Govt to
ICANN Board

PDF (44 xnjl 1
Received: | ;
27 0ct 2016

To:

— Tt 20150912 GAC Input to ICANN CCWG accountabil..1 / 3

Governmental Advisory Committee (GAC) input to the

Ahmad Allam-Mi, Son Excellence
I'Ambassadeur, Communaute Economique

de Etats de ' Afrique Centrale, Cross-Community Working Group (CCWG)
) . . -

Ibrahim Assane Mayaki, Chief Executive | *——1— on Enhancing ICANN's Accountability
Officer, NEPAD Planning and Coordinating 12 September 2015
Agency,

. . .
Akram Atallah, President Global Domains Proposal — GAC's involvement in the Community
Division, ICANN, USA Mechanism
From:

——

\Vijay Phalke, Lead Tester, Rasnez, Obscuria 1. Introduction
[«

e This paper is a contribution from the GAC with regards to the involvement of the
GAC in the "Community Mechanism®, as outlined in chapter 6 of the "CCWG-

Or. Peter Allen, Chief Executive Accountsbility 2nd Draft Proposal on Work Stream | Recommendations™.

Officer, Ministry of the Public Service, Energy

and Public Utilities, mment of * The position described here aims at answering the open question whether or not the

Belize, Belize G GAC may intend to participate in the proposed "Community Mechanism®,
Camille Angué, GAC Representative, France - , , I . .
* This document is submitted 10 the CCWG-Acx bility as a ¢ input 10 the
Antigoni Axenidou, Director, General Legal public ‘N"m:": period of the working group's 2% draft proposal (August 39 -
Division, UN Office of Legal Affairs, September 1292015),
prion: ——F— Doscrpt e
This is test correspondence from Indian Gowt S ¢ The present document is divided in two parts:
Key Points: A Mo Pk ) i L ) .
Advice regarding ICANNST] o o A list of ground which izes the

denominator between the various GAC ber positions expe d in the
document: "INPUT FROM GAC MEMBERS TO MEETING OF CCWG-
/V ACCOUNTABILITY: Paris, 1718 July 2015",

o A concrete proposal with regards 10 the involvement of the GAC in the
aforementioned *Commanity Mechanism®,

Note the following elements of Incoming Correspondence:
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Title: This is the title given to the Incoming Correspondence in dotCMS.

PDF Link: Selecting this link will display the Incoming Correspondence in PDF format.

Received Date: This is the date the Incoming Correspondence was received.

To: This is the recipient(s) of the Incoming Correspondence.

From: This is the sender(s) of the Incoming Correspondence.

CC: This is who has been carbon copied (CC’d) on the Incoming Correspondence.

Description: This is the description given to the Incoming Correspondence in dotCMS.

Key Points: This is key points given to the Incoming Correspondence in dotCMS.

Uploaded File Name: This is the name of the file that was uploaded to create the

Incoming Correspondence.

Number of Pages: This is the number of pages of the Incoming Correspondence.

¢ Rotate Clockwise Icon: Selecting this icon will rotate the Incoming Correspondence
clockwise.

e Download Icon: Selecting this icon will allow you to download the Incoming
Correspondence to your computer.

e Print Icon: Selecting this icon will allow you to print the Incoming Correspondence.

¢ Incoming Correspondence: This is the Incoming Correspondence page(s) that were

uploaded to dotCMS.

Creating Incoming Correspondence
To create new Incoming Correspondence content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files Manage your Site
- gacdev0 Site Browser

3. Select Correspondence Incoming - GAC from the Type dropdown list.
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Figure 16: Navigating to the Content page within the Admin site will show all the Incoming Correspondence pages that have

already been created.

4. Select the Add New Content button on the top right.

Observe  Site Browser Content
Conerve Pages, Folders & s Manage your S

& peoee Comtent Search

Type: | Correspondence Iacomit | v

Search

{ Search + §g Oear Search

Advanced

showing 1-12 of 12

® M us)

® M us)

New test LUIC
20th Oct

Latter from
Inca Gont to
JCANN Boaro

5. Complete the following required fields:

a. Title

b. Correspondence File

c. Privacy Setting (defaults to Private)
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d. Received

e. From

f. To

g. Official Date and Time
Observe Site Browser Content
Observe Pages, Folders & Files  Manage your Site

' gacdev0 Content Search Add/Edit Correspondence Incoming - GAC

Content

&1 Correspondence Incoming -

GAC Title:
WjEnglish (US) v
Workflow URL Title:

Step: Initial State
Assignee: Nobody Correspondence File:

Choose File No file chosen

Actions
Privacy Setting:
i Save ® Private
& Save / Publish Public
Assign Workflow
|Received:

& Cancel




Observe Site Browser Content
Observe Pages, Folders & Flles  Manage your Site

& 9ocdevl Content Search Add/Edit Correspondence Incoming - GAC

Content
[From:
& Correspond I ing - Christopher A. Coons, U.S. Senator, United States
GAC Nora Abusitta, Secretariat, NETmundial InRiative
. Cristian Aguir, Deputy Minister of Communications, Infrastructure and Housing, Guatemala

WiEnglish (US) - Dr. Hessa Al-Jaber, Secretary General, ICT, Qatar

Mohammed Al-Tuwaljri, A Secretary | for Ec e Affairs, LAS

Carlos Alberto Forete Mesquita, Minister of Transport and Communications, Government of Mozambique
Workflow Carlos Alberto Forete Mesquita, Minister of Transport and Communications, Government of Mozambigue

Ambassador Alfredo Alfredo Morelli, Director, Ministry of Foreign Affairs of Argentina, Argentina
Step: Initial S Ahmad Alam-m, Ambassadeur, CEEAC
Ahmad Allam-Mi, Son Excellence I'Ambassadeur, Communaute Economique de Etats de I' Afrique Centrale
Assignee: Nobody Dr. Peter Allen, Chief Executive Officer, Ministry of the Public Service, Energy and Public Utilities, Government of Belize, Belize
Steve Allison, Product Manager, ICANN, Examplestan
Hasina Andriamanjato, Minister of Posts Telecommunications and New Technologies, Madagascar

Lic. Miguel Angel Lopez Perito, Ministro-Secretario General y Jefe del Gabi Civil P ia, la Republica del Paraguay
Lic, Miguel Angel Lopez Perito, Ministro-Secretario General y Jefe del G Civil P ia, la 2 del Paraguay
Camille Angué, GAC Representative, France

d Save Markus Arbenz, Executive Director, IFOAM
Ibrahim Assane Mayaki, Chief Executive Officer, NEPAD Planning and Coordinating Agency

@ Save/Publish Ibeahim Assane Mayaki, CEO, NEPAD
Akram Atallah, President Global Domains Division, ICANN, USA

¢ Assign Workflow

& Cancel

To:

Christopher A. Coons, U.S. Senator, United States

Nora Abusitta, Secretariat, NETmundial Intiative

Cristian Aguir, Deputy Minister of Communications, Infrastructure and Housing, Guatemala

Dr. Hessa Al-Jaber, Secretary General, ICT, Qatar

Mohammed Al-Tuwaljri, Assistant Secretary General for Economic Affairs, LAS

Carlos Alberto Forete Mesquita, Minister of Transport and Communications, Government of Mozambigue
Carlos Alberto Forete Mesquita, Minister of Transport and Communications, Government of Mozambigue
Ambassador Alfredo Alfredo Morelli, Director, Ministry of Foreign Affairs of Argentina, Argentina

Ahmad Alam-m, Ambassadeur, CEEAC

Ahmad Alam-Mi, Son Excellence I'Ambassadeur, Communaute Economique de Etats de I' Afrique Centrale
Dr. Peter Allen, Chief Executive Officer, Ministry of the Public Service, Energy and Public Wtilities, Government of Belize, Belize

Observe  Site Browser Content
Otserve Pages, Foiders & Ples  Manage your Ste
& 9cdevd Contert Search Add/Edit Correspondence Incoming - GAC

Content
+ Correspond ing -
GAC
=iEngish (US) -
Workflow
Step: Inntial State
Assignee: Nobody l P Words: 04
Actions ¥  language Variables:
bl Save Create Notification:
& Save / Publish ® No
Assign Workflow O Yes
& Cancel
Official Date and Time:
- | -
. ___________________________________________________________________________________________| .|
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6. Select Cancel to negate adding the content
Actions

kd Save
& Save / Publish

Assign Workflow

¢ Cancel

OR

Select Save which will save the content and not publish it
Actions

kd Save

& Save / Publish
Assign Workflow
& Cancel

OR

Select Save / Publish which will save and publish the content
Actions

kd Save

& Save / Publish

Assign Workflow

¢ Cancel

NOTE: Once Save / Publish is selected, the Incoming Correspondence will be published in the
GAC Advice section of site.

Updating Incoming Correspondence
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To update Incoming Correspondence content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site

& gacdevO Site Browser

3. Select Correspondence Incoming - GAC from the Type dropdown list.

Observe  Site Browser Content
Cner e Pages, Folders & Files  Marage v
@ oo Content Search Change She |«
+ Add New Contant  ~
ype show 201 Export
H Privacy
Itle VRL Titke Sefting  Received Erom Te cc
® N s New test L new test | ¢
, Search ~ 2 Oear Search 200 Ot 20h.0ct
Advanced
¢ N o< n n &

Figure 17: Navigating to the Content page within the Admin site will show all the Incoming Correspondence pages that have
already been created.

4. On the right side on the Content Search page, select the Incoming Correspondence you
would like to update by clicking on the Title.
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Observe  Site Browser Content
wrve wges, Faicers & Fie

@& oscte0 Conten Search Change Site -
+ Add New Content  ~
Type: [Corressondence Incom showing 1-12 of 12 Export

Iitle R Tithe Setting  Received Erem Ts o«

Search « £a Oear Search

Advanced

NOTE: You can refine your search by doing the following:
e Selecting any of the column headings to sort ascending and descending
AND / OR

e Enter additional data in the “Search” field on the left and click the Search
button

5. After selecting the Incoming Correspondence that you would like to modify, the editor will
be displayed. Lock the page for editing by clicking on Lock for Editing under the
Actions menu.
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Observe  Site Browser Content
Srerve Peges, Posders B Fies  Masape your Ste

2al Page gacdev0 Contert Search Add/Edit Correspondance Incoming - GAC

Content History Raferences

& Correspondence Incoming -

GAC Tithe:
Wi Cnglsh (US) - Letter from India Govt to ICANN Board
Workflow URL Titde:

better-from-inda -govt -20-icann- board

Step: [nitlal Stave

Assignee: Nobody
Correspomdence File:

Downioad
20150912 GAC Input to ICANN COWG accountabiity (1).pdf 3¢ Remove @ info

Privacy Setting:
Private

® Pl

Toplc:
Click Here 1o Select Categories

® Aovice

6. Modify any of the following fields:
Title

Correspondence File
Privacy Setting

Received

Topic

From

To

CcC

Description

Key Points

Create Notification option
I.  Notification Text

m. Official Date and Time

AT T SQ@ 00000
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Content History = References

&, Correspondence Incoming -

GAC Title:
Wi English (US) v AOH Incoming Correspondence Test With Correspondent
Workflow URL Title:

Step: Initial State aoh-incoming-correspondence-test-with-correspondent

Assignee: Nobody
|Correspondence File:
Locked: GAC Secretariat :
(Seconds Ago) Download
Create_Edit Incoming Correspondence.pdf 3 Remove @ info
Actions
|Pr|vacy Setting:
o' Release Lock
@ Private
d Seve () Public
@ Sove/ Publish
(" Assign Workflow |Received:
@ Cancel 7/28/2016 |~
Topic:
Click Here to Select Categories
Content  History  References
[From:
& Correspond I ing - -
- Christopher A. Coons, U.S. Senator, United States
GAC Nora Abusitta, Secretariat, NETmundial Initiative
miEnglish (US) = Cristian Aguir, Deputy Minister of Communications, Infrastructure and Housing, Guatemala
L Dr. Hessa Al-Jaber, Secretary General, ICT, Qatar
Mohammed Al-Tuwaijri, Assistant Secretary General for Economic Affairs, LAS
Carlos Alberto Forete Mesquita, Minister of Transport and Communications, Government of Mozambigue
Workflow Cartos Alberto Forete Mesquita, Minister of Transport and Communications, Government of Mozambigue
Ambassador Alfredo Alfredo Morelli, Director, Ministry of Foreign Affairs of Argentina, Argentina
Step: Initial State Ahmad Allam-m, Ambassadeur, CEEAC
. Ahmad Allam-Mi, Son Excellence 'Ambassadeur, Communaute Economique de Etats de I' Afrique Centrale
Assignee: Nobody Dr, Peter Alien, Chief Executive Officer, Ministry of the Public Service, Energy and Public Utilities, Government of Belize, Belize
Locked: GAC Secretariat - Steve Allison, Product Manager, ICANN, Examplestan
(Seconds Ago) Hasina Andriamanjato, Minister of Posts Telecommunications and New Technologies, Madagascar

Lic. Miguel Angel Lopez Perito, Ministro-Secretario General y Jefe del Gab Civil Presidencia, |a Republica del Paraguay
Lic. Miguel Angel Lopez Perito, Ministro-Secretario General y Jefe del Gabi Civil Presidencia, la Republica del Paraguay
Actions Camille Angué, GAC Representative, France

Markus Arbenz, Executive Director, IFOAM

Ibrahim Assane Mayaki, Chief Executive Officer, NEPAD Planning and Coordinating Agency

SR Pelense Lock Ibrahim Assane Mayaki, CEO, NEPAD
W Save Akram Atallah, President Global Domains Division, ICANN, USA
. —
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Content  History  References

£y Correspond I ing - Christopher A. Coons, U.S. Senator, United States
GAC Nora Abusitta, Secretariat, NETmundial Initiative
. Cristian Aguir, Deputy Minister of Communications, Infrastructure and Housing, Guatemala
Wi English (US) R4 Dr. Hessa Al-Jaber, Secretary General, ICT, Qatar
Mohammed Al-Tuwalijri, A Secretary G | for Ec Affairs, LAS
Carfos Alberto Forete Mesquita, Minister of Transport and Communications, Government of Mozambique
Workflow Carlos Alberto Forete Mesquita, Minister of Transport and Communications, Government of Mozambique
Ambassador Aifredo Alfredo Morelli, Director, Ministry of Foreign Affairs of Argentina, Argentina
Step: Initial State Ahmad Allam-m, Ambassadeur, CEEAC
Ahmad Allam-Mi, Son Excellence I'Ambassadeur, Communaute Economique de Etats de |I' Afrique Centrale
Assignee: Nobody Dr. Peter Allen, Chief Executive Officer, Ministry of the Public Service, Energy and Public Utilities, Government of Belize, Belize
Steve Allison, Product Manager, ICANN, Examplestan
Locked: GAC Secretariat : Hasina Andriamanjato, Minister of Posts Telecommunications and New Technologies, Madagascar
(SN el Uc. Miguel Angel Lopez Perito, Ministro-Secretario General y Jefe del Gabinete Civil Presidendia, la Republica del Paraguay
Lic. Miguel Angel Lopez Perito, Ministro-Secretario General y Jefe del Gabinete Civil Presidendia, la Republica del Paraguay
Actions Camille Angué, GAC Representative, France
Markus Arbenz, Executive Director, IFOAM
Ibrahim Assane Mayaki, Chief Executive Officer, NEPAD Planning and Coordinating Agency
off Release Lock Ibrahim Assane Mayaki, CEO, NEPAD
i Save Akram Atallah, President Global Domains Division, ICANN, USA

& Save/ Publish

( Assign Workflow :
Christopher A. Coons, U.S. Senator, United States
& Cancel Nora Abusitta, Secretariat, NETmundial Initiative
Cristian Aguir, Deputy Mi of Communi Infrastructure and Mousing, Guatemala
Dr. Hessa Al-Jaber, Secretary General, ICT, Qatar
Mohammed Al-Tuwaljr, Assistant Secretary General for Economic Affairs, LAS
Carlos Alberto Forete Mesquita, Minister of Transport and Communications, Government of Mozambique
Carlos Alberto Forete Mesquita, Minister of Transport and Communications, Government of Mozambique
Ambassador Alfredo Alfredo Morelll, Director, Ministry of Foreign Affairs of Argentina, Argentina
Ahmad Allam-m, Ambassadeur, CEEAC
Ahmad Allam-Mi, Son Excellence I'Ambassadeur, Communaute Economique de Etats de |' Afrique Centrale

[CC:

Dr. Peter Allen, Chief Executive Officer, Ministry of the Public Service, Energy and Public Utilities, Government of Belize, Belize

Content  History  References

[Cescription:
& Correspond 1 ing -
GAC File~ Edit~ Inset~ View~ Format~ Tools »
SiEnglish (US) B ,Fcnnavls /I VY § E X3 B --3 2 @ & | &’ R v~
Workflow Tost ' COmesp with P To, From & CC fields.
Step: Initial State
Assignee: Nobody
Locked: GAC Secretariat :
(Seconds Ago)
Actions
of Release Lock
 Save
@ Save/ Publish
¢ Assign Workflow
& Cancel
Ip WDA_
| -
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Content History References
Key Points:
& Cor P d- L ".
GAC Fie~ Edit~ Insert~v View~ Format~ Tools~
MiEnglish (US) 2 Fomas~ B /7 U & E B 3 H E-5- 3 B W E & R v~
. .
w = Test key points On INCOMING COMBSpONdencs.

Step: Initial State
Assignee: Nobody
Locked: GAC Secretariat :

nds AGo

Actions

of Release Lock

Save

@ Save/ Publish
Assign Workflow

& Cancel

Content  History  References

&1 Correspondence Incoming -
GAC

W English (US) v

Workflow
Step: Initial State
Assignee: Nobody
Locked: GAC Secretariat :

(Seconds Ago)

Actions

of Release Lock

d Save

@ Save/ Publish
Assign Workflow

& Cancel

[+

[wvsxwvc] -

Language Variables:

Create Notification:

O Yes

No

Official Date and Time:

8/8/2016 v

12:00 AM | ~
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7. Once modifications have been made, you can either select Cancel to negate the edits.

| 92




Actions

{' Release Lock
kd Save
& Save / Publish

Assign Workflow

I & Cancel

OR

Select Save which will save the edits and not publish them.

Actions

{' Release Lock

kd Save

& Save / Publish
Assign Workflow

& Cancel

OR

Select Save / Publish which will save and publish the edits.

Actions

{' Release Lock

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Incoming Correspondence will be published in the
GAC Advice section of site.

Outgoing Correspondence

Outgoing Correspondences can be in response to other correspondences, calls for public
comment, events taking place in the community or any other number of activities. The contents
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of Outgoing Correspondence can vary, but often a correspondence written by the GAC houses
Advice or Actions.

The following screenshot illustrates the contents of Outgoing Correspondence:

Communiqués Correspondence Itemized Advice Principles & Guidelines

Current round of new gTLDs —
Safeguards

) View as POF | ¢——

Sent: Al Al Al 10 ) Y Al H AR
. OFFICIAL CORRESPONDENCE

01 August 2016

Jackic Mover
To: / Lead PM

Accountabilia O1 August 2006
Jackie Moyer, Lead PM, NNACI, T
Accountabilia l RE: Current round of new gTLDs Safeguards
Froen: Dear Dr, Crocker,

Governmental Advisory Committee26fanuary 2008DrSeeve CrockerChair, ICANN Board o Cyrus Namazi,
James Bladel, GNSO Chair, ICANNDear DrCrocker, Re: GAC Membership concerns with the use of two-character labds at the second

: levelOn 16 October 2004 ICANN Boand Resolution 20141006 gpassed, with conskieration of the GAC Los
:‘wc Crocker, ICANN Board, ICANN, United Angeles Communiqué, directing ICANN staff to “deveop and implement an efficient procedure for the rekease of
. wo-character doomins currenthy required 1o be reserved in the New gTLD Registry Agreement."Coecerns have

Jane Doe, CEO, Conglomerate Inc., been ralsed by GAC members who feel that the new process has been implemented very quickly and without any
Acronymia formal consultation with affected interested members of the GAC, just notification via ICANN support staff. The

new process appearns 1o depart from the new gTLD Registry Agreementwhich supported national sovercignty,
Hitesh Goyani, Lead Engineer, Zensar Tech, and GAC Principles regarding new gT1LDs, in thae:
Alex Hutson, Sr. Business Analyst, ICANN,
USA GACI2345

[cci] «— ETLD Safeguants
Description: The GAC appreciates the efforts of the ICANN Board New gTLD Program Committee
p . NGPC) since the 2013 Bedjing meeting to respond to the GAC's Safeguard advice. At the

[Current round of new gTLOs Safeguards same time, however, despite guidance provided by the GAC in Communiqués generated

recommended provisions requiring the verification of eredentials for domains in highly
regulated sectors.

'\ / during subsequent ICANN meetings, including the 2015 ICANN mecting in Singapore,

T . contracts with the new gTLD Applicants have continued without the GAC previously

Note the following elements of Outgoing Correspondence:

Title: This is the title given to the Outgoing Correspondence in dotCMS.

PDF Link: Selecting this link will display the Outgoing Correspondence in PDF format.
Sent Date: This is the date the Outgoing Correspondence was sent.

To: This is the recipient(s) of the Outgoing Correspondence.

From: This is the sender(s) of the Outgoing Correspondence.

CC: This is who has been carbon copied (CC’d) on the Outgoing Correspondence.
Description: This is the description given to the Outgoing Correspondence in dotCMS.
Key Points: This is key points given to the Outgoing Correspondence in dotCMS.
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e Outgoing Correspondence: This is the Outgoing Correspondence page(s) that was
created in dotCMS.

Creating Outgoing Correspondence

To create new Outgoing Correspondence content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site
& gacdevO Site Browser

3. Select Correspondence Incoming - GAC from the Type dropdown list.

Observe  Site Browser Content
(R Comtent Search range Site |~
+ ASd New Cortert ~
showing 1-40 of 107 Export
th Redir
Erom To Yo VRL

. Search ~ g Clear Search

Advanced

Figure 18: Navigating to the Content page within the Admin site will show all the Outgoing Correspondence pages that have
already been created.

4. Select the Add New Content button on the top right.

Observe  Site Browser Content
Poges, Folders & Fies | Menage your S
@ oscoev0 Content Search
Type N = showing 1-40 of 107 Export
Official
Dateand  Privecy Redir
v Subjest Time Setting  Template Frem Te L VRL
- -, il s <1 4 ¢ e
. Search +« 2 Oeor Search ] 481 | 4 3 outy
Advanced -
19
343
. - 2 ] aseq 946204004
am ‘ - Ty
T
wrigtls
43
I |
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5. Complete the following required fields:
a. Title

b. Official Date and Time

c. Privacy Setting (defaults to Private)
d. From
e. To
?burv- Site Mr Content
v gacdevD Content Search Add/Edit Correspondence Outgoing - GAC
Content

* Correspondence Outgoing -

GAC Title:
Sl English (US) -
Workflow Subject:

Step: Initial State
Assignee: Nobody

Topic:
Actions Click Here to Select Categories
 Save
Description:
& Save/ Publish
Assign Workfiow Filev Edit~ Inset~ View~ Format~ Tools ~
@ Cancel Fomats~ |B 7 U & FE ¥ 3 B - |- % ¥ W E & &2 ¢~
—
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Observe Site Browser Content
Observe Pages, Folders & Flles  Manage your Site

@ ovcdev0 Content Search Add/Edit Correspondence Outgoing - GAC

Content
* Correspond Outgoing - Official Date and Time:
i - | -
i Enghish (US) - -
|anxy Setting:
Workflow @ Private
O Public
Step: Initial State 2
Assignee: Nobody
From:
Christopher A. Coons, U.S. Senator, United States
Actions Nora Abusitta, Secretariat, NETmundial Initiative
Cristian Aguir, Deputy Minister of Communications, Infrastructure and Mousing, Guatemala
o Save Dr, Hessa Al-Jaber, Secretary General, ICT, Qatar
Mohammed Al-Tuwaljri, Assistant Secretary General for Economic Affairs, LAS
& Save/ Publish Carlos Alberto Forete Mesquita, Minister of Transport and Communications, Government of Mozambique
Carlos Alberto Forete Mesquita, Minister of Transport and Comm 18, Government of Mazambigue
¢ Assign Workflow Ambassador Alfreco Alfredo Morelll, Director, Ministry of Foreign Affairs of Argentina, Argentina
Ahmad Allam-m, Ambassadeur, CEEAC
@ Cancel Ahmad Allam-M|, Son Excellence I'Ambassadeur, Communaute Economique de Etats de I' Afrique Centrale
Dr, Peter Allen, Chief Executive Officer, Ministry of the Public Service, Energy and Public Utilities, Government of Belize, Belize
Steve Allison, Product Manager, ICANN, Examplestan
Hasina Andriamanjato, Minister of Posts Telecommunications and New Technologies, Madagascar
Lic. Miguel Angel Lopez Perito, Ministro-Secretario General y Jefe del Gabinete Civil Presidencia, la Republica del Paraguay
Lic. Miguel Angel Lopez Perito, Ministro-Secretario General y Jefe del Gabinete Civil Presidencia, ka Republica del Paraguay
Camille Angué, GAC Representative, France
Markus Arbenz, Executive Director, [FOAM
Ibrahim Assane Mayakd, Chief Executive Officer, NEPAD Planning and Coordinating Agency
Ibrahim Assane Mayaki, CEO, NEPAD
Akram Atallah, President Global Domains Division, ICANN, USA

Observe Site Browser Content
Observe Pages, Foiders & Flles ~ Manage your Site

@ ocdevo Content Search Add/Edit Correspondence Outgoing - GAC

Content
* Correspond Outgoing - To:
SAC Christopher A. Coons, U.S. Senator, United States
Wi Engish (US) = Nora Abusitta, Secretariat, NETmundial [nitiative
i Cristian Aguir, Deputy Minister of Communications, Infrastructure and Housing, Guatemala
Dr. Hessa Al-Jaber, Secretary General, ICT, Qatar
Mohammed Al-Tuwaijr, A Secretary G | for Economic Affairs, LAS
Workflow Carlos Alberto Forete Mesguita, Minister of Transport and Communications, Government of Mozambique
Carios Alberto Forete Mesquita, Minister of Transport and Communications, Government of Mozambique
Step: Initial State Ambassador Alfredo Alfredo Morelli, Director, Ministry of Foreign Affairs of Argentina, Argentina
Ahmad Allam-m, Ambassadeur, CEEAC
Assignes: Nobody Ahmad Allam-Mi, Son Excelience '‘Arr deur, C jte Economigue de Etats de I' Afrique Centrale
Dr, Peter Allen, Chief Executive Officer, Ministry of the Public Service, Energy and Public Utities, Government of Belize, Belize
Steve Allison, Product Manager, ICANN, Examplestan
Actions Hasina Andriamanjato, Minister of Posts Telecommunications and New Technologies, Madagascar
Uic. Miguel Angel Lopez Perito, Ministro-Secretario General y Jefe del Gabinete Civil Presidencia, ks Republica del Paraguay
W Save Uc. Miguel Angel Lopez Perito, Ministro-Secretario G | y Jefe del Gabs Civil Pr i3, 2 Republica del Paraguay
Camille Angué, GAC Representative, France
@ Save / Publish Markus Arbenz, Executive Director, IFOAM
1brahim Assane Mayaki, Chief Executive Officer, NEPAD Planning and Coordinating Agency
¢ Assign Workflow Ibrahim Assane Mayaki, CEO, NEPAD
Akram Atallah, President Global Domains Division, ICANN, USA
& Cancel .

6. Select Cancel to negate adding the content
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Actions

kd Save
& Save / Publish

Assign Workflow

¢ Cancel

OR

Select Save which will save the content and not publish it
Actions

kd Save

& Save / Publish
Assign Workflow
& Cancel

OR

Select Save / Publish which will save and publish the content
Actions

kd Save

& Save / Publish

Assign Workflow

¢ Cancel

NOTE: Once Save / Publish is selected, the Outgoing Correspondence will be published in the
GAC Advice section of site.

Relating Content to Outgoing Correspondence
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After Outgoing Correspondence content has been created and published, the Secretariat can
relate Advice to it so information from the related Advice displays in the Outgoing
Correspondence. In addition to Advice, the Secretariat can relate Document Sections to
Outgoing Correspondence which will allow them to add a free-form section that they can used
to add documentation / information as needed.

RELATING NEW CONTENT TO OUTGOING CORRESPONDENCE
To relate new Advice and Document Section to Outgoing Correspondence, follow the steps
below:

1. Log into dotCMS Admin.
2. Click the Site Browser tab from the top navigation.

Site Browser Content
Pages, Folders & Files Manage your Site
& gacdev0 Site Browser

Figure 19: Navigating to the Site Browser page within the Admin site will show all the editable pages that you are able to modify.

3. On the Site Browser, within the left pane, click on the outgoing folder.

Mamre Site Browser Content
Tasks & . - ar Massge v

@ 0rctev Site Browser Change Sie [~

Sites and Folders ™ Engish (US - + Add New
D o Name Meny  Status Mos User Mod, Date
£ orcsev0

stount prvete

actvity publc
0ve ugretures
commurques  Dg-OApOrg-CHTeDIrerCe

comespondence -
LESL-SULYeNg COFTes. DY $C1

omng

| me——

*  b3-outgong-camespondence
prrvate

et -eueng (O v
pablic S -UING COrTes- DY 50

granres * by outgong-cormespendence

4. Double click the Outgoing Correspondence Name in the right pane to open the live
editor interface for the page.
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Mamre Site Browser Content
Tavks & Dashboard  Peges, Tolders & Mies  Manage your Ste

- e Site Browser

Change Site |
Sites and Folders S Engish (US) - o+ Add New =
;9 geotevd Name Meny  Status Mot Vser Mog, Date
stount prvete
actwity Patic
aovice wgratures
communiques DI OMPONg-CTeRIndence- . B (en_US) BQ Outpong Correspondence GAC Secretaret
emempendence T lesleupeng Corres: DY $Cr - B (on_US) Test Outgoing Carmes - 8Q 5 GAC Secretarat
~omng
= test-cutgoing corres-ba-acr... ® A W (en_US) Test Oungoing Corres - 8Q S GAC Secretarat
| outgoing
' DI-OMPONG-CHTeIDNGenCe- - B (en_US) B5Q Outpong Correspondence GAC Secretaret
prrvane
pablic e eueng COrres DY $Y ® 4 (e US)Test O AL Secretariet
sgranares ¥ by-outgoing-camespendence . W (en_US) BY Outgoing Commespongence GAC Secretarat  O4/0S/2017 12155129 AM

NOTE: You can sort the Outgoing Correspondence Name column (ascending or
descending) by clicking on the column heading.

5. From the live editor mode, first lock the page for editing.

Preview Live

‘% Lock for Editing

(= 9

@& Publish Page

=2 Remote Publish Page
& Add To Bundle

6. Select the Add Content button on the page.
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-
| s | Lo | ) - ; Communiqués Correspondence Itemized Advice Principles & Guidelines
@ Pomh Page S Send for Translation PRIVATE: GAC Members Only
@ memste Rowsh Page Test Outgoing Corres - BQ
8 A4 To Buncle Script05-04-
ASSON W Now
'§ 17::14:51:837Updated
Poge Statistics
A D Al AJ e “ T L8
| B OFFICIAL CORRESPONDENCE
% Creste New Page ' OS5 April 2017
Viewing s e Wanawit Ahkupotra
. . Deputy Excoutive Director
Wanawit Ahkuputra, Deputy Executive . . R N
Director, Electronic Transactions Thadand 035 Apeil 2007
Pevelopment Agency, Thailand RE: BO Test
cc:
(i
Oefout Viskor = Wanawit Ahkuputra, Deputy Executive
Director, Electronic Transactions GAC05- 04 17:14:36:349
W Engish (US) - Development Agency, Thalland
= ) Test Adhbeens o (784354
From:
@ Acmia Screen B Test Advice - ‘Test Advice Statement
Cristian Aguir, Deputy Minister of
Communications, infrastructure and Ratkwsale
Housing, Guatemala

7. Select New Content from the Add Content dropdown.
— Communiqués Correspondence Itemized Advice Principles & Guidelines

Qe |

§ Felease Lock

@ Pubinh Page Send for Translation PRIVATE: GAC Members Only
Test Outgoing Corres - BQ
Script05-04-

17::14:51:837Updated

& vemote Putisn Page
B 204 7o buscie

s OFFICIAL CORRESPONDENCE

05 April 2017

% Creste New Poge

B Suggestions? Comments? Send

Ve
Waramit Ahlagputra

ety Exccstive t
Wanawit Ahkuputra, Deputy Executive l y Evocutive Diector

Director, Electronic Transactions Thallead 03 \peli 2017
Development ncy, Thalland
pment Agency RE: BQ Test
o
EEiE
Defnik Vistor - Wanawit Ahkupetra, Deputy Executive
Director, Electronic Transactions GAC-05-0417214:36:349

Development Agency, Thailand

W trgh =
B ot Mhbooog O 17 s
From
@ Admin Screen BQ Test Mdvice - Test Advice Statement
Cristian Aguir, Deputy Ninister of
Communications, Infrastructure and RKaotimak
Housing, Guatemala

8. An Add New Content pop-up will display allowing you to add Advice or a Document
Section.
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Add New Content

Advice - GAC
Document Section

9. Click on the content type you would like to add from within the Add New Content pop-up.

10. Complete the required fields (headings in red) for the content type selected.

a. Document Section: This content does not have required fields however, the Title
and Body must be completed so the Document Section added has a Title and
support text (Body)

b. Advice

i. Title
i. URL Title (automatically created based upon the Title)
iii. Privacy Setting (defaults to Private)
iv. Consensus Setting (defaults to Consensus)
v. Official Date and Time
vi. Advice Statement
vii. Rationale
viii. Reference Number

11.Select Cancel to negate adding the content
Actions

kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will save the content and not publish it

ICANN |TYPE THE DOCUMENT TITLE | MONTH YEAR | 102



Actions

kd Save

& Save / Publish
Assign Workflow

& Cancel

OR

Select Save / Publish which will save and publish the content
Actions

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE:

e Once Save / Publish is selected, the Outgoing Correspondence will be published in the
GAC Advice section of site.

e Selecting Advice will create a piece of Advice content that is attached to the Outgoing
Correspondence but is also independently accessible and will display in their respective
site sections.

e Selecting Document Section will create a Document Section in the Outgoing
Correspondence, not an independently accessible piece of content.

RELATING EXISTING CONTENT TO OUTGOING CORRESPONDENCE
To relate existing Advice and Document Section to Outgoing Correspondence, follow the steps
below:

1. Log into dotCMS Admin.
2. Click the Site Browser tab from the top navigation.
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Site Browser
Pages, Folders & Files

Content
Manage your Site

& gacdev0 Site Browser

Figure 20: Navigating to the Site Browser page within the Admin site will show all the editable pages that you are able to modify.

3. On the Site Browser, within the left pane, click on the outgoing folder.

Mo Site Brow: Content
Tenks & Dashboart  Pages, Fold Masaze your Ste
& 9200ev0 Site Browser Change She ||
Sites and Folders W Engish (US) - + Add New ~
Stat Mog,
‘9 gacdev0 Name Heny s Mod. User 00, Oate
atout prvane
actwity Pt
aovice ugretures
communiques T T p———— . W (en_US) BQ Outgong Correspondence GAC Secretar ] 03:0 v
“ * T reseueng Corres DY $0r o L | t Ous GAC Secretaral 04/ 3™
. ~omng
" tes-cutgeing cormes-by-acr... ® A W (en_US) Test Oungoing Carres AC Secretarat M08 -
T ba-outpoing-camespendence- - LG AC Secretaret 04
] prrvane
o " ( AC Secr 0
pablic LESL-SULPeNG COrTes DY $Cr - L1 Gecretariat 04
sgranres ¥ by-outgoing-camespandence - W (e GAC Secretarat M08 ™

4. Double click the Outgoing Correspondence Name in the right pane to open the live
editor interface for the page.

Mo Site Browser Content
Tenks & Dashboard  Pages, Folde Marape your Ste
- a0 Site Browser Change Site  «|
Sites and Folders W Engish (US) - + Add New ~
0 .
‘99’( 0 Name Meny  Status Mof . Wser Mod, Date
o prvane
actwity Patic
aovice ugratures
communiques " ba-outpong-camespondence- t
“ . T test-outpeng Corres DY Sr -
nooming
" test-outgoing corres-bg-acr... -
| outgoing
*  by-outpoing-comespendence- .
prrvate
pablic LS -GG COrres: DY 307 -
sigranures " by-outgoing comespondence .

NOTE: You can sort the Outgoing Correspondence Name column (ascending or
descending) by clicking on the column heading.

5. From the live editor mode, first lock the page for editing.
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Preview Live

9 Lock for Editing

@& Publish Page

=2 Remote Publish Page
& Add To Bundle

6. Select the Add Content button on the page.
| s | Lo l ) . Communiqués Correspondence Itemized Advice Principles & Guidelines

{ Retesse Lock

@ Puoimh Page

Send for Translation PRIVATE: GAC Members Only

Test Outgoing Corres - BQ
Script05-04-
17::14:51:837Updated

Kemote Pubish Paje

L

Add To Duncle
Assign Weow
& Page Progertes {4 Add Content

i reoe St

e OFFICIAL CORRESPONDENCE

8 Suggestions? Comments? Send u

5 Create New Page OS5 April 2017
T
Viewing ox: Wanuwit Ahkuputra
ive W
Wanawit Ahkuputra, Deputy Executive Al]).wx.\ SHE.— _ -
Director, Electronic Transactions udand 035 Apeil 2007
Development Agency, Thailand .
Agency. RE: BOQ Test
cc:
[Nl
Oefout Visitor = Wanawit Ahkuputra, Deputy Executive
Director, Electronic Transactions GAC05- 04 17:14:36:349
YT - Development Agency, Thalland
B Test MRS o 17 ys®a
From:
@ Acrmen Screen BO Test Advice - ‘Test Advice Statement
Cristian Aguir, Deputy Minister of
Communications, infrastructure and Ratkwsale
Housing, Guatemala

7. Select Reuse Content from the Add Content dropdown.
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- 3 ommuniqués orrespondence Itemized Advice rinciples & Guidelines

| - | e l - ; C C d ed Ad P les & Guidel

4 Scicere 8

® rer £ ST

@ hemote Putish Pu Test Outgoing Corres - BQ

B fod Tz Drdk Script05-04-

. < 17::14:51:837Updated
P % ) i Add Contert
. ;M N T ~ ~ v " ‘_“_o\,_.,,
: OFFICIAL CORRESPONDENCE [a——]

% Creste New Page : 05 April 2017 T

L

Ve
. Waramit Ahlagputra e

Fxocgive
Wanawit Ahkuputra, Deputy Executive ’Im! OIS Disbcioc s Acel 2017
Director, Electronic Transactions ' O3 el 200
Development Agency, Thalland

RE: BO Test
o
EEiE
Defast Vistor = Wanawit Ahkuputra, Deputy Executive
Director, Electronic Transactions GAC-05-0417214:36:349

Development Agency, Thailand

W tromh -
BOQ Yot Mhvhooos O 17ag e
From
@ Acrmin Screen BQ Test Mdvice - Test Advice Statement
Cristian Aguir, Deputy Minister of
Communications, Infrastructure and Roticnal
Housing, Guatemala

8. Once the Search pop-up displays, select Advice or Document Section from the
Content Type dropdown.

Search: Advice - GAC

Content Type: | aAdvice - GAC |~
Advice - GAC
Language | nocument Section
Title:
Host Folder: -

Privacy Private
Setting: Public

Consensus Consensus
Setting: Non-Consensus

Advice
Statement:

Rationale:

Migrated

9. Select the Search button at the bottom of the Search pop-up to execute your search or
select the Clear Search button to clear your search criteria.
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Search: Advice - GAC

Consensus Consensus
Setting: () Non-Consensus
Advice
Statement:
Rationale:
Migrated
Advice:
GAC: |* Accountability & Transparency
+ ATRT 1
4+ ATRT 2
+ ATRT 3
4+ ATRT 4
+ AoC Review
+ VijayTest
+ SubCategoryl
+ CCT Review

| &4 Search | | @ Clear Search |

Figure 21: You can refine your search by entering additional criteria in the Search pop-up and then selecting the Search button.

10.Once the search results display, click the Select button to select the content you would

like to reuse.
Search: Advice - GAC

Fiiveyy riwvowe
Setting: Public
Consensus Consensus
Setting: Non-Consensus
Advice
Statement:
Rationale:
Migrated
Advice:
+ Accountability & Transparency
.| +ATRT1
GAC: | 4 ATRT2
+ ATRT 3
+ ATRT 4
+ AoC Review
+ CCT Review

+ Specific Reviews
+ WHOIS Review

4 Search | 4 Clear Search

Matching Results (173)

SELECT

SELECT

SELECT

Language

Sl English (US)

Sl English (US)

Sl English (US)

W English (US)

Title

2017-03-15 2-
Character
Country/Territory
Codes at the
Second Level

2017-03-15 IGO
Protections

2017-03-15
Mitigation of
Domain Name
Abuse

2017-03-15
Protection of the
Red Cross and
Red Crescent

URL Title

2017-03-15-
2-character-
country-
territory-
codes-at-the-
second-level

2017-03-15-
go-
protections

2017-03-15-
mitigation-of-
domain-
name-abuse

2017-03-15-

protection-of-
the-red-cross-

and-red-

Privacy
Setting

public

public

public

private

Consensus
Setting

consensus

consensus

consensus

consensus

NOTE: Once Save / Publish is selected, the Outgoing Correspondence will be published in the

GAC Advice section of site.
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Updating Outgoing Correspondence

To update Outgoing Correspondence content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Site Browser tab from the top navigation.

Site Browser

Content

Pages, Folders & Files Manage your Site

& gacdev0

Site Browser

Figure 22: Navigating to the Site Browser page within the Admin site will show all the editable pages that you are able to modify.

3. On the Site Browser, within the left pane, click on the outgoing folder.

Mamre Site Browser
' Poges, Folders & Mies

o3 & Davtoer

& 9r0iev0 Site Browser
Sites and Folders

9 gacdev0
0 L aven
atwy
Sivee
COMmmuniQues
Comespondence
' neoming
prvane
pablc

sgransres

Content

W Enghsh (US) -
Name

prvane

Patic

wgretures

* DI outpoNg-Camespendence-

LS -ULPeNg COrTes: DY 5T

" test-outgoing corres-bg-acr

*  Dy-outgoINg-Camespandence-

LS -GUPENg COrTes- DY $Cr

* by outgoing-cammespondence

Meny  Status

Mot Vser

Mogd, Date

4. Double click the Outgoing Correspondence Name in the right pane to open the live
editor interface for the page.

Mamre Site Browser
Poges, Toiders & Pies

Tanks & Dashboar

& 200 Site Browser
Sites and Folders

9 gacdev0
0 L aven
atwy
Sivee
COMmmuniQues
Comespondence
nooming
| outgoing
prvane
pablc

sgransres

NOTE: You can sort the Outgoing Correspondence Name column (ascending or

Content

W Engish (US) -
Name

privane

patic

wgratures

LS -ULPeNg COrTes: DY 5T

™ test-outgoing corres-bg-acr

LS -GUPENg COrTes- DY $Cr

* by outgoing-cammespondence

* DI outpoNg-Camespendence-

*  Dy-outgoINg-Camespandence-

Meny  Status

descending) by clicking on the column heading.
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5. Select Page Properties to access the content backend so the content properties can be

modified.
Preview Live
Lock for Editing

Publish Page

Remote Publish Page

g @I

Add To Bundle

What's Changed?

fF

| I" Page Properties

Page Statistics

-

¢ Create New Page

6. After clicking Page Properties, the editor will be displayed. Lock the page for editing by

clicking on Lock for Editing under the Actions menu.

Actions

4 Lock for Editing

& Cancel

7. Modify any of the following fields:
Title
Subject
Topic
Description
Key Points
Official Date and Time
Privacy Setting
From
To
CcC
. Signature
Create Notification

AT T TQM0 a0 T
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Content  History  References

P " O 2ae o

GAC

Wi English (US) -

Workflow
Step: Inntial State
Assignee: Nobody
Locked: GAC Secretariat

(21 Minutes Ago)

Actions

of Release Lock

 Save

@ Save/ Publish
Assign Workflow

& Cancel

Content  History  References

T Correspondence Outgoing -
GAC

Wi Engish (US) -

Workflow
Step: [nitial State
Assignee: Nobody
Locked: GAC Secretariat :

(Seconds Ago)

Actions

£ Release Lock

d Save

& Save / Publish

o Assign Workflow

& Cancel

e —
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Title:
AOH Outgoing Correspondenc
|Subject:
Test Subject
Topic:
Cli Select C )
[Description:
File~ Edit> Inset~ View~ Format~ Tools ~
Fomats~ B 7 U & E ¥ 3 B =-|IE-F B W & & 22 ¢~
Test Descripion
ﬁoy!olnu:
File~ Edt~ Insert~ View~ Format~ Tools ~
Fomats+ B 7 Y & E E I B - E-F B W & &L 2 ¢~
Test Key Points
P Words: 3
|
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Content  History  References

= Correspond Outgoling - (Official Date and Time:
8/9/2016 v [ 12:00 AM | v
Wi English (US) -
Workflow
Step: Initial State
Assignee: Nobody F
From:
Locked: GAC Secretariat :
(Seconds Ago) Christopher A. Coons, U.S. Senator, United States
Nora Abusitta, Secretariat, NETmundial Initiative
Cristian Aguir, Deputy Minister of Communications, Infrastructure and Mousing, Guatemala
Actions Dr. Hessa Al-Jaber, Secretary General, ICT, Qatar
Mohammed Al-Tuwaljr, Assistant Secretary General for Economic Affairs, LAS
of Release Lock Carlos Alberto Forete Mesquita, Minister of Transport and Communications, Government of Mozambique
Carlos Alberto Forete Mesquita, Minister of Transport and Communications, Government of Mozambique
l Save Ambassador Alfredo Alfredo Morell, Director, Ministry of Foreign Affairs of Argentina, Argentina
Anmad Allam-m, Amb deur, CEEAC
@ Save/ Publish Anmad Alam-Mi, Son Excellence Ambassadeur, Communaute Economique de Etats de I' Afrique Centrale
Dr. Peter Allen, Chief Executive Officer, Ministry of the Public Service, Energy and Public Wrilities, Government of Belize, Belize
@ Assign Workflow Steve Allison, Product Manager, ICANN, Examplestan
@ Cancel Hasina Andriamanjato, Minister of Posts Telecommunications and New Technologles, Madagascar
Uic. Miguel Angel Lopez Perito, Ministro-Secretario General y Jefe del Gabinete Civil Presidencia, la Republica del Paraguay
Uc. Miguel Angel Lopez Perito, Ministro-Secretario General y Jefe del Gab Civil P ia, 2 Republica del Paraguay
Camille Angué, GAC Representative, France
Markus Arbenz, Executive Director, IFOAM
Ibrahim Assane Mayaki, Chief Executive Officer, NEPAD Planning and Coordinating Agency
Ibrahim Assane Mayaki, CEO, NEPAD
Akram Atallah, F Glodal D 15 D 1, ICANN, USA
Content  History  References
™ Correspondence Outgoing - ro:

GAC

. Christopher A. Coons, U.S. Senator, United States

S English (US) 1= Nora Abusitta, Secretariat, NETmundial Initiative

Cristian Aguir, Deputy Minister of Communications, Infrastructure and Housing, Guatemala
Dr. Hessa Al-Jaber, Secretary General, ICT, Qatar

Workflow Mohammed Al-Tuwaijri, Assistant Secretary General for Economic Affairs, LAS

Carlos Alberto Forete Mesquita, Minister of Transport and Communications, Government of Mozambique
Step: Initial State Carlos Alberto Forete Mesquita, Minister of Transport and Communications, Government of Mozambigue

Ambassador Alfredo Alfredo Morelli, Director, Ministry of Foreign Affairs of Argentina, Argentina

Assignee: Nobody Ahmad Allam-m, Ambassadeur, CEEAC
Ahmad Allam-Mi, Son Excellence I'Ar deur, C: raute Ecor ique de Etats de I" Afrique Centrale

Locked: GAC Secretariat : Dr. Peter Alien, Chief Executive Officer, Ministry of the Public Service, Energy and Public Utilities, Government of Belize, Belze
(Seconds Ago) Steve Allison, Product Manager, ICANN, Examplestan

Hasina Andriamanjato, Minister of Posts Telecommunications and New Technologies, Madagascar

Actions Uc. Miguel Angel Lopez Perito, Ministro-Secretario General y Jefe del Gabinete Civil Presidencla, la Republica del Paraguay

Lic. Miguel Angel Lopez Perito, Ministro-Secretario General y Jefe del Gabinete Civil Presidencia, |a Republica del Paraguay
Camille Angué, GAC Representative, France

of Release Lock Markus Arbenz, Executive Director, [FOAM
Ibrahim Assane Mayaki, Chief Executive Officer, NEPAD Planning and Coordinating Agency
l Save ibrahim Assane Mayaki, CEO, NEPAD

@ Save/ Pubi .Akram Arallah, President Global Domains Division, ICANN, USA
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Content  History  References

= Correspondence Outgoing -
GAC

WIEnglish (US) v

Workflow
Step: Initial State
Assignee: Nobody
Locked: GAC Secretariat :
(Seconds Ago)

Actions

i’ Release Lock

d Save

& Save/ Publish
Assign Workflow

& Cancel

CcC:

Christopher A, Coons, U.S. Senator, United States

Nora Abusitta, Secretariat, NETmundial Initiative

Cristian Aguir, Deputy Minister of Communications, Infrastructure and Housing, Guatemala

Dr. Hessa Al-Jaber, Secretary General, ICT, Qatar

Mohammed Al-Tuwaljr, Assistant Secretary General for Economic Affairs, LAS

Carios Alberto Forete Mesquita, Minister of Transport and Communications, Government of Mozambigue

Carios Alberto Forete Mesquita, Minister of Transport and Communications, Government of Mozambigue

Ambassador Alfredo Alfredo Morelli, Director, Ministry of Foreign Affairs of Argentina, Argentina

Ahmad Allam-m, Ambassadeur, CEEAC

Ahmad Allam-Mi, Son Excellence 'Ambassadeur, Communaute Economique de Etats de |I' Afrique Centrale

Dr. Peter Allen, Chiefl Executive Officer, Ministry of the Public Service, Energy and Public Utilities, Government of Belize, Belize
Steve Allison, Product Manager, ICANN, Examplestan

Hasina Andriamanjato, Minister of Posts Telecommunications and New Technologies, Madagascar

Uc. Miguel Angel Lopez Perito, Ministro-Secretario General y Jefe del Gabinete Civil Presidencia, |a Republica del Paraguay
Uc. Miguel Angel Lopez Perito, Ministro-Secretario General y Jefe del Gabinete Civil Presidencia, |a Republica del Paraguay
Camille Angué, GAC Representative, France

Markus Arbenz, Executive Director, [FOAM

Ibrahim Assane Mayaki, Chief Executive Officer, NEPAD Planning and Coordinating Agency

Ibrahim Assane Mayaki, CEO, NEPAD

Alkram Atallah, President Global Domains Division, ICANN, USA

Signature:

42566442402722170516.png &) Browse... X Remove @ info

ICreate Notification:
. No
) Yes

8. Once the edits have been made, you can either select Cancel to negate the edits

Actions

o' Release Lock
kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will save the edits and not publish them

Actions

o' Release Lock

kd Save

& Save / Publish
Assign Workflow

& Cancel
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OR
Select Save / Publish which will save and publish the edits

Actions

o' Release Lock

d Save

@ Save / Publish I

Assign Workflow

4 Cancel

NOTE: Once Save / Publish is selected, the Outgoing Correspondence will be published in the
GAC Advice section of site.

ltemized Advice

Advice will be aggregated into an index in the Itemized Advice section so all site visitors have
visibility into all Advice / Actions. The Secretariat can attach Advice to Sessions so there is an
understanding of the context in which the Advice was generated. The Secretariat also can
attach Advice to a Communiqué and Outgoing Correspondence so it can be distributed.

The following screenshot illustrates the contents of the Advice Index:

Communiqués Correspondence Itemized Advice Principles & Guidelines

RELATES T0: Search Advic —mip |SEARCH ADVICE-
[smcntomc :] e Rakaton To Dvepdons ENTER KEYWORD Q
FIRST DATE
REF. NO. < TITLE ¢ DELIVERED VIA ® peuveren | ¢
2017-03-15
Mitigation of 2017-03-15 Miti i fD inN Ab ICANNS8 GAC Communique 15 Mar 2017
il -03- itigation of Domain Name Abuse q
Abuse * ? f

Lock

2017-03-15
Protection of the

Red Cross and 017<03-15 Protection of the Red Cross and Red Crescent

Red Crescent dagjgnations and identifiers
designations and

identifiers

ICANNSS GAC Communique 15 Mar 2017

ICANN |TYPE THE DOCUMENT TITLE | MONTH YEAR |113



Note the following elements of the Advice Index:

e Relates To Dropdown: This element is a list that contains topics that Advice has been
tagged with. When a topic is selected, only Advice tagged with the selected topic will
display in the index.

e Search Advice: This element is the search field that allows the user to search for Advice
by keyword(s)

e Reference Number: This element is a unique identifier applied to each piece of Advice.

e Title: This element is the title given to the piece of Itemized Advice.

e Delivered Via: This element specifies the content the Advice was related to when first
delivered.

o First Date Delivered: This element is the date the Advice was first delivered.
e Lock Icon: This element indicates the Advice is private for GAC Members only.

The following screenshot illustrates the contents of the Advice:
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Communiqués  Correspondence  ltemized Advice Principles & Guidelines

RELATED TOPICS: | b Ralated Topics

GAC ADVICE

st Defivered Date & Via Consenus

Reference No.: l
Reference Number P |2017-0315 Mitigation of | [First Delivered 15 Mar 2017 via:|  [Consenus:
Domain Name Abuse NA Conscensus met

Title » |2017-03-15 Mitigation of Domain Name Abusc |

The GAC advises the ICANN Board toc

Advice Statement P | L provide written responses to the questions Ested in the Follow-up Scorecand attached to this Communique, no
later than § May 2017 for appropeiate consideration by the GAC before the ICANN 59 meeting in Johannesburg,
taking into account that the ICANN President and CEO will act as contact point foe the GAC in this matter.

Rationale
The GAC Is secking 1o assess the effectiveness of fts Advice to the KCANN Board,

Annex 1 of the GAC Hyderabad Communigué sted 2 number of questions to conduct such assessment in relation
o Advice implemented as part of the 2013 Registrar Accreditation Agreement and the New g'TLD Registry
P | Agreement.

The GAC is also interested in assessing the contribution of the SSR and Contractual Compliance departments of
ICANN to the prevention and mitigation of domain name abuse.

While FCANN responded to Annex 1 of the GAC Hyderabad Communiqué, the information provided was not
sufficient to conduct the necessary assessments,

Note the following elements of the Advice:

e Related Topics: This element is a list that contains topics that Advice has been tagged
with.

e Reference Number: This element is a unique identifier applied to each piece of Advice.

e First Delivered Date & Via: This element specifies the content the Advice was related to

when first delivered and the date it was delivered.

Consensus: This element specifies if the Advice has met consensus or not.

Title: This element is the title given to the piece of Itemized Advice.

Advice Statement: This element is the Advice Statement specified in the Advice content.

Rationale: This element is the Rationale specified in the Advice content that supports the

Advice Statement.
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Creating Advice
To create new Advice content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site
& gacdevO Site Browser

3. Select Advice - GAC from the Type dropdown list.

Observe  Site Browser Content
Searve ages, Falcers & Fles  Manage v
& 92ctev0 Contenm Search Change She |~

+ Add New Content ~

showing 1-40 of 103 Export

OfMiciad

Thie VRL Tiie ;:t:l.: ::ﬂ“::"" ?l‘r:” ::::':“ Lant Editar Last ES% Date
Search ~ g Clear Search * B ) Mee e——
Figure 23: Navigating to the Content page within the Admin site will show all the Advice pages that have already been created.
4. Select the Add New Content button on the top right.
o e
Y ———
OfMciad
Tie VRL Tiie ::t:l'r‘; :::t:"‘ :'::N ::l'n‘;‘c:“ Last Editer Last BER Date
Advanced -
5. Complete the following required fields:
a. Title
b. URL Title (automatically created based upon the Title)
c. Privacy Setting (defaults to Private)
d. Consensus Setting (defaults to Consensus)
e. Official Date and Time
f. Advice Statement
g. Rationale
h. Reference Number
|
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Observe Site Browser Content
Observe Pages, Folders & Flles  Manage your Site

& gocdev0 Content Search Add/Edit Advice - GAC

Content

£ Advice - GAC

[ Title:
WiEnglish (US) |~
Workflow
URL Title:
Step: Initial State
Assignee: Nobody
Topic:
lick Hi ] i
Actions
kd Save Privecs Settine] Tivacy Setting:
@ Save / Publish ® Private
Assign Workflow (O Public

4 Cancel

Consensus Setting:

@ Consensus
() Non-Consensus

Official Date and Time:

\ - A

Observe  Site Browser Content
Otserve Pages, Folders A Mies Manage your Site

& 92cdev0 Content Search Add/Edit Advice - GAC

Content

€4 Advice - GAC Advice Statement:

WiEnglish (US) - Fle~ Edt~ Inset~ View~ Fomat~ Tools~
Fomas~ B 7 U & E X I B - -3 B ® B & R ¢~
Workflow

Step: Initial State
Assignee: Nobody

Actions

e Save
& Save/ Publish
Assign Workflow

@ Carcel
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Observe Site Browser Content

Observe Pages, Folders & Fles Manage your Site
& oscdev0 Content Search Add/tdit Advice - GAC
Content
Rationale:

& Advice - GAC
Filev Editv Insetv View~ Format~ Tools ~
Wi English (US) N
Fomas+ B /7 ¥ § E XE I B S-E-3 B @ B &L 2 ¢~
Workflow

Step: Initial State
Assignee: Nobody

Actions

e Save
& Save/ Publish
Assign Workflow

& Cancel

6. Select Cancel to negate adding the content.
Actions

kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will save the content and not publish it.
Actions

kd Save

& Save / Publish
Assign Workflow

& Cancel

OR

Select Save / Publish which will save and publish the content.
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Actions

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Advice will be published in the GAC Advice section
of site.

Relating Content to Advice

After Advice has been created and published, the Secretariat can relate Advice to a Session so
Advice displays in the related Session.

RELATING NEW CONTENT TO ADVICE

To relate new Sessions to Advice, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site

& gacdevO Site Browser

3. Select Advice - GAC from the Type dropdown list.

Observe  Site Browser Content
Pages, Fuiders & Fles  Manage v
& 9rcte0 Contenm Search Change Site -
+ Add New Content ~
showing 1-40 of 103 Export &
Officiad
Privacy Consensus Qate and Rsference
Tile MRL Tile Setting  Setting Time Number Lant Editer Last EO% Date

Marc Satvatiera

Search + &4 Cear Search Meeting Crentes on

Advanced

Figure 24: Navigating to the Content page within the Admin site will show all the Advice pages that have already been created.
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4. Click the Advice Name in the right pane to open the live editor interface for the page.

Observe  Site Browser Content
Poges, Folders & Mies  Marwge v

@ o0 Content Search Change Site |~
+ ASa New o
. = w 40 of Expo
Official
Se. Privacy Consessws  Dateand  Reference
Title VAL Tmie Setling  Setting Time Nunber Last Editar Last B4t Date
- W (en_uS Marraech maATIEeCh-3IVke-  Dubl conuness 112006 45454 ay phalce 1212016 11:45PM
e o - f4 Ocar Search AN ~
Advanced ° - /20 A ™
™
- - 20 ~
A

NOTE: You can refine your search by doing the following:

e Selecting any of the column headings to sort ascending and
descending

AND / OR

e Enter additional data in the “Search” field on the left and click the
Search button

5. After selecting the Advice that you would like to modify, the editor will be displayed. Lock
the page for editing by clicking on Lock for Editing under the Actions menu.

Observe  Site Browser Content
serve Pepes, Poiders B Pies  Masage your Ste
gacdev0 Contert Search Add/Edit Advice - GAC
Contert  History  References

£ Advice - GAC

Tithe:
-t ’ -
Marrakech: Advice to ICANN for gTLD
Workflow
URL Tithe:
Step £
adv:
Assignee: Nobody
Topic:
Actions Click Here to Select Categories
v Privacy Setting:
Private
- "
Official Date and Tiene:
11/1/2016 v 12:00MM |~
I |
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6. Once the Advice content has been locked, select the Relate dropdown list.

Observe  Site Browser Content
Conerve Pages, Folders & Fles  Manage your Ste
Guobal Page P Oevl Contennt Search Add/Eon Agvice - GAC

Content Hstory References

£ Advice - GAC

WEngish (US) -

Workflow
Step: Inbal State
Assignee: Nobody

Locked: GAC Secretarat

Actions
) Release Lock P
- SWve WYSIWYG | » Language Variy
& Save /[ Pubish
Assign Workfow Reference Number:

& Canced

ties

Session - GAC: Parent (MeotingGac-AdviceGac)

URL Privacy Time

Title ritte Setting Zone

Officlal  Start End

Date
and
Time

Room Recording

7. Select Relate New Content from the Relate dropdown list.

Observe Site Browser Contemt
Oouerve Pages, Falders & Fles  Manage your Ste
Giotel Page Pocdev Content Search Add/Ean Advice - GAC

Content History References

£ Advice - GAC

Wi Drghsh (US) -

Workflow

Step: [Nzl State
Assigmee: hotody
Locked: GAC Secretarist

Actions
£ Relosse Lock p
- S WYSIWYG | » Language Variables
- Save / Pish l
Assign Workflow Reference Number:

1

Session -~ GAC: Parent (MeetingGac-AdviceGac)

URL Privacy Time

Title 1ite Setting Zone

Official

Room ummq:;'

Time

Woras: 4
International
Date Date Phone
Par Part Parti

and and Numbers
Time Time URG - e

Woeds: 4

4 Ralate) ~

Start End  _ _ o L Melste
D:- w Partici Par Participats |* Ralste New Cortent I
a
Time URL Phone Access Code

8. Complete the following required fields to create a new Session to relate Advice to:
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a. Title
b. URL Title (automatically created based upon the Title)
c. Type (defaults to GAC Meeting)
d. Status (defaults to Open)
e. Privacy Setting (defaults to Private)
f.
g. Official Date and Time
Observe Site Browser Content
Observe Pages, Folders & Flles Manage your Site
& g9acdev0 Content Search Add/Edit Session - GAC

Content Remote Participation Relationships

& Session - GAC

Time Zone (defaults to UTC+00:00 — Coordinated Universal Time (UTC))

Title:
Wi English (US) v

Workflow

URL Title:

Step: Initial State

Assignee: Nobody

Type:
® GAC Meeting

Actions GAC Working Group Meeting
GAC Break
d Save
& Save / Publish Status:
Assign Workflow ® Open
& Cancel Closed

Privacy Setting:

® Private
Public
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Observe Site Br Content
Observe Pages, Folders & Files Manage your Site
& gacdev0 Content Search Add/Edit Session - GAC

Content Remote Participation Relationships

Topic:
& Session - GAC lick Her
Wl English (US) =
Time Zone:
Workflow UTC+00:00 - Coordinate ~

Step: Initial State

Assignee: Nobody Room:
Actions
Recording:
kd Save

& Save/ Publish

Assign Workflow

pa | Official Date and Time:
& Cance

- -

9. Select Cancel to negate creating the Session and relating it to the Advice
Actions

kd Save
& Save / Publish

Assign Workflow

¢ Cancel

OR

Select Save which will create the Session, relate it to the Advice and not publish
Actions

kd Save

& Save / Publish
Assign Workflow

¢ Cancel
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OR

Select Save / Publish which will create the Session, relate it to the Advice and save /
publish the Session

Actions

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE:
e Once Save / Publish is selected, the Itemized Advice will be published in the GAC
Advice section of site.
e Selecting Session will create Session content that is attached to a piece of Advice but is
also independently accessible and will display in their respective site section.

RELATING EXISTING CONTENT TO ADVICE

To relate existing Sessions to Advice, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site

& gacdevO Site Browser

3. Select Advice - GAC from the Type dropdown list.
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Observe  Site m Content
& r0tev0 ' Contenm Search Change Site |~
+ Add New Content ~
showing 1-40 03 Export &
Officiad
Privacy Consensus Qate ond Reference
Tivle VRL Tiie Setting  Setting Time Number Lant Editer Last BO% Date
, Search ~ a4 Cear Search * B "
Advanced ’ 'v‘,,.h,. -
Figure 25: Navigating to the Content page within the Admin site will show all the Advice pages that have already been created.
4. Click the Advice Name in the right pane to open the live editor interface for the page.

Mf" "". lfowm Content

& sacoevd Content Search Change Site

+ Add New Contert ~
A = W 40 of Expo
OfMcial
Search Privacy Consensws Dete oo Reference
Title VAL Tmie Setting  Setting Tims Nunber Last Editar Last B4t Date
— ——— - - ~ - - i3 45454 Viay phalce 123016 L1:45PM
Advanced - - L

NOTE: You can refine your search by doing the following:

e Selecting any of the column headings to sort ascending and
descending

AND / OR

e Enter additional data in the “Search” field on the left and click the
Search button

5. After selecting the Advice that you would like to modify, the editor will be displayed. Lock
the page for editing by clicking on Lock for Editing under the Actions menu.
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Observe  Site Browser Content
Otserve Pogen, Poders B Fles  Manage your Ste
Giotal Page gacdev0 Contert Search Add/Edit Advice - GAC

Contert History References

& Advice - GAC

Tithe:
i Englah (US) -
Marrakech: Advice to ICANN for gTLD
Workflow
URL Tithe:
Step: [Nl Stan
s marrakech-advice-to-icann-for-gtid
Assignee: Nobody
Topic:
Sews CQlick Here to Select Categories
I B Lock for EdRing ]
& Cancel Privacy Setting:
Private
& Pubiic
Consensus Setting:

& Consensus
Non-Consensyus

Official Date and Tiee:

11/1/2016 * 1200MmM |~

Observe  Site Browser Content
Comerve Pages, Folders & Fles  Marage your Ste
Guobal Poge P Corternt Search Add/Eon Advice - GAC

Content Hstory References

£ Advice - GAC

W English (US) -

Workflow
Step: Inbal State
Assignee: Nobody
Locked: GAC Secretarat

6. Once the Advice content has been locked, select the Relate dropdown list.

Actions
o Release Lock » Words: 4
el Seve WYSIWYG | » Language Variables
@ Save/ Publsh ‘
Assign Workfiow Raference Number:
& Canced 1
Session - GAC: Parent (MeetingGac-AdviceGac)
Officlal  Start International
munxmmm.M.“mem p Phone
T = = e cose amber
7. Select Relate from the Relate dropdown list.
L}
| 126
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Observe  Site Browser
Otaary Pages, Folders & Fies

Gloter Pege gactevd

Contert History

£ Advice « GAC

M Englsh (US)

Workflow

Step: Initial State
Assignee: Nobody

Locked: GAC Secretariat

Actions

§ Release Lock

b Save

& Save/ Publish
Assign Workfow

& Cancel

8. Once Relate is selected, a Search pop-up will display. Select the Search button to

Comtent
s Marage your Ste
Conternt Search Add/Ean Advice - GAC

References

P

WYSIWYG | » Language Variabiles

Reference Number:

45454

Session -~ GAC: Parent (MectingGac-AdviceGac)

Title

URL Privacy Time
Title Setting

Official  Start End

| Relste

{ Relste ~

Date Date Date

and and and
Time Time Time

Par Par

URL Phone

Access Code

Bnk

return all results or enter criteria in any of the Search fields to refine the Search results

returned.

Search:

Language
Title:

Host Folder:
Type:

Privacy
Setting:

Recording:

GAC Meeting
GAC Working Group Meeting
GAC Break

Private
Public
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Start Date -
and Time:

End Date and
Time:

Lead(s):
Objectives:

Expected
Outcomes:

Minutes:

Action Items:

Remote
Participation
URL:

Remote
Participation
Phone:

Remote
Participation
Access Code:

International

Phone
Numbers link:

& Gieo Search

Figure 26: You can refine your search by entering additional criteria in the Search pop-up and then selecting the Search button.

9. Once the Search button is selected, the results will display in the right side of the Search

pop-up.
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Search:
Minutes: Matching Results (306)
Priv Ti
Action Items: Language Title URL Title sml.:: z;:: Room Recording|
Remote gac-
Participation GAC Working working-
URL: Group group-
Sl English (US) MeetingBQ meetingbq- private UTC  Hall A
Remote Session28-11-  session28-
Participation 16::15:30:588 11-16-15-
Phone: 30-588
gac-
Remote GAC Working working-
Participation Group group-
Access Code: Wi English (US) MeetingBQ meetingbq-  private  UTC  Hall A
Session2B8-11-  session28-
International 16::15:03:695 11-16-15-
Phone 03-695
Numbers link:
gac-
@ Clear Search GAC Working working-
Group group-
Sl English (US) MeetingBQ meetingbq- private  UTC  Hall A
10. Select the checkbox next to the Session that you would like to relate to Advice.
Search:
Minutes: Matching Results (306)
Priv Ti
Action Items: Language Title URL Title sml.:: z;:: Room Recording
Remote gac-
Participation GAC Working working-
URL: Group group-
D Sl English (US) MeetingBQ meetingbq- private UTC  Hall A
Remote Session28-11-  session28-
Participation 16::15:30:588 11-16-15-
Phone: 30-588
gac-
Remote GAC Working working-
Participation Group group-
Access Code: Wi English (US) MeetingBQ meetingbq-  private  UTC  Hall A
Session2B8-11-  session28-
International 16::15:03:695 11-16-15-
Phone 03-695
Numbers link:
gac-
& Clear Search GAC Working working-
Group group-
Sl English (US) MeetingBQ meetingbq- private  UTC  Hall A
11.0nce the checkbox next to the Session that you would like to relate to Advice is
selected, select the Relate button at the bottom of the page.
.|
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S English (US) Meeting8Q meetingbg-  public (e Hall A
Search: Session22-11-  session22-
16::18:34:189  11-16-18-
Minutes: 34189
Action Items: gac-
GAC Working working-
Group group-
Remote v Sl English (US) MeetingBQ meetingbq- private  UTC  Hall A
Participation Session22-11-  session22-
URL: 16::18:27:644 11-16-18-
27-644
Remote
Participation gac-
Phone: GAC Working working-
Group group-
Remote i English (US) :‘::lnngso ::::“"9"“' private | UTC  Hall A
::::‘::p;;::: Session21-11-  session21-
’ 16::17:29:368 11-16-17-
International 29-368
Phone
Numbers link: Next ©
4, Search 4 Clear Search
4, Relate
12.Select Cancel to negate adding the content.
Actions
o' Release Lock
kd Save
& Save / Publish
Assign Workflow
& Cancel
OR
Select Save which will save the content and not publish it.
Actions
o' Release Lock
kd Save
& Save / Publish
Assign Workflow
& Cancel
. ___________________________________________________________________________________________| .|
ICANN |TYPE THE DOCUMENT TITLE | MONTH YEAR | 130



OR

Select Save / Publish which will save and publish the edits.

Actions

Release Lock

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Advice will be published in the GAC Advice section
of site.

Updating Advice
To update Advice content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site

& gacdevO Site Browser

3. Select Advice - GAC from the Type dropdown list.

@ 90c0en0 Conten Search Change She (-

+ Add New Content  ~
showing 1-40 03 Export &
Officiad
Privacy Consensus Qate ond Reference
Tivle VRL Tiie Setting  Setting Time Number Lant Editer Last BO% Date

Marc Sadvatiema

, Search ~ a4 Cear Search
reated on

Advanced

Figure 27: Navigating to the Content page within the Admin site will show all the Advice pages that have already been created.

4. On the right side on the Content Search page, select the Advice you would like to update
by clicking on the Title.

e ——— —
ICANN |TYPE THE DOCUMENT TITLE | MONTH YEAR |131



Observe  Site Browser Content
Sanrve Pages, Foiders & Fles  Manage v

& 9rcteO Content Search

Thie

Advanced ™ (en US Marracech

R Tithe

Privacy Consensus
Setting  Setting

NOTE: You can refine your search by doing the following:

Officiad
Qate and
Time

Reference
Number Last Editer

e Selecting any of the column headings to sort ascending and

descending

AND / OR

Change Site [«

& AGS Naw Contert ~

txport

Last £4it Date

e Enter additional data in the Search field on the left and click the Search

button

5. After selecting the Advice that you would like to modify, the editor will be displayed. Lock
the page for editing by clicking on Lock for Editing under the Actions menu.

e ——
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Observe  Site Browser Content
Couerve Pages, Forders & Flles  Manage your Site

Giodel Page Qsctev0 Comtert Seaech ASH/ Bt Advice - GAC

Content History References

& Advice - GAC

Title:
Wl English (US) -
Advicn created independently
Workflow
URL Title:
Step: Initial State

advice-created-independently

Assignee: Nobady

Tople:
Actions Qlick Here to Select Categories
K for Edring
& Cancel Privacy Setting!
Private
& Pubiic

Consensus Setting:
® Consensus

Non-Consensus

Official Date and Time:

9/6/2016 v 4:30PM | v

6. Modify any of the following fields:
Title

Topic

Privacy Setting
Consensus Setting
Official Date and Time
Advice Statement
Rationale

Reference Number
Related Session

TSQ@mP a0 oY
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Observe  Site Browser Content
Otsrve Pages, Foicers & Fles  Manage your Soe

& Glotel Page QacdevO Conmtert Search ASd/ LIt Advice - GAC

Content  Mistory  References

£1 Advice - GAC

Title:
Wi Englsh (US) )
ICANN100 Advice received for gTLD Safegaurads
Workflow
URL Title:
Step: Initial Stane
ikann100-advice-received-for-gtid-safegaurads
Assignee: Nobody
Locked: GAC Secretariat : Topic:
(Seconds Ago)
Qlick Here 1o Select Categories
e ® pubic Satety ® sategeands
of Release Lock
W Save |ﬁm Setting:
Private
& Save/ Pusisn ® Public
¢ Assign Worldflow
& Cancel
& Consensus
Noo-Consensus
Date and Time:

11/3/2016 w 12:00AM =

Observe Site Browser Content
Observe Pages, Folders & Fles  Manage your Ske

& Global Page gocdev0 Content Search

Content  History  References

Add/Edit Advice - GAC

Advice Statement:
£ Advice - GAC
p— Flev Edit~ Inset~ View~ Format~ Tools ~
WIEnghsh (US) - — = -
‘ fomas+ B / YV § E E I B E-E-32 3 ® E L R v~
Workflow TLD Safeguards
Step: Initial State
Assignee: Nobody The GAC appreciates the efforts of the ICANN Board New gTLD Program Commitiea (NGPC) since the 2013 Bajing meeting to respond to
L ockadh GAC SecTatariat = the GAC's Safeguard advice. At the same time, cespte g provided by the GAC in Communiqués generated during
. = ) WWNW MMNNISICANN InSl with the new gTLD Applicants have continued
e without the GAC previ wod pe requinng the verifcaton of credentials for domans in hghly reguiated
Acti Nonetheless, the GAC notes that an increasing number of Registries and Applicants for strings related to highly regulated seclors have,
mmwm Mmmbmmmmwmmum These Applicants and
G that Y can be based on the GAC advice.
o Release Lock The GAC recommends that the NGPC:
w S + Create a st of commended public (PIC) related 1o verification and validation of credentials for domains
@ Save/ Publish i highly reguiated sectors 10 5erve as 8 model. These public coukd 8 best for other gTLD
registry operators. For example the PIC for .bank appears to have taken steps 10 provh f o that they can rely
Assign Workflow on the bona fide of the Regi listed. Rek keh should be identified and encouraged (o devise a set of PICs that work
well for the protection of pubic interests in each of the new gTLDs related 10 highly regulated sectors,
@ Cancel The GAC addiionally recommends:

« that the ICANN community creates a harmonised methodology %o assess the number of abusive domain names within the current
exercise of assessment of the new gTLD program.

« that the NGPC clarifiesits acceptance or rejection of Safeguard acdvice, It would be useful 10 Gevelop a straighticrward scorecard on all
ma&cwmmmmmnwmmm»mmmammm
been implemented, what remains a work in progress, and what has not been of
mamwdmmummmmnomu K lobo in ceder 10 seek

s Saa MY ANAL S O dan o 4
4 Words: 360,
| -
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Content

Manage your Ste

Observe Site Browser
Observe Pages, Folders & Fles

& Global Page gacdevl Content Search

Content History  References

Add/Edit Advice - GAC

Rationale:

£1 Advice - GAC
= Fllo ~

WiEnglish (US) -

Workflow

Step: Initial State
Assignee: Nobody
Locked: GAC Secretariat :

(Seconds Ago)

f Release Lock

d Save

@ Save/ Publish
Assign Workflow

& Cancel

Formats ~

Edt ~

This is test rationale

Insert ~

View ~

B /7 VYV § E E = E

Format +  Tools ~

Evis- B B W B KL 2 v~

Observe  Site Browser Content

Otasrve Pages, Facers & Fles  Manage your Ste
& Glotel Page oacdev0 Comert Search Add/Edit Advice - GAC
Content  History  References
£1 Advice - GAC
W Englsh (US) -
Workflow

Stepe Initial State

Assigmee: Notudy
Locked: GAC Secretariat :

Seconds Ago,
P

WYSIWYG | »
of Release Lock i

Language Variables:

Reference Number:
@ Save/Pusish

Assion Workflow 897
& Cancel
4 Session -~ GAC: Parent (MeetingGac-AdviceGac) Relote ~
Official Start  End »
it URL Tith Pr'v.cv‘l’hm. R " Date Date Date sy et Relanas "
L and sd and :J;l. Phone Access Code  link
Time Time Time
x KA carn100- Pubinc (514 WVIWIG  IM6 LIS LD [/ GO Comy
I L}
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7. Once modifications have been made, you can either select Cancel to negate the edits.

Actions

Release Lock
kd Save
& Save / Publish

Assign Workflow

4 Cancel

OR

Select Save which will save the edits and not publish them.

Actions

Release Lock

kd Save

& Save / Publish
Assign Workflow

4 Cancel

OR

Select Save / Publish which will save and publish the edits.

Actions

Release Lock

kd Save

& Save / Publish

Assign Workflow

4 Cancel

NOTE: Once Save / Publish is selected, the Itemized Advice will be published in the GAC
Advice section of site.
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Principles & Guidelines

The Principles & Guidelines section only contains migrated content. New content cannot be
created within dotCMS and existing / migrated content cannot be modified within dotCMS. If
new content needs to display, it will need to be migrated. If there is a need for a future
enhancement to create new Principles & Guideline, that request will need to be submitted to
ICANN ICT.

The following screenshot illustrates the contents of Principles & Guidelines:

Communiqués  Correspondence  Itemized Advice  Principles & Guidelines

EDITION
l INTERIM GAC PRINCIPLES ON IDN CCTLD ¢ ¢
Interim GAC Principles on IDN rinciples Mn-cctide paf
ccTLDs
2) PDF [r6kb ]4—
DFFICIAL DATE:
D
March
210 March 2010 Annex A
TOPICS DISCUSSED: n . 2end 3
ADVICE  INTERNATIONALIZED DOMAIN NAMES GAC Interim Principles on IDN ccTLDs
COUNTRY CODE TOP LEVEL DOMAINS
1. m_mm_ThL main pmm.mm of the (u\( ccﬂ lk pnnctplm
T Code Top Level Domains™ apply nlso fnr lDY\ ocTLDs. The current principles
are intended to supplement the aforementioned principles insofar as non-ASCII
o¢TLDs are concerned.

2. The introduction and operation of IDN ocTLDs should not undermine the
sccurity and stability of the DNS. To this end, all actors, including TLD
operators, ICANN and the relevant government should work together to ensure
that the highest standards of TLD operation are achicved, taking account of best
practices and intermnationally accepted technical standards where they exist.

Note the following elements of Principles & Guidelines:

e Title: This is the title given to the Outgoing Correspondence in dotCMS.

e PDF Link: Selecting this link will display the Outgoing Correspondence in PDF format.

o Official Date: This is the date that has been specified as the Official Date on the
Principles & Guidelines.

e Topics Discussed: This is the categories / taxonomy attached to the Principles &
Guidelines.

o Edition Dropdown List: The dropdown list allows you to select other published Principles
& Guidelines.

e Uploaded File Name: This is the name of the file that was uploaded to create the
Principles & Guidelines.

e Number of Pages: This is the number of pages of the Principles & Guidelines.

¢ Rotate Clockwise Icon: Selecting this icon will rotate the Principles & Guidelines
clockwise.
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e Download Icon: Selecting this icon will allow you to download the Principles & Guidelines
to your computer.

e Print Icon: Selecting this icon will allow you to print the Principles & Guidelines.

e Principles & Guidelines: This is the Principles & Guidelines page(s) that were uploaded
to dotCMS.

Updating Principles & Guidelines

To update the Principles & Guidelines content, a request will need to be sent to the Web
Administration team.

Meetings & Records

The Meetings & Records section allows GAC Members to be informed of upcoming, current
and past events so they can fully participate in those events. GAC Members can also view
documentation associated to those events. The major content included within Meetings &
Records includes:

e Calendar (including Sessions)
e |ICANN Meeting Agendas
e |ICANN Meeting Minutes

Introduction Header

The Introduction Header is meant to orient site visitors to the Meetings & Records page and
give them a basic understanding of Agendas, Sessions, Meetings Minutes and their related
artifacts.

The following screenshot illustrates the contents of the Meetings & Records Introduction:
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L\"A ICANN.org English “wal Espaiol Francais Pycckmi X Login/Register <C>

ICANN|GAC

NEWS ABOUTTHEGAC GACADVICE MEETINGS &RECORDS WORK EFFORTS

Meetings & Records|®]«— =

l

GAC meetings are usually conducted in
conjunction with an ICANN meeting. They
may also be conducted inter-sessionally. GAC
meetings are usually open. This part of the
website provides both GAC Members and
others members of the community with
access to past, present and future GAC
meeting  material — including  agendas,
transcripts, location details, recordings and
minutes. For GAC Members there is also T
access to preparatory material ahcad of

forthcoming meetings such as the draft
agenda, bricfings and presentations, remote
participation details and travel assistance.
Vijay Mtg & records intro text

ATTENDING YOUR FIRST GAC
MEETING

TRAVEL ASSISTANCE

GUIDELINES FOR HIGH LEVEL
GOVERNMENT MEETINGS

Note the following elements of the Meetings & Records Introduction:

¢ Introduction Text: Brief informational section that informs the user of the Meetings &
Records section

¢ Introduction Links: Links to resources to help educate the user about GAC Meetings and
Travel Assistance. The links and destinations are listed below:

o Attending Your First GAC Meeting: Selecting this link will automatically open
https://gacbeta.icann.org/meeting-services/attending-your-first-gac-meeting page.

o Travel Assistance: Selecting this link will automatically open
https://gacbeta.icann.org/meeting-services/travel-assistance page.

o Guidelines for High Level Government Meetings: Selecting this link will
automatically open https://gacbeta.icann.org/meeting-services/guidelines-for-high-
level-government-meetings page.

e Collapse Introduction: Selecting “X” will collapse the Introduction section
e Expand Introduction: Selecting “i” will expand the Introduction section

Updating the Introduction Header

To update the Introduction Header content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Site Browser tab from the top navigation.
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Site Browser Content
Pages, Folders & Files Manage your Site

Figure 34: Navigating to the Site Browser page within the Admin site will show all the editable pages that you are able to modify.

3. On the Site Browser page, within the left pane, click on the meetings-records folder.

Site Browser Content
opes, Pebders & Ties Mgt Yo S
& seccevd $ite Browaer Chasge Site (7
Stos and Folders W Enghsh (US) - & Add New =
Name Mery  States Mod Veer Mad. Date
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oigeaten | aaen
ety * o - LI Mee AR - o o
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T seisan-advie- content . - e SemonAdvice Comert Asvt Mme
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WODMgE el services
e el e o Srow Arovend
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Figure 28: Clicking the meetings-records folder in the left pane will show the folders contents in the right pane. Notice that it
includes the index html file.

4. Double click the index html page in the right pane to open the live editor interface for the

Site Browser Content
opes, Pebders & Ties Mgt Yo S
& seccevd $ite Browaer Chasge Site (7
Stos and Folders W Enghsh (US) + 230 New
Name Mery  States Mod Veer Mad. Date
scvee
privete
ogendn
orpiioten L aaen
L e ] = meemgiaencerieny . - Ve <ot LN -
Flo-anaat T mestnglorscete - e et e Devesh Satn 3 A
. T seson- adve- onant - - e fewon Advice Comert  Arvt s ™
eger

Wrpage et services
W e e o Show Arovend
gt
g e
| meemnge-recorce

e

Figure 29: Double clicking index from the right pane will open the page in its Live Editor which allows the Secretariat to modify the
contents of this page.

5. From the live editor mode, first lock the page for editing.
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Preview Live

{4, Lock for Editing

@& Publish Page
=2 Remote Publish Page
& Add To Bundle

6. Click on the Edit Content button in the part of the Introduction section that needs to be

edited.
GAC  meetings arc  usually] - e contorn TR TN AL Al | 7 e Conten
conducted in conjunction with f\\ilpll‘,l,“r?{?(l;\(' YOUR FIRST GAC

ICANN meeting. They may also be conducted

inter-sessionally. GAC meetings are usually

open. This part of the website provides both TRAVEL ASSISTANCE

GAC Members and others members of the
community with access to past, present and
future GAC meeting material including

GUIDELINES FOR HIGH LEVEL
GOVERNMENT MEETINGS

agendas,  transcripts, location  details,
recordings and minutes. For GAC Members
there is also access to preparatory material
ahead of forthcoming meetings such as the
draft agenda, bricfings and presentations,
remote  participation details and travel
assistance. Vijay Mtg & records intro text

Figure 30: Clicking the Edit Content button will open a text editor that allows the Secretariat to change the contents of the
Introduction section.

7. After clicking Edit Content, the editor will be displayed. Lock the page for editing by
clicking on Lock for Editing under the Actions menu.

Actions

& Lock for Editing

& Cancel

8. Modify only the Body editor’s content as shown by the figure below.
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Content History

&£ Content (Generic)
Title:
Wi English (US) -
Meetings & Records intro text

Workflow
URL Title:

Step: Initial State
Assignee: Nobody

meetings-records-intro-text

Locked: GAC Secretariat : Body:
(Seconds Ago)
Flev Editv Inset~ View~ Format~ Tools v
Actions — _ X
Fomats~ B / U & E E H B .- 3 B W E & 2 -
o Release Lock [
mnnnumnmmmm%mMNnﬁw They may also be conducted inter-sessionally. GAC meetings are
kd Save usually open. This part of the website pe both GAC Members and others of the y with accass 10 past, present and
MunGAC g material including &g mmmmmwnmmmmmmmmmw
& Save / Publsh ahead of for gs such as the draft ag g p remote par details
travel nm Vigay Mig & records m et
Assign Workflow
& Cancel
Observe Site Browser Content
Otnerve Pages, Folders & Fles Marage your Ske
& Global Page gacdevD Sie Beowser Add/Edit Content (Generic)
Content History
& Content (Generic)
Title:
W English (US) >
Meetings & Records intro links
Workflow
URL Title:
B E meetings-records-intro-links
Assignee: Nobody
Locked: GAC Secretariat : Body:
(Seconds Ago)
File* Edit~ Inset~ View~ Fomat~ Tools~
Actions — - N
Fomats~ B /7 YU & E E I B -i-3F B W E & &2 v~
of Release Lock
ATTENDING YOUR FIRST GAC MEETING
d Save
IRAVEL ASSISTANCE
@ Save / Publish
GUIDELINES FOR HIGH LEVEL GOVERNMENT MEETINGS
Assign Workflow
& Cancel

9. Once the edits have been made, you can either select Cancel to negate the edits.

e —
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Actions

kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will save the edits and not publish them.
Actions

kd Save

& Save / Publish
Assign Workflow

& Cancel

OR

Select Save / Publish which will save and publish the edits.

Actions

kd Save

& Save / Publish

Assign Workflow

¢ Cancel

10. Select Release Lock to release the lock on the content.
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Edit Preview Live

Release Lock

Publish Page

Remote Publish Page

By ©|s

Add To Bundle

Assign Workflow

Calendar

The Calendar on the Meetings and Records page provides site visitors visibility to Sessions that
have been created (Scheduled & Unscheduled). It allows a site visitor to select a specific day
on the Calendar and view all Sessions (GAC Meetings and/or GAC Working Group Meetings),
their details and artifacts scheduled on that day based upon the site visitor's permissions.

NOTE: Once Sessions are created and scheduled, the sessions will display when that day is
selected on the calendar. If Sessions are created and not scheduled, all unscheduled Sessions
will display in the Unscheduled section that displays below the scheduled Sessions.

The following screenshot illustrates the contents of the Calendar:

Calendar  ICANN Meeting Agendas  ICANN Meeting Minutes

INCLUDE TOPCS: SEARCH CALENDAR
e | GAL MEETINGS — [SELLUATOFIC :] IU"U' KEYWORD P U
GAL WG MEETINGS
> [< December 2016 ’] Saturday, 3 December 2016
~ T w T F s
1—2 3 11:00 - 12:00 UTC Private Test Session 01

5 6 7 8 9 10 | room:

" 11 12 13 14 15 16 17
18 19 20 21 22 23 24 | 1%00-1300UTC
25 2628 29 30 31 Wetivomd

" Unscheduled Meetings

Private Test Session 05

T8D NJ Unscheduled session
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Note the following elements of the Calendar:

Include Checkboxes: Selecting these checkboxes will display meetings where the
Meeting Type has been indicated to be GAC Meetings or GAC WG (Working Group)
Meetings.

Topics Dropdown List: This dropdown list allows categories / taxonomy to be selected so
only meetings that have been tagged with the category / taxonomy selected will display.
Search Calendar: This field allows the user to search meetings for a keyword(s) so only
those meetings display.

Month Selector: This field allows the user to select the month they would like to see
displayed in the calendar.

Selected Day: The selected day will display with a white background.

Sessions Scheduled Day: The days Sessions have been scheduled on will display with a
blue background.

No Sessions Scheduled Day: The days that don’t have any Sessions scheduled will
display with a gray background.

Scheduled Sessions: This section displays all the published Sessions scheduled on the
day selected on the Calendar. The Session name is a link that will display the Sessions
Details when selected.

Unscheduled Sessions: This section displays all published Sessions that have not been
scheduled. The Session name is a link that will display the Sessions Details when
selected.

Session

The Session content allows GAC Members to specify Session details and attach important
artifacts pertaining to the Session. It also allows site visitors the opportunity to view Session
detail, included but not limited to, date, time, location and artifacts pertaining to the Session. A
relationship can be established between Sessions and an Agenda so when the Agenda is
viewed, all Sessions that have been related to that Agenda will display. A relationship can also
be established between Sessions and Advice so the Advice can be traced back to the Session
from which it originated.

The following screenshot illustrates the contents of the Sessions:
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Calendar  ICANN Meeting Agendas  ICANN Meeting Minutes

[08:00 - 09:00 UTC||[Example Session|

T

‘— 3 Transcript I‘_ K BlRecordin! —
Teaas:
Example Leads. “
Objectives:

Example Objectives

Expected Outcomes:

Example Expected Outcomes
Actions:

Example Action Items

&
-

Brief & Presentation Materials:
3 Plenary Bricf [S K8]
3 Plenary Presentation One [SKB]
3 test transeript [419 KB)

Note the following elements of the Sessions:

Start & End Time: This element is the start and end times of the Session.

Title: This element is the title given to the Session.

Room: This element is the room in which the Session will be held.

Transcript Link: Selecting this link will display the official transcript of the Session.
Recording Link: Selecting this link will navigate the user to the recording of the Session.
Leads: This element is the Leads specified on the Session.

Objectives: This element is the Objectives specified on the Session.

Expected Outcomes: This element is the Expected Outcomes specified on the Session.
Actions: This element is the Actions specified on the Session.

Brief & Presentation Materials: These elements are the Briefs, Presentations &
Transcripts related to the Session.

Creating a Session

To create a new Session content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.
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Observe Site Browser

Observe

- gacdev0

3. Select Session - GAC from the Type dropdown list.

Pages, Folders & Files

Site Browser

Observe  Site Browser Content

& oscdev0 Content Search

Content
Manage your Site

Change Sie [~

= Add New Comtent ~

oe showing 1-40 of 313 Export &
Officiad
Search Privasy Time Cate and StactDate |
Titie VRL Title Setting Zone Room Recording Time andYime
. W (en_US Cxampie Session exanzie public UTC  Crocker W Google com 12 16
L Search ~ ¥ Cear Search $
- - s ot Se ~

Advanced

Figure 31: Navigating to the Content page within the Admin site will show all the Session pages that have already been created.

4. Select the Add New Content button on the top right.

Observe  Site Browser Content
rerve Pages, Folders & Fles  Masage v
& oscdev Content Search
e | Ses a = showing 1-40 of 313 Export &
Officiad
Search Privasy Time Date and Stact Date |

Titie VRL Title Setting Zone Room Recording Time andYime

. W (en_uS Cxampie Session example pubiic UTC  Crocker www Google com

\ Search ~ &4 Cear Search

- W (en_uS Private Test Sesson 02 private-test private uTC Rooe 1
Advanced

5. Complete the following required fields:

Title

URL Title (automatically created based upon the Title)

Type (defaults to GAC Meeting)

Status (defaults to Open)

Privacy Setting (defaults to Private)

Time Zone (defaults to UTC+00:00 — Coordinated Universal Time (UTC))
Official Date and Time

@ ~oapow
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Observe  Site Browser Content
Oteerve Pages, Tokders & Fles  Manage your Ste
- Jacoed Cornent Search Ad0/Ean Sesson - GAC Change Site |~

Content  Remote Participation | Refationships

Title:
£ Sesslon - GAC
Wi English (US) -
e
Step! Inval State .
e & GAC Meeting
GAC Working Group Meeting
Act GAC Broak
 Sove [raras ]
& Save/ Publish & Open
Assgn Workflow Closed
& Canced
T TR T TITY e
Privacy Setting:
& Private
Public
Topic:
Cici Mere to Select Categories
Time Zone:

UTC+00:00 - Coordnate | ~

Observe  Site Browser Content
Otsarve Pages, Folders & Fles  Manage your St

- oo Content Search Aod /it Session - GAC Change She ||

Content Remote Participation Relationships

Date and Time:
£ Sesslon - GAC
- -
M Engien (US) -
Start Date and Time:
Workflow
. -
Step: Intial State
Assignee; Nobody End Date and Time:
- -
Actions
W Save Lead(s):
@ Save/ Pubish Fle* Edt~ Iset~ View~ Fomat~ Tools~
Aasign Workdiow fomas> B /7 ¥ S E X I B - -3 A B & &L 2 ¢~
& Cancel

6. Select Cancel to negate adding the content.
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Actions

kd Save
& Save / Publish

Assign Workflow

¢ Cancel

OR

Select Save which will save the content and not publish it.
Actions

kd Save

& Save / Publish
Assign Workflow

¢ Cancel

OR

Select Save / Publish which will save and publish the content.
Actions

kd Save

& Save / Publish

Assign Workflow

¢ Cancel

NOTE: Once Save / Publish is selected, the Session will be published in the Meetings &
Records section of site.

Adding Remote Participation

To add or edit Remote Participation, follow the following steps:
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1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site

& gacdevO Site Browser

3. Select Session - GAC from the Type dropdown list.

Content

..... Marny

W oscden0 Content Search Change SRte |~

+ Add New Content ~

showing 1-40 of 313 Export
Officiad
Search Privasy Time Cate and StactDate |

Titie URL Title Seiting Zone Room Recording Time and Yime
- W (en US faampie Sesson example pubs UTC roceer www Googhe com A2/2016 1263016

Search « £ Cear Search sesucn 8 15AM 8 AM
- W (en US Private Test Season 02 private-test private UTcC Soom 1 12 2018 12, 016

Advanced Sesston-02 o =809

Figure 32: Navigating to the Content page within the Admin site will show all the Session pages that have already been created.

4. Click the Session Name in the right pane to open the live editor interface for the page.

Observe  Site Browser Content
erve Pages, Folders & Fles  Marage v
& oscdev0 Content Search Change Skte [~
+ Add New Content ~
AL = showing 1-40 of 311 Export
Officiad
Privacy Time Date and StactDate |
Title URL Title Seiting Zone Reom Recording Time and Time i
- - A “
Search ~« £a Cear Search marralonch 12:00AM
. a, 4
Advanced a8
- = 2
0 am

NOTE: You can refine your search by doing the following:

e Selecting any of the column headings to sort ascending and
descending

AND / OR

e Enter additional data in the “Search” field on the left and click the
Search button

5. After selecting the Session that you would like to modify, the editor will be displayed.
Lock the page for editing by clicking on Lock for Editing under the Actions menu.
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Observe  Site Browser Conten
Oteerve Pagen, Folders & fles  Masage you
Giotel Page Qectevd Cortent Search Add/Ear Session - GAC

Content  Remote Participation  Relationships  Mistory
¢ Session - GAC
Title:
Wi Engish (US) -
¢ new Session with £

GAC Working Group Meeting :Test Create new S¢

Workfiow
URL Title:
Stap: Initial State . )
QB WOrKINg -9rouR-MOeting o5t -Create- NEw-Sassion-with-bq-script10-01-17-18-47-833
Assignee: Nobody
Type:

GAC Meeting
® GAC Working Group Meeting

Actions

R Lock for Editing GALC Break

& Carcal

Status:
® Open
Closed

Privacy Setting:

& Private

6. Once the Session content has been locked, select the Relationships tab.

Observe  Site Browser Content
Conerve 227 Marage yor Ste

e, Foiders & Mies

Global Page secdevd ert Seerch Add/EaR Sesslon - GAC

Ceen
Comtent Relationships  History  References

& Session - GAC
Remote Participation URL:

| English (US) -

Waorkflow
Remote Participation Phone

Step: Intial State
Assignee: Nobody

Locked: GAC Secretariat
Remote Participation Access Code:

International Phome Numbers link:

hetp://adigo. comyicann

7. Add the following Remote Participation details:
a. Remote Participation URL
b. Remote Participation Phone

c. Remote Participation Access Code
d. International Phone Numbers link (pre-populated with http://adigo.com/icann)

___________________________________________________________________________________________|
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Observe  Site Browser Content
Cenerve Pages, Fokders & Mlen  Marage your Ste

Global Page pactevd Cortent Search Add/Ean Session - GAC

Content Remote Participation Relationships History References

£ Session - GAC

Remote Participation URL:

W English (US) =

Waorkflow

Remote Participation Phone:
Step: Inval State

Assignee: Nobody
Locked: GAC Secretariat

Remote Participation Access Code:

Actions
— . Imternational Phone Numbers link:
d Release Lock
o Save hetp://adigo, comyicann

& Save/ Publish
AsSgn Workfow

& Cancel

8. Select Cancel to negate adding Remote Participation.
Actions

o' Release Lock
kd Save
& Save / Publish

Assign Workflow

& Cancel I

OR

Select Save which will save the Remote Participation and not publish it.
Actions

o' Release Lock

kd Save

& Save / Publish
Assign Workflow

& Cancel

OR

Select Save / Publish which will save and publish the Remote Participation.
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Actions

Release Lock

ke Save

@ Save/ Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Remote Participation will be published in the
Session.

Relating Content to a Session

After a Session has been created, the Secretariat can relate an Agenda and Advice so
information can display in an Agenda and Advice can be linked to the Session in which it was
originated. In addition to and Agenda and Advice, the Secretariat can relate files / attachments
to Sessions so they appear when the Session displays.

RELATING NEW CONTENT TO A SESSION

To relate a new Agenda, Advice and File / Attachment to a Session, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site
& gacdevO Site Browser

3. Select Session - GAC from the Type dropdown list.
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Content

\\\\\ .

& oscdev0 Content Search

Search

Search ~ #4 Ciear Search

Figure 33: Navigating to the Content page within the Admin site will show all the Session pages that have already been created.

Titie

URL Title

Privasy Time
Setting Zone Room

Recording

Change Skte [~

+ Add New Content ~

Officiad
Cate and
Time

8:15AM

209

4. Click the Session Name in the right pane to open the live editor interface for the page.

Observe  Site Browser Content
erve Pages, Folders & Ples  Marape v
& oscdev0 Content Search
CAC = wing 1-4(
- -
Search ~« £a Cear Search
. -
Advanced

. -

NOTE: You can refine your search by doing the following:

e Selecting any of the column headings to sort ascending and

descending

AND / OR

e Enter additional data in the “Search” field on the left and click the

Search button

URL Title

Privacy Time
Seiting Zone Reom

Recording

Export

Stact Date
and Yime

Change Ske [~

= Add New Comtent

Officiad

Export &

!
i

Date and StactDate |

Time

5. After selecting the Session that you would like to modify, the editor will be displayed.

Lock the page for editing by clicking on Lock for Editing under the Actions menu.
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Observe  Site Browser Content

Oteerve Pagen, Foiders & files  Mamage your Ste

Giotel Page Qectevs Content Search ASd/Eax Session - GAC

Content Remote Participation Relationships History

¢ Session - GAC
Title:
Wi Engish (US) -
GAC Working Group Meeting - Test Create new Session with £

Workfiow
URL Title:
c [nitial Stat
R OB~ WOMKING -9rOUP-MOEKING LRSL-Create-NEw-5esSi0n-with-bq-scripti0-01-17-18-47-833
Assignee: Nobody
Type:
Actions GAC Meeting
& GAC Working Group Meeting
B Lock for Editing GAC Break

& Cancel
Status:

& Open
Closed

Privacy Setting:
& Private
Pubiic

6. Once the Session content has been locked, select the Relationships tab.

Observe Site Browser Content

Conerve Pages, Fokders & Mien  Marage your Ste

Cicba Pege pecoev0 Corent Search Add/Ean Session - GAC

Comtent Remote Participation History References

£ Sesslon - GAC
Tithe:
| Engis (US) -
GAC Working Group Meeting :Test Create new Session with £
Workflow
URL Title:
Step! Intay State
goc-working-group-meeting-test-create-new-session-with-bg-script10-01-17-18-47-833
Assignee! Nobody
Locked: GAC Secretariat Type:
GAC Meating

Actions ® GAC Working Growp Meeting

GAC Break
£ Releave Lock
o Save Status:
& Open
@ Save/ Pubish pe
Cosed
Aswgn Workflow
& Concel Privacy Setting!
@ Private
Pubic

7. From the Relationships tab, the following content can be related to a Session:
a. Agenda
b. File Asset — Translatable
c. File Asset
d. Advice
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Observe  Site Browser Content
Ctner Pages, 1

jos, Folders & Ples  Manage your Ste

Gobal Page pacdev0 Conteret Search Add/tdit Session - GAC

Content Remote Participation RelavonsMNps History

Agenda - GAC: Paront (AgendaGac-MoetingGas ;y] | Relate ~

Tithe URL Title Privacy 9 L Date and Time Start Date and Time End Date and Time

| s File Asset - Translatable: Child (MeetingGac-FileAssetTransiatable) | | Relate =

Title URL Title Official Date and Time Privacy Setting File Name Create Notification

[_s Pile Asset: Chic (MeetingGac-Fleasser) | \ Relate ~

Title Official Date and Time Privacy Setting File Name Create Notification

[1 Advice - GAC: Chia (MestingGac-AdviceGac)| | Relote ~

Title URL Title Privacy Setting = 9 Official Date and Time Reference Number

8. From the Relationships tab, select the Relate dropdown list for the piece of content you
would like to relate to the Session.

Observe  Site Browser Content
Cenerve Pages, Tolders & Fles  Manage your Ste
Gicbal Page pacdevO Conteret Search Add/tdit Session - GAC
Content Remote Participation RelatonsMps Hstory
Agenda - GAC: Pacent (AgendaGac-MeetingGac)
Title URL Title Privacy 9 L Official Date and Time Start Date and Time End Date and Time
File Asset - Translatable: Child (MeetingGac-FlleAssetTransiatable)
Title URL Title Official Date and Time Privacy Setting File Name Create Notification
Pile Asset: Chid (MeatingGac-FleAsset)
Title Official Date and Time Privacy Setting File Name Create Notification
Advice -~ GAC: Child (MeetingGac-AdviceGac)
Title URL Title Privacy Setting = 9 Official Date and Time Reference Number

NOTE: The process for relating different pieces of content to a Session is the same
however, each content type will have different required fields.

9. Select Relate New Content from the Relate dropdown list for the piece of content you
would like to relate to the Session.
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Observe  Site Browser Conten
Oteerve Pegen, Foiders & Miles  Marage your Ste

Glosel Page qeceds Cortent Search Add/EaR Sesslon - GAC

Content Remote Participation Relationships History

Agenda « GAC: Parert (AgendaGac-MeetingGac)

Title URL Title Privacy Setting Location Official Date and Time Start Date and Time End Date and Time

File Asset - Transiatable: Chid (MeetingGac-FleAssetTranslatable)

Title URL Tithe Official Date and Time Privacy Setting File Name Create Notification

File Asset: Child (MeetingGac-FlleAsset)

Title Official Date and Time Privacy Setting File Name Create Notification

Advice - GAC: Onild (MeetingGac-AdviceGac)

Title URL Title Privacy 9 C Sett Official Date and Time Reference Number

10. Complete the following required fields for the content you would like to relate to a

Session:
a. Required fields for the Agenda
i. Title
ii. URL Title (automatically created based upon the Title)
iii. Privacy Setting (defaults to Private)
iv. Location
v. Official Date and Time
vi. Start Date and Time
vii. End Date and Time

\ Relate |

. Relate

|, Relote
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Observe  Site Browser Content
Conerve Pages, fokders & Fles  Manage your Ste
& secoedd Cortert Search Add/Edit Agenda - GAC Change Skte |~
Comtant Relationships
& Agenda - GAC
Tithe:
M Enghish (US) -
Workflow
URL Tithe:
Step: Intal State
Assignee: Nobod
L Privacy Setting:
& Private
Actions Publk
Save
- Location|

@ Save/ Publsh

Assgn Weekflow

& Cancel

‘Official Date and Time:

Start Date and Time:

End Date and Time:

b. Required fields for the File Asset — Translatable
i. Title

i. URL Title (automatically created based upon the Title)
iii. Official Date and Time

iv. Document Type (the user has the option to select multiple types, if needed)
v. File Asset
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Observe  Site Browser

& Gacoee

ent Relationshy

Flle Asset - Translatable

Workflow

Step! Inval State

Assignee: NoDOZy

Actions

Contemt

AGa/Ean File Asset - Transiatadle Change Site |~

ps

Tithe:

Official Date and Time!

jDecument Type:

Privacy Setting

Publ

c. Required fields for the File Asset

i
i
i
iv.
V.

Title

URL Title (automatically created based upon the Title)

Official Date and Time

Document Type (the user has the option to select multiple types, if needed)
File Asset

d. Required fields for a piece of Advice

i
ii.
iii.
iv.
V.
vi.
vii.
viii.

Title

URL Title (automatically created based upon the Title)
Privacy Setting (defaults to Private)

Consensus Setting (defaults to Consensus)

Official Date and Time

Advice Statement

Rationale

Reference Number
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Observe Site Browser Content
Observe Pages, Folders & Flles  Manage your Site

& gocdev0 Content Search Add/Edit Advice - GAC

Content

£ Advice - GAC

[ Title:
WiEnglish (US) |~
Workflow
URL Title:
Step: Initial State
Assignee: Nobody
Topic:
lick Her |
Actions
S Privacy Setting:
@ Save/ Publish @ Private
Assign Workflow () Public
4 Cancel
Consensus Setting:

@ Consensus
(0 Non-Consensus

Official Date and Time:

-

Observe  Site Browser Content
Otserve Pages, Folders A Mies Manage your Site

& 92cdev0 Content Search Add/Edit Advice - GAC

Content
&4 Advice - GAC Advice Statement:
MiEnglish (US) - Fle~ Edt~ Inset~ View~ Fomat~ Tools~

Fomats~ B 7 Y § E E I E
Workflow

Step: Initial State
Assignee: Nobody

Actions

e Save
& Save/ Publish

Assign Workflow

@ Carcel

E.iE.-E B W B &L B2 ¥~
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Observe Site Browser Content
Observe Pages, Folders & Fles Manage your Site

& 9o Content Search Add/tdit Advice - GAC

Content

Rationale:

£ Advice - GAC
Filev Editv Inset~ View~ Format~ Tools ~

Wi English (US) N
Fomats> B 7 ¥ § E XE I B - IE-3 B W B L 2 ¢~
Workflow

Step: Initial State
Assignee: Nobody

Actions

e Save
& Save/ Publish
Assign Workflow

& Cancel

11.Select Cancel to negate relating new content to the Session
Actions

kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will create the new content that was related to the Session and not
publish

Actions

kd Save

& Save / Publish
Assign Workflow

¢ Cancel

OR
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Select Save / Publish which will create the new content, relate it to the Session and
save / publish

Actions

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Session will be published in the Meetings &
Records section of site and any newly created content that was related to the Session will be
published in their respective sections of the site.

RELATING EXISTING CONTENT TO A SESSION

To relate existing Agenda, Advice and File / Attachment to a Session, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site

& gacdevO Site Browser

3. Select Session - GAC from the Type dropdown list.

@ oscden0 Content Search Change Site [~

+ A w C
) xpor
Officind
Privasy Time Date and StactDate |
Title VR Title Setting Zone Room Recording Time i Yime

» a4 Clear Search I 3: 15AM B00AM
Advanced

Figure 34: Navigating to the Content page within the Admin site will show all the Session pages that have already been created.

4. Click the Session Name in the right pane to open the live editor interface for the page.
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Observe  Site Browser Content
erve Pages, Folders & Ples  Marape v
& oscdev0 Content Search
CAC = wing 1-4(
Itie
- - ICANN 55 M
Search ~« £a Cear Search
. - 5
Advanced
. -

NOTE: You can refine your search by doing the following:

e Selecting any of the column headings to sort ascending and

descending

AND / OR

e Enter additional data in the “Search” field on the left and click the

Search button

URL Title

Privacy Time
Setting Zone Reom Recording

Change Ske [~

= Add New Comtent

Officiad

Export &

Date and StactDate |

Time

5. After selecting the Session that you would like to modify, the editor will be displayed.

Lock the page for editing by clicking on Lock for Editing under the Actions menu.

Observe  Site Browser Content
egen, Foiders & fies  Masage your &
Cortert Search Add/Ear Session - GAC
Remcte Participation  Relationships  History

+ Session - GAC

Tite:
Wi Enghsh (US -
GAC V C ) Mo g <Y b w
Workfiow
URL Title:
Stap: Initial State
guc-m ng-t at "

Assignee: Nobody

Actions

Privacy Setting:

& Private
Public

6. Once the Session content has been locked, select the Relationships tab.

and Time
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Observe  Site Browser Content
Cene-ve Pages, Folders & Mien  Marage your Ste
Gicbw Pege pactevd Corent Search Add/Ean Session - GAC

Comtent Remote Participation History References

£ Sesslon - GAC

Tithe:
Wi Engiien (US) -
GAC Working Group Meeting :Test Create new Session with £
Workflow
URL Title:
Step! Intial State
goc-working-group-meeting -test-create-new-session-with-bq-script10-01-17-18-47-833
Assignee: Nobody
Locked: GAC Secretariat Type:
GAC Meating
Actions ® GAC Working Group Meeting
GAC Break
£ Release Lock
o Seve Status:
& Open
Save / Publish
@ Cosed
Aswgn Workfiow
& Concel Privacy Setting!
® Private
Pubic

7. From the Relationships tab, the following content can be related to a Session:
a. Agenda
b. File Asset — Translatable
c. File Asset
d. Advice

Observe Site Browser  Contemt

Cenerve Pages, Tokders & Fles  Manage your Ste

Gicbal Page pacdev0 Contert Search Add/Edit Session - GAC

Conmtent Remote Participation Relatonships.  History

Agenda - GAC: Pacont (AgendaGac Mm-!mql’..:)l

Title URL Title Privacy 9 L Date and Time Start Date and Time End Date and Time

[ Flle Asset - Translatable: Child (Mu-'.m;ysa-:»‘AltAisct?ranslatab\t}]

Title URL Title Official Date and Time Privacy Setting File Name Create Notification
[L1 Pile Asset: Chid (MeetingGac-Fleasser) |
Title Official Date and Time Privacy Setting File Name Create Notification
[ Advice - GAC: Chig :MN(-'-;Cac-k:nccGa:jll
Title URL Title Privacy -] = 9 Official Date and Time Reference Number

8. From the Relationships tab, select the Relate dropdown list for the piece of content you
would like to relate to the Session.
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Observe  Site Browser Content
Ctner

Pages, foidens A Fies Marage your Ste
Giobal Pege pacdev Contertt Search Add/Edit Session - GAC
Content Remote Participation Relabonsips History

Agenda - GAC: Parent (AgendaGac-MeatingGac)
Title URL Title Privacy Setting Location Official Date and Time Start Date and Time End Date and Time

File Asset - Translatable: Child (MeetingGac-FileAssetTransiatable)
Title URL Title Official Date and Time Privacy Setting File Name Create Notification

Pile Asset: Chid (MeetingGac-FleAsset)
Title Official Date and Time Privacy Setting File Name Create Notification

Advice - GAC: Child (MeetingGac-AdviceGac)
Title URL Title Privacy Setting = 9 Official Date and Time Reference Number

NOTE: The process for relating different pieces of content to a Session is the same
however, each content type will have different required fields.

9. Select Relate from the Relate dropdown list for the piece of content you would like to
relate to the Session.

Observe  Site Browser Conten
Oteerve Pagen, Folders & Miles  Marage your Ste
Giotel Page Gectevd Coervent Search Add/EaR Session - GAC

Content Remote Participation Relationships History

Agenda - GAC: Parent (AgendaGac-MeetingGac) \ Relate| ~

Title URL Title Privacy Setting Location Official Date and Time Start Date and Time End Date and Time
o Relste New Conmert

File Asset - Transiatable: Chid (MeetingGac-FleAssetTranslatable) | Relate <«
Title URL Title Official Date and Time Privacy Setting File Name Create Notification

Flile Asset: Child (MeetingGac-FlleAsset) \ Relate «
Title Official Date and Time Privacy Setting File Name Create Notification

Advice - GAC: Onild (MeetingGac-AdviceGac) \ Relote ~
Title URL Title Privacy 9 C Setting Official Date and Time Reference Number

10.0nce Relate is selected, a Search pop-up will display. Select the Search button to
return all results or enter criteria in any of the Search fields to refine the Search results
returned.
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Search:

Language

Title:

Host Folder:

Privacy
Setting:

Location:

Introduction:

") Private
Public

+

+ ATRT 1

4+ ATRT 2

+ ATRT 3

+ ATRT 4

+ AoC Review

+ CCT Review

+ Spedific Reviews
+ WHOIS Review

@ Clear Search

Accountability & Transparency |

Figure 35: You can refine your search by entering additional criteria in the Search pop-up and then selecting the Search button.

11.0nce the Search button is selected, the results will display in the right side of the Search

POp-up.
Search:
[Matching Results (54)
Host Folder: -
Privacy
Language Title URL Title Setting Location
Privacy Private
Setting: () Public - - .
i 9 C Wl English (US) Test Agenda 17th Jan test-agendo-17th- | Livate | 20780
jan Tech
Location:
Vijay Agenda from BQ vijay-agenda- Hyderabad
Sl English (US) script10-01- from-bg-script10-  public tndla ‘
Introduction: 17::21:02:264 01-17-21-02-264
l Vijay Agenda from BQ vijay-agenda-
. - ) ) Hyderabad,
GAC:  + Accountability & Transparency English (US) script10-01- from-bg-script10- public India
+ ATRT 1 17::19:28:467 01-17-19-28-467
+ ATRT 2
+ ATRT 3 vijay-icann-102- New York,
h Al
+ ATRT Wl english (US) Vijay ICANN 102 Agenda agenda public NY, USA
+ AoC Review
+ CCT Review ) vijay-
| . ) Vijay_ICANNS7H H 2
+ Specific Reviews Wl English (US) Yay_ICANNS7Hyderabad |\ anns7nyderabad- ~ public ydersbad
+ WHOIS Review Agenda sgende India
regression-test-
L Sea . R n Test 26th Zen
B rch # Clear Search Wl English (US) egression Test 26th Dec 26th-dec-test- public ensar
- test agenda Tech
agenda
| -
| 166
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12.Select the checkbox next to the Agenda, File Asset or Advice that you would like to

relate to a Session.

Search:
Host Folder: -
Privacy Private
: Setting: Public
Location:
Introduction:
GAC: |+ Accountability & Transparency
+ ATRT 1
+ ATRT 2
+ ATRT 3
+ ATRT 4
+ AoC Review
+ CCT Review

| + Specific Reviews
+ WHOIS Review

4, Search 4 Clear Search

Matching Results (54)

Language
D W English (US)

Sl English (US)

Sl English (US)
Wl English (US)

Sl English (US)

Sl English (US)

Title

Test Agenda 17th Jan

Vijay Agenda from BQ
script10-01-
17::21:02:264

Vijay Agenda from BQ

script10-01-
17::19:28:467

Vijay ICANN 102 Agenda

Vijay_ICANNS7Hyderabad
Agenda

Regression Test 26th Dec
- test agenda

URL Title

test-agenda-17th-
Jan

vijay-agenda-
from-bg-script10-
01-17-21-02-264

vijay-agenda-
from-bq-script10-
01-17-19-28-467

vijay-icann-102-
agenda

vijay-
icannS7hyderabad-
agenda

regression-test-
26th-dec-test-
agenda

Privacy
Setting

private

public

public

public

public

public

Location

Zensar
Tech

Hyderabad,
India

Hyderabad,
India

New York,
NY, USA

Hyderabad,
India

Zensar
Tech

13.0nce the checkbox next to the Agenda, File Asset or Advice that you would like to relate
to a Session is selected, select the Relate button at the bottom of the page.

Search:
Language l -
Title:
Host Folder: -
Privacy Private
Setting: Public
Location:
Introduction:
GAC: | + Accountability & Transparency
+ATRT 1
+ ATRT 2
+ ATRT 3
+ ATRT 4
+ AoC Review
+ CCT Review
+ Specific Reviews
o MIUATE D dmine
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W English (US)

Wl english (US)

W english (US)

W English (US)

W english (US)

Wl english (US)

S English (US)

Vijay ICANN 102 Agenda

Vijay_ICANNS7Hyderabad
Agenda

Regression Test 26th Dec
- test agenda

22nd dec test agenda

Test agenda - 21st dec

Meeting 55 - Agenda

ICANN100O Agenda

vijay-icann-102-
agenda

vijay-
icann57hyderabad-
agenda

regression-test-
26th-dec-test-
agenda

22ng-dec-test-
agenda

test-agenda-21st-
dec

meeting-55-
agenda

icann100-agenda

public

public

public

public

public

public

New York,
NY, USA

Hyderabad,
India

Zensar
Tech

Zensar

Zensar
Tech

Marrakech,
Morocco

Pune, India

Next ©
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14.Select Cancel to negate adding the content.

Actions

{' Release Lock
kd Save
& Save / Publish

Assign Workflow

4 Cancel

OR

Select Save which will save the content and not publish it.

Actions

{' Release Lock

kd Save

& Save / Publish
Assign Workflow

4 Cancel

OR

Select Save / Publish which will save and publish the edits.

Actions

{' Release Lock

kd Save

& Save / Publish

Assign Workflow

4 Cancel

NOTE: Once Save / Publish is selected, the Session will be published in the Meetings &
Records section of site.

Updating a Session
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To update a Session, follow the steps below:

1. Log into dotCMS Admin.

2. Click the Content tab from the top navigation.

Observe Site Browser
Observe Pages, Folders & Files
& gacdevO Site Browser

Content
Manage your Site

3. Select Session - GAC from the Type dropdown list.

Observe  Site Browser

& oscdevO

Figure 36: Navigating to the Content page within the Admin site will show all the Session pages that have already been created.

Content

Content Search

Titie

URL Title

cxampie

Privacy Time

Setting Zone Reom

o+ Add New Conten

Officiad
Cate and
Recording Time

1 5AM

209

4. On the right side on the Content Search page, select the Session you would like to

update by clicking on the Title.

Observe Site Browser
erve Pt T,

& oscdev

Content

Content Search

earch « fa Cear Search

NOTE: You can refine your search by doing the following:

Advanced

Itie

URL Title

Privacy Time
Setting Zone Reom

o+ Add N

Officiad

Change Ske [~

Date and StactDate |

Recording Time

e Selecting any of the column headings to sort ascending and

descending

AND / OR

e Enter additional data in the “Search” field on the left and click the

Search button

5. After selecting the Session that you would like to modify, the editor will be displayed.
Lock the page for editing by clicking on Lock for Editing under the Actions menu.
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Observe  Site Browser Content
Oteerve Pagen, Foiders & e your Ste

Macaze

ol Page gectens Cortert Search Add/Ear Session « GAC

ootent  Remdte Participation  Relationshigs  History

+ Session - GAC
Title:
W Engish (US) .
GAC Working Group Meeting :Test Create new Session with £

Workfiow
URL Title:
Step: Initial State . .
QRS WOrKING -QroUR-MOeting oSt -Create- Naw-SasSion-with-bq-script10-01-17-18-47-833
Assignee: Nobody

Type:
Actions GAC Meeting
® GA orking Growp Meeting
) Lock § GAC Break
o
Status:
& Open
Closed
Privacy Setting:

& Private

6. Modify any of the following fields:
Title
Type
Status
Privacy Setting
Topic
Time Zone
Room
Recording
Official Date and Time
Start Date and Time
End Date and Time
Leads

. Objectives
Expected Outcomes
Minutes
Action Items
Communiqué Text

LTOS3ITFTTIQ@TTOQ00TO
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Observe  Site Browser
Creerve Pages, Foiders & fies

& Giodel Page Qectevd

Content R P

Content

Masage your Ste

Cortent Search Add/Ear Session - GAC

References

. Session - GAC

Wifngish (US) -

Workflow

Step: Initial State

Assignee: Nobody
Locked: GAC Secretanat

(3 Days Aps)

Actions

of Release Lock

e Sewve

@ Seve [/ Putiun
Assign Workfow

& Cancel

Observe  Site Browser
Oteerve Pages, Foiders & fies

& Giobel Page Qecdevd

Content R P

R History

Tithe!

GAC Working Group Meeting :Test Create new Session with £

URL Title:

QAC-WOrking -9roup-meeting -test-create-new-session-with-bg-script13-01-17-19-15-885

Type:
GAC Meeting

® GAC Working Group Meeting
GAC Break

Status:
& Open
Closed

Privacy Setting:
® Private
Public

Content
Manage your Ste

Cortent Search Add/Ear Session - GAC

History  References

1 Session - GAC

Wi Enghsh (US) v

Workflow

Stap: [nitial State

Assignee: Nobody
Locked: GAC Secretanat

(3 Days Ap2)

& Save / Putisn
Assign Workfow
& Cancel

e —
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Time Zone:
UTC+00:00 - Coordinate ~

Room:
Hall A

—

Date and Time:
1/10/2017 * 12:00AM | -
Start Date and Time:
11/3/2016 v B00M |~

|in¢ Date and Time:

11/7/2016 * 12:00AM | =

Load(s):

Fle+ Edt~ Ioetv Views Fomat~ Tools~
Ffemats- B /7 ¥ 6 E X 3 B =

cE-3 @

~ E &£

2 J-
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Observe  Site Browser Content
Cenerve Pages, fokders & Fles  Manage your Ste

& Gobal Page pacdev Contertt Search Add/Ldit Session - GAC

Comant Remote Participation  Relaticnships

History  References

E}oﬂfvw
£ Session - GAC
Fio ~

W Enghish (US) h
Formats ~

ESts Inset~ Vw~

Format ~

Toos ~

B /7 Vv & E X 3 B =

Workflow
Step: Intial SZate
Assignee: Nobody
Locked: GAC Secretariat

3 Doys Ago,

Actions

o Release Lock

e Sove

@ Save/ Publsh
Assign Workflow

& Canced

+iE- A A W E &L

Content

Marage s Ste

Carnent Search Add/EaR Session - GAC

Observe  Site Browser
Ctamve Pages, Foasers & Fes

& Global Page JACoeD

Mistory  References

R P 0

Content

[Expected OGutcomes:

£1 Session - GAC
Fle> Edt~ Inset~ View~ Format~

W Englsh (US) -
Formats ~

Workfiow
Step: Invtial State

Assignee: Nobody
Locked: GAC Secretanat

J Days Ape)

of Release Lock
 Seve

@ Save/ Putiisn
O Assign Workflow

& Cancel

B /7 Y §$ E X3 B

Tools

E-E-A A & & &

2

v~

e —
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Observe  Site Browser Content
Ctamve Pages, Folders & Fles  Masage your Ste

 Globel Page Gacoed Carnent Search AGS/Ean Sesson - GAC

Content Remote Participation Relationships Mistory References

Minutes:
£ Session - GAC
Tools ~

Flo~ Edt~ Inset~ \Vew~ Format ~

B / ¥ § EX3A R -

W Engish (US) -
Formats ~
Workflow Mirntes forth
Step: Initial State
Assignee: Nobody
Locked: GAC Secretanat

I Days Age

Actions

of Refease Lock

i Sove

& Save/ Publish
Assign Workflow

& Cancel

=~ =

A R E &

2

ofw

Observe  Site Browser Content
e e Pages, Folders & Fles  Masage your S

w Glodal Page Ao Cannent Search Add/Ean Session - GAC

Content Remote Participation Relationships History References

Action Items:

%) Session - GAC

Fle~ Edt~ Imet~ View=~ Format~ Tools ~

. Enghsh (US) -
Formats ~
Workflow
Step: [nitial State
Assignee: Nobedy
Locked: GAC Secretanat

J Days Age

Actions

of Release Lock

o Save

@ Save [/ Pubisy
Assign Workfow

& Cancel

B J/J N 6 EEXEAN =-E-3 3 B E &
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Observe  Site Browser Content
Ctaarve Pages, Folders & Files  Masage your e
Glonal Page Gacces Cantent Search ASa/Eax Session - GAC

Content  Remote Participation  Relationships  Mistory  References

Communique Text:
%) Session - GAC
File* Edt~ Ioerts View~> Fomat~ Tools~

Fomats B 7 ¥ & E X A B =-E-3 WA @ B L R V-~

W Engish (US) -

Workflow
Step: [nitlal State
Assignee: Nobody
Locked: GAC Secretanat

Acticra

{ Release Lock

ul Sove

@ Save [ Publish
Assign Workfow

& Cancel

7. Once modifications have been made, you can either select Cancel to negate the edits.
Actions

i’ Release Lock
kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will save the edits and not publish them.
Actions

i’ Release Lock

kd Save

& Save / Publish
Assign Workflow

& Cancel
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OR

Select Save / Publish which will save and publish the edits.

Actions

Release Lock

ke Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Session will be published in the Meetings &
Records section of site.

ICANN Meeting Agendas

The Meeting Agendas content is a representation of an event and provides a holistic view of all
Sessions scheduled to take place during an event. A relationship can be established between
Sessions and an Agenda so when the Agenda is viewed, all Sessions that have been related to
that Agenda will display.

The following screenshot illustrates the contents of the ICANN Meeting Agendas:

ICANN |TYPE THE DOCUMENT TITLE | MONTH YEAR |175



N/

Calendar ICANN Meeting Agendas ICANN Meeting Minutes

EDITION:

.|| ———
Ilunnnwmmm ]

ICANN57 GAC Agenda|

PDF l

ntroduction
Friday, 04 November 2016 \( ; l':\ l)\

ISaturday, 05 November 2016

[I Ivderabad, India 03 November 2016 - 09 November 2¢ n(sl

Introduction

Fridav, 04 November 2016

Monday, 07 November 2016

[Tuesday, 08 November 2016

Wednesday, 09 November 2016

09230 - 10000 UTC TCANNS7 - GAC Agenda Item 2 - TANA Stewardship

RELATED DOCUMENTS
Leads
\ Thomas Schnekder, GAC Chalr
Objectives
Upchine abos the LANA Seowandhip trasition
Expected Outcomes
—_

Documents

3 ICANN;7 Agenda ftem 2 TANA Stew P KRB
> 10000 - 10:30 UTC T TCANNS7 - GAC Agenda Item 3 - Accountability
Workstrcam 2

Note the following elements of the Agenda:

Agenda Title: This element is the title specified in the Title field when creating the
Agenda content

View as a PDF: This element is the link that will allow the user to view and download the
Agenda as a PDF and then print

Anchor Links: This element is the link that will automatically navigate the user to the
section that corresponds with the selected link

Related Documents: This element is a section that displays documents that have been
related to the Agenda content.

Agenda: This element is the view of the published Agenda

Session Content Related to an Agenda: This element is the Session content that has
been related to the Agenda

Edition Dropdown List: This element is the dropdown list allows you to select other
published Agendas

Agenda Location, Start Date & End Date: This element is the Location, Start Date & End
Date specified in the Agenda content

Agenda Introduction: This element is the Introduction specified in the Agenda content
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Creating ICANN Meeting Agendas

To create new Meeting Agenda content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site

& gacdevO Site Browser

3. Select Agenda — GAC from the Type dropdown list.

Observe  Site Browser Content
erve Poges, Folders B Fles  Manage your §
@ 9cone Contant Search Change Site v
+ Add New Comtent ~
showing 1-40 of 54 txport X))
Officiad
Search Privasy Date and Stact Date  End Date
Title URL Yite Sefting  Le<ation Time andYime andTime  Last Editer Aast &
- - Agerx P
\ Search ~ fa Cecar Search -
. - 106 11/7/2018 GAC
Advanced " 8:00AM .

64

Figure 37: Navigating to the Content page within the Admin site will show all the Agenda pages that have already been created.

4. Select the Add New Content button on the top right.

Asenda - GAC = showing 1-40 of 54 txport X)

5. Complete the following required fields:

a. Title

b. URL Title (automatically created based upon the Title)

c. Privacy Setting (defaults to Private)

d. Location

e. Official Date and Time

f. Start Date and Time

g. End Date and Time
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Observe  Site Browser Content
Ctasve Pages, Folders & Fles  Masage your Ste

& or0dev0 Content Search Acd/EQit Agensa - GAC

Content  Relationships

£, Agenda - GAC

Title:
i Enghsh (US) -
o [om ]
Step: [nitial State
Assignee: Nobody
® Private
Acticrs Pubic
i Sove
Location:

& Sove [ Publish

Assign Workfow

& Cancel

Official Date and Time:

Start Date and Time:

End Date and Time:

6. Select Cancel to negate adding the content.
Actions

kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will save the content and not publish it.

Actions

kd Save

& Save / Publish
Assign Workflow

& Cancel

Change Site |~
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OR

Select Save / Publish which will save and publish the content.
Actions

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Agenda will be published in the Meetings &
Records section of site.

Relating Content to an Agenda

After an Agenda has been created, the Secretariat can relate Minutes and Sessions so the
Agenda provides a holistic view of all Sessions scheduled and the Minutes associated to each

Session.

RELATING NEW CONTENT TO AN AGENDA

To relate a new Minutes and Sessions to an Agenda, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site

& gacdevO Site Browser

3. Select Agenda - GAC from the Type dropdown list.

e ——— —
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Observe  Site Browser Content
tverve spen, Foiders & Mies  Macage

& vedev0 Centent Search Change Site -

+ Add New Contert ~

~ 40 of 48 Export 1)
Official
Privacy Date and Start Cate  End Date
Tithe URL Titke Sefting  Lecation Time and Time and Time Last ednor LAt £
Search ~ g Oear Search ‘ - : ) 15PM jv 5P
Advanced N - M s .;v ’ “
Figure 38: Navigating to the Content page within the Admin site will show all the Agenda pages that have already been created.
4. Click the Agenda Name in the right pane to open the live editor interface for the page.
Observe sm!mfnur Content
& 9xse0 Content Search Change Sie |~
+ Add New C b
e: [Aoend ~ m = owing 1-4( 485 txport X))
Official
Privasy Date and SatOate  End Date
Title URL Titke Setting  Le<ation Time and Yime ard Time Last Editer Last Edit
Search ~ £ Clear Search ol b e y ) v « 4 ~
Advanced ° ol il By cconul g

NOTE: You can refine your search by doing the following:

e Selecting any of the column headings to sort ascending and
descending

AND / OR

e Enter additional data in the Search field on the left and click the Search
button

5. After selecting the Agenda that you would like to modify, the editor will be displayed.
Lock the page for editing by clicking on Lock for Editing under the Actions menu.
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Observe  Site Browser Content
Ctaerve Pages, Folders & Fles  Masage your S0e
Glonal Page P Carnent Search A0a/Ean Agenda - GAC

Content Relationships History

. Agenda - GAC
Title:
W Eagish (US) -
Vigay_ICANNS7Hyderabad Agenda

Workflow
URL Title:

Stepe [nitial State .
vijay-icann57hyderabad-agenda

Assigmee: Nobedy

Privacy Setting:
Actices Private
® Pubic
l § Lock for Editing ]
& Cancel Location:

Hyderabad, Inda

6. Once the Agenda content has been locked, select the Relationships tab.

Observe  Site Browser Content
Trierve Pages, Folders & Fles Mg your S8
Globa! Page pacdev0 Conternt Search Add/Edit Agenda - GAC
&1 Agenda - GAC
Tithe:
W English (US) -
Vijay_ICANNS THyderabad Agenda
Workflow

URL Tithe:

Step! Inval State
vijay-icann$ Thyderabad-agenda

Assignee! NoDOTy

Locked: GAC Secretariat Privacy Setting:
Private
® Public
Actions

Location:

§ Release Lock
b Save Hyderabad, India
& Save/ Pubish

Official Date and Time:
Assgn Werkflow

& Cancel 1/5/2017 v [12:00AM | =

7. From the Relationships tab, the following content can be related to an Agenda:
a. Minutes
b. Sessions
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Observe  Site Browser Content
Ot ages, Folders & Files  Manage yiu
- Qaccevd C et Search Ade /ot Agends - GAC

Content Refationships History

[ Minutes - GAC: Chig :Arv‘-:aﬁa:-ﬂwnutcv‘c\!-’.il \ Relate ~
Title URL Title Privacy Setting Create Notification Official Date and Time

| s Session - GAC: Chiks (AgendaGac-MestingGac) | . Relate ~

Privacy Time g'n":‘.l 3'.'(.' :::- S
Title URL Title Type 'I'“ Zome Room Recording -/ and  ang Participation Participation Participation Phome Numbers
i URL Phone Access Code  link
Time Time Time
N DaylMeetngd-GAC  de pacwy  put T4+05:3 a7 g/ adige. comycann )

=@

8. From the Relationships tab, select the Relate dropdown list for the piece of content you
would like to relate to the Agenda.

Observe  Site Browser Content
Ererve Pages, Folders & Fles  Marage your St

Gicba Page gacored Comert Search Add/Ban Agenda - GAC

Comtenmt Relstiorshos Mistory

Minutes - GAC: Child (AgendaGac-MinutesGac)

Title URL Title Privacy Setting Create Notification Official Date and Time

Session - GAC: Child (AgendaGac-MeetingGac)

x Meeting4: GA > gacwy P $: L . P o _ @ [j]
@@
NOTE: The process for relating different pieces of content to an Agenda is the same
however, each content type will have different required fields.
9. Select Relate New Content from the Relate dropdown list for the piece of content you
would like to relate to the Agenda.
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Observe  Site Browser Content
Oteerve Pogen, Folders & Mies  Macage your Ste
Giodel Page gectend Cortent Seerch Add/Ean Agenda - GAC

Content ReQuonsMps History

Minutes - GAC: Child (AgendaGac-MinutesGac)

Title URL Title Privacy Setting Create Notification Official Date and Time

Session - GAC: Child (AgendaGac-MeetingGac)

Official Start

End -
Title URLTitle Type """c' ;‘"“ Room Recording °':‘ D‘:' m Participation Part Phone Numbers
Setting  Zome — — URL Phone Access Code  link
R Doyl Mewsngd GAC  dayl- gacwy  publc UTC+05:20 /17 % 261 1P

10. Complete the following required fields for the content you would like to relate to an
Agenda:
a. Required fields for Minutes:
i. Title
i. URL Title (automatically created based upon the Title)
iii. Privacy Setting (defaults to Private)
iv. Official Date and Time

Observe  Site Browser Content

Ctaerve Pages, Folders & Fles  Masage your Ste

& 9xcsev0 Content Search ASd/E4it Minutes - GAC
Content

£ Minutes - GAC

W Enghsh (US) -

Workflow

Imtroduction:

Steps Invtial State
Assignee: Nobody

Actions Fle* Edt~ Imet~ View~* Fomatv Tools~

Ffomus~ B 7 VY S5 E X 3 M - -3 W W & &L 2 -~

e Save
@ Sove [ Publish
Assign Workflow

& Concel

e ——
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Observe  Site Browser Content
Conerve Pages, Tokders & Fles  Manage your St
@ secoeed Cormert Search Add/Edit Minstes - GAC Change Shte [+
Content

£ Minutes - GAC

Waorkflow

Step: Inval State

Assignee: Nobody

Actions

Y Save
@& Save/ Publsh
Assign Workflow

& Cancel

WYSIWYG | » Language Variables

Privacy Setting:

e Private

Public

Create Notification:

e No

Yes

Official Date and Time:

- -

Relate the event Agenda for which you would like to create a Minutes document:

b. Required fields for Sessions:

Title
URL Title (automatically created based upon the Title)
Type (defaults to GAC Meeting)

iv. Status (defaults to Open)
v. Privacy Setting (defaults to Private)
vi. Time Zone (defaults to UTC+00:00 — Coordinated Universal Time (UTC))
vii. Official Date and Time
W ‘N_. m to_m_-nt _
& o Connent Search A0G/EaR Sesson - GAC Change Site |~
Comtent Remote Participation Relatonships
Tithe:
& Sesslon - GAC
—v—
Step! Inval State Fype:
Assignas: Mebody & GAC Meeting
GAC Working Group Meeting
Actions GAC Broak
l Save [status:
& Save/ Pubish ® Open
Assign Workfow Ciosed
& Canced
Privacy Setting:
& Private
Topic:
Cick Mere 1o Select Categories
Time Zone:
UTC+00:00 - Coordnate ~
I |
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Observe  Site Browser Conten
Ctasrve Pages, Folders & Fles  Manage v
& sected Cortent Search ASd/Eait Session - GAC Change She [+)
Content Remote Participation Relationships

Official Date and Time:
£ Sesslon « GAC

M Engits (US) -

Start Date and Time:
Workflow

Step: Intial State

Assignee: Nobody End Date and Time:
. .
Actions
o Save Lead(s):
@ Save/ Publish Fle* Edt~* lset View~s Fomat~ Tools~
Assign Workfiow fomus> B /7 VY S E X A B - -3 WA B & &L 2 «-~

& Cancel

11.Select Cancel to negate relating new content to the Agenda
Actions

kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will create the new content that was related to the Agenda and not
publish

Actions

kd Save

& Save / Publish
Assign Workflow
& Cancel

OR

Select Save / Publish which will create the new content, relate it to the Agenda and
save / publish
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Actions

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Agenda will be published in the Meetings &
Records section of site and any newly created content that was related to the Agenda will be
published in their respective sections of the site.

RELATING EXISTING CONTENT TO AN AGENDA

To relate existing Minutes and Sessions to an Agenda, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site

& gacdevO Site Browser

3. Select Agenda - GAC from the Type dropdown list.

Change Site [~

& Add New Content ~

Ty showing 1-40 of 48 Export 1)
Official
Privacy Date and Start Oate  End Dale
Tithe URL Titke Sefting  Lecation Iime and Time and Time Last Ednor Lant tr

Sewch - 4 Oear Search

Advanced

2 17-21-02-264

Figure 39: Navigating to the Content page within the Admin site will show all the Agenda pages that have already been created.

4. Click the Agenda Name in the right pane to open the live editor interface for the page.
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Observe  Site Browser Content
o, Fokders & Fles V
o Content Search Change Ste
+ Ac w C -
e: [Aoends - GA = wing 1-4 48 txport X))
Official
Privasy Date and St Oate  End Date
Title URL Titke Sefting  Le<atinn Time and Yime ard Time Last Editer Last Edit
e N ~ !
Search ~ £ Clear Search an Tech ) 15PM J0PM 4:45PM
- Mien US)| L WayAgendafrom 8Q | vijeyagendss = pubic  Myderabad, 10V1/2016 1L//2018 L1/7/2018 =
Advanced " B:00AM "

NOTE: You can refine your search by doing the following:

e Selecting any of the column headings to sort ascending and
descending

AND / OR

e Enter additional data in the Search field on the left and click the Search
button

5. After selecting the Agenda that you would like to modify, the editor will be displayed.
Lock the page for editing by clicking on Lock for Editing under the Actions menu.

Observe  Site Browser Content
e s Py A Marage v

A0a/Ean Agends - GAC

Content Relatonships History
*. Agenda - GAC
Title:

Vigay_ICANNS7Myderabad Agenda

URL Title:

vijay-icann57hyderabad-agenda

Privacy Setting:

Actiors Private
® Publc
[ & tooktere |
¢ Cance Location:
Hyderabad, Inda

6. Once the Agenda content has been locked, select the Relationships tab.
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Observe  Site Browser Content

Trerve Pages, Folders & Fles  Manage your Ste

Globa! Page pacoev0 Content Search Add/Edit Agenda - GAC

Content | Relationships | Mistory

£ Agenda - GAC
Tithe:
| Engiish (US) -
Vijay_ICANNS7Hyderabad Agenda
Workflow

URL Tithe:
Step! Intal State
—- vijay-icanns hyderabad-aspenda

Assignee! Nobody

Locked: GAC Secretariat Privacy Setting:
Private
® Public
Actions

£ Release Lock Location:

bl Save Hyderabad, India

& Save/ Publsh
2ssgn Werkflow Official Date and Time:

& Cancel s2017 - 12200 AM | =

7. From the Relationships tab, the following content can be related to an Agenda:

a. Minutes
b. Sessions
M Shte l«nn.r Content )
Gloal Page Gacsed Cartent Search ASE/BE% Agends - GAC

Content Refationships: History

|4 Minutes - GAC: Chils (AgendaGac-MinutesGac) | \ Relate ~
Title URL Title Privacy Setting Create Notification Official Date and Time
[ Session - GAC: Child (AgendaGac-MeetingGac 1] L Relate ~
Officlal  Start End
International
Tithe URL Title Type wcy Time Room Recording Dats Par Par Particip Phone
i ) L = L L Phone Access Code  link
Time Time Time
K Dayl:Meestngé-GAC  dayl pacwy  pubic UTC405:30 a7 yenr  2en hep/fedige.comicarn | O @0

8. From the Relationships tab, select the Relate dropdown list for the piece of content you
would like to relate to the Agenda.
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Observe  Site Browser Centent

” s, Folders & Fles  Marage you
el Page — o arch Add/Ban Agends - GAC

Cortent Relatiorshos Mistory

Minutes - GAC: Child (AgendaGac-MinutesGac)

Title URL Title Privacy Setting Create Notification

Session - GAC: Ohid (AgendaGac-MeetingGac)

Official Start End
Date Date Date
and and and
Time Time Time

Privacy Time

Title L Tiel T
URL . ype Setting Zome

Room Recording

Official Date and Time

R t International

URL

Phone

Participati Phone
Access Code  link

NOTE: The process for relating different pieces of content to an Agenda is the same

however, each content type will have different required fields.

9. Select Relate from the Relate dropdown list for the piece of content you would like to

relate to the Agenda.

Observe  Site Browser Content
Ctarve Pages, Folders & Files  Masage your Soe

Glonal Page Qaccevd Content Search A0S/ ot Agenda - GAC

Content Refationships History

Minutes - GAC: Child (AgendaGac-MinutesGac)

Title URL Title Privacy Setting Create Notification

Session - GAC: Child (AgendaGac-MeetingGac)

Official Start End

Privacy Time Date Date Date

Tithe URL Title Type Setting 2 Room Recording and and ond
Time Time Time
K DaylMeesngd GAC  dayl oWy pubic UTC+05:30 V17 YN UWI?

Official Date and Time

URL

1
Inter
Participation Participation Participation Phone Numbers
Phone

Access Code  link

10.0nce Relate is selected, a Search pop-up will display. Select the Search button to

return all results or enter criteria in any of the Search fields to refine the Search results

returned.
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Search:

Host Folder:

Introduction:

Privacy
Setting:

Create
Notification:

GAC:

Private
Public

) No
Yes

+ Accountability & Transparency
+ ATRT 1
+ ATRT 2
+ ATRT 3
+ ATRT 4
+ AoC Review
+ CCT Review
+ Specific Reviews
+ WHOIS Review

@ Clear Search

Figure 40: You can refine your search by entering additional criteria in the Search pop-up and then selecting the Search button.

11.0nce the Search button is selected, the results will display in the right side of the Search

pop-up.

Search:
Host Folder:

Introduction:

Privacy
Setting:

Create
Notification:

GAC:

-4 Search

) Private
) Public

1) No
) Yes

+ Accountability & Transparency |

+ ATRT 1

+ ATRT 2

+ ATRT 3

+ ATRT 4

+ AoC Review

4+ CCT Review

+ Specific Reviews
+ WHOIS Review

4 Clear Search

Matching Results (41)

12.Select the checkbox next to the Minutes or Session you would like to relate to an

Agenda.
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Language Title URL Title ing  Notification Date and
Time
. Test 17th Jan test-17th-jan- 1/17/2017
Sl English (US ate  true
e (us) Minutes minutes PV v 3:00PM
Regression regression-
. 12/26/2016
Sl English (US) Test 26th Dec  test-26th-dec-  public true 5';0P<4
- Test Minutes  test-minutes o
. Test minutes test-minutes- 12/22/2016
W Enghish (US blic true
ngish (US) 22nd dec 22nd-dec pubH 9:45PM
" Test 215t D test-21st-dec- 12/21/2016
W Enghish (US) est2istDec  test-alst-dec  oublic  true /21/
minutes minutes 4:00PM
ICANN 101 -101-
Sl English (US) Meetin :‘e:'t‘n biic true 12/16/2016
ng' ( ting ing publi ('] 12:00AM
Minutes minutes
W English (US LCA:: - :B"':]-:OZ- bl t AYUVEOLS
nglish (US) eeting eeting public e 12:00AM
Minutes minutes
-
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Search:

Host Folder:

Introduction:

Privacy
Setting:

Create
Notification:

GAC:

) Private
") Public

) No
) Yes

+ Accountability & Transparency ]

+ ATRT 1

4+ ATRT 2

+ ATRT 3

+ ATRT 4

+ AoC Review

+ CCT Review

+ Specific Reviews
+ WHOIS Review

@ Clear Search

Matching Results (41)

Language
[ ™ engsn (us)
Sl English (US)

Wl English (US)

W English (US)

Wl English (US)

W English (US)

Title

Test 17th Jan
Minutes

Regression
Test 26th Dec
- Test Minutes

Test minutes
22nd dec

Test 215t Dec
minutes

ICANN 101
Meeting
Minutes

ICANN 102
Meeting
Minutes

T

URL Title

test-17th-jan-
minutes

regression-
test-26th-dec-
test-minutes

test-minutes-
22nd-dec

test-21st-dec-
minutes

icann-101-
meeting-
minutes

icann-102-
meeting-
minutes

PO T

Privacy
Setting

private

public

public

public

public

public

Create
Notification

true

true

true

true

true

true

13.0nce the checkbox next to the Minutes or Session that you would like to relate to an

Agenda is selected, select the Relate button at the bottom of the page.

Search:

Language

Title:

Host Folder:

Introduction:

Privacy
Setting:

Create
Notification:

GAC:

) Private
*) Public

) No
) Yes

+ Accountability & Transparency |

+ ATRT 1

+ ATRT 2

+ ATRT 3

+ ATRT 4

+ AoC Review
+ CCT Revie:

S -

Sl English (US)

Sl English (US)

W English (US)

Wl English (US)

W english (US)

W English (US)

14.Select Cancel to negate adding the content.
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ICANN 101
Meeting
Minutes

ICANN 102
Meeting
Minutes

Test public
minutes - 9th
Dec

Test new
private
minutes - 9th
dec

Public Test
Minutes 08

Public Test
Minutes 07

icann-101-
meeting-
minutes

icann-102-
meeting-
minutes

test-public-
minutes-Sth-
dec

test-new-
private-
minutes-9th-
dec

public-test-
minutes-08

public-test-
minutes-07

public

public

public

private

public

public

true

true

true

true

false

false

Official
Date and
Time

1/17/2017
3:00PM

12/26/2016
5:00PM

12/22/2016
9:45PM

12/21/2016
4:00PM

12/16/2016
12:00AM

12/16/2016
12:00AM

12/16/2016
12:00AM

12/16/2016
12:00AM

12/9/2016
10:30PM

12/9/2016
10:30PM

12/7/2016
12:00PM

12/7/2016
12:00PM

Next ©
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Actions

-

Release Lock
Save

Save / Publish

Assign Workflow

| & Cancel

OR

Select Save which will save the content and not publish it.
Actions

Release Lock

Save

Save / Publish
Assign Workflow

Cancel

OR

Select Save / Publish which will save and publish the edits.
Actions

Release Lock

Save

Save / Publish

Assign Workflow

Cancel

NOTE: Once Save / Publish is selected, the Agenda will be published in the Meetings &
Records section of site.

Updating ICANN Meeting Agendas

To update Meeting Agenda content, follow the steps below:
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1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site

& gacdevO Site Browser

3. Select Agenda - GAC from the Type dropdown list.

& Add New Content ~

showing 1-40 of 48 Export %)
Official
Privacy Date and Start Oate End Daie
Tithe URL Title Sefting  Lecation Time and Time and Time Last ednor Lam tr

2. 264

e

Figure 41: Navigating to the Content page within the Admin site will show all the Agenda pages that have already been created.

4. Click the Agenda Name in the right pane to open the live editor interface for the page.

Observe  Site Browser Content
o, Fokders & Fles "
o Content Search Change Ste
+ Ac w C -
e [A o OA = wing 1-4 48 txport X))
Official
Privasy Date and St Oate  End Date
Title URL Titke Seiting  Le<ation Time andYime andTime  Last Bditer Last tdin
e N ~ !
a - £ Clear Search ) ol " 1 ~
- - 1L 2016 1/772018 =
Advanced ~ B:00AM o

NOTE: You can refine your search by doing the following:

e Selecting any of the column headings to sort ascending and
descending

AND / OR

e Enter additional data in the Search field on the left and click the Search
button

5. After selecting the Agenda that you would like to modify, the editor will be displayed.
Lock the page for editing by clicking on Lock for Editing under the Actions menu.
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Observe  Site Browser
Ctaerve Pas Foiers A bies

Glodal Page PU

Content  Relationships

. Agenda - GAC

M Eaghsh (US) -

Workflow

Stepe [nitial State
Assignee: Nobedy

Acticea

Content

Marage s Sie

Connent Search A0A/Ean Agenda - GAC

History

I  Lock for Editing

& Cancel

Tithe:

Vigay_ICANNS7Hyderabad Agenda

URL Title:
vijay-ikcann57hyderabad-agenda

Privacy Setting:
Private
@ Pubic
Location:

Hyderabad, Inda

6. Modify any of the following fields:

Title

SQ@ P o0TY

Topic

Observe  Site Browser

Ctnerve Pages, Tokders & Fies

& Gobal Page pacdev0

Comtant Relationships

&1 Agenda - GAC
W English (US) -
Workflow

Step: Intial State
Assignee: Nobody
Locked: GAL Secretariat

Actions

Release Lock
 Sove

& Save/ Pubish
Assign Workflow

& Cancel

Content

Privacy Setting
Location
Official Date and Time
Start Date and Time
End Date and Time
Introduction

Mansge your Ste

Contertt Search Add/tdit Agenda - GAC

History

Tithe:

Vijoy _1CANNS THyderabad Agendas

URL Tithe:

vijay-icanns Thyderabad-spenda

Privacy Setting:
Private
® Public

Location:

Myderabad, India

Date and Time:

Us2017 v 1200AM |~

Start Date and Time!

2/6/2017 v 12:00AM | v

End Date and Time:

2/10/2017 v 12:00AM |+
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Observe Site Browser  Contemt

Ctnerve Pages, Tokders & Fies

& Global Page pacdev0

Comtont Relatiomshigs

£ Agends - GAC

W English (US) -

Workflow
Step: Intial State
Assignes: Nobody
Locked: GAL Secretariat

Actions

{ Release Lock
 Save

& Save/ Publsh
L Assign Workflow

& Cancel

Site Browser

Observe
Oteerve Pagen, Foiders & Mies

W Giodel Page gectevd

Content  Relationships

&1 Agenda - GAC

W Crghsh (US) -

Workfow

Step: [nitial State
Assignee: Nobody
Locked: GAC Secretariat

¢ Days A

Actions

of Release Lock

o Sove

@ Seve [/ Pubins
Assign Work®fow

& Cancel

Conteret Search

Manage your Ste

Add/tdit Agenda - GAC

P
WYSIWYG | » Language Varables.
Topici
Qick Mere to Select Categories

Histary
Introduction:

Fie ~ Ecnt ~ Insart ~ View ~ Format ~ Tools ~

Foms~ B /7 ¥ & E X 3 B - i-3 B W B & 2 -

P Woras: 0
Content
Macage your Ste
Conrtent Search Add/Lan Agends - GAC
Hstory

Woeds: 0

7. Once modifications have been made, you can either select Cancel to negate the edits.
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Actions

{' Release Lock

Save

& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will save the edits and not publish them.

Actions

{' Release Lock

Save

& Save / Publish
Assign Workflow

& Cancel

OR

Select Save / Publish which will save and publish the edits.

Actions

Release Lock

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Agenda will be published in the Meetings &
Records section of site.

ICANN Meeting Minutes

The Meeting Minutes content is an official document published by the Secretariat on behalf of
the GAC so that GAC Members and other community members can confirm what took place in

ICANN |TYPE THE DOCUMENT TITLE | MONTH YEAR |196



a session. The document is composed of several sessions and includes all the notes and

outcomes from those sessions. The document gives an accurate record of the session in case

there is ever question about what happened, what was said, or decided in that session. A
relationship can be established between Minutes and an Agenda so when the Agenda is
viewed, the Minutes will display on the Session that has also been related to the Agenda.

The following screenshot illustrates the contents of the ICANN Meeting Agendas:

Calendar

ICANN Meeting Agendas  ICANN Meeting Minutes

EDITON

[lonnsvcm MEETING MINUTES :] D

~—, [ICANN57 GAC Meeting
Minutes
- " Pc‘l

Introduction

Friday, 04 November 2016

. > Saturday, 05 November 2016

TCANN57 GAC MEETING MINUTES|+——

[II‘\dchlxnl. India 03-09 November :.mﬁ] <

Monday, 0T November 2016

Tuesday, 08 November 2016

Wednesday, 03 November 2016
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Introduction

These are the official minutes from the meceting of the Govemment Advisory Committee
GAC) as part of [CANNS7 3-9 November 2006 in Hyderabad, India.

The GAC discussed a range of topics of interest as well as mecting formally withe

Ceneric Names Supporting Organisation  GNSO

Bosd GAC Recomemendutions leplementation Working Group BORI

Country Code Names Supporting Organisation (NSO

The OCT Review Tesn

The At-Lange Advisary Comesittee (ALAC : and

The HCANN Bound,
The GAC published an official communique for the mecting and also participated in a range
of outreach activitics with the Government of India and the Government of the State of
Telangana,

| 197



Friday. 04 November 2016

ICANN3S7 - GAC Agenda Ttem 2 - IANA Stewardship 09230 - 10200 UTC Hall 4
Leads:
Thaoeres Schncider, GAC Chair
Objective:
Update abour the LANA Scowandship transition
Expected Outcome:
Session Minutes:

The GAC were remindad that the IANA Transition occurred on 3oth September 2006,

The GAC were remindad that the GAC lizison to the Post LANA Transition (P11
Customer Standing Committee (CSC) is Elise Lindeberg from Noeway,

I'he CSC Lialson informed the GAC that there had been two meetings of the CSC 1o date
via tekoconference, both for administrative purposes. The first face to face mecting of the
CSC s this week in Hyderabad,

It was noted that there are some unresolved issues in refation to the LANA Transition which
arc being covered by discussions on the new ICANN Bylaws which arce taking place, These
refate 1o GAC appointments to the new PITbodies such as the CSC and ICANN review
bodics. There are also specific community powers related to the handling of the IANA
function.

Those GAC Members who have worked on the TANA Stewandship activity on behalf of the
GAC were formally thanked by the GAC Chair.

\ction ltems:

Bricf & Presentation Materiaks
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Note the following elements of the Meeting Minutes:

e Meeting Minutes Title: This element is the title specified in the Title field when creating
the Meeting Minutes content

e View as a PDF: This element is the link that will allow the user to view and download the
Meeting Minutes as a PDF and then print

e Anchor Links: This element is the link that will automatically navigate the user to the
section that corresponds with the selected link

e Meeting Minutes Introduction: This element is the Introduction specified in the Meeting
Minutes content

e Meeting Minutes: This element is the view of the published Meeting Minutes

o Edition Dropdown List: This element is the dropdown list allows you to select other
published Meeting Minutes

e Meeting Location, Start Date & End Date: This element is the Location, Start Date & End
Date specified in the Agenda content

e Related Session Content: This element is the Session content that has been related to
the Agenda

Creating Meeting Minutes
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To create new Meeting Minutes content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site

& gacdevO Site Browser

3. Select Minutes — GAC from the Type dropdown list.

Observe  Site Browser Content

& 9¥00ev0 Content Search Change She (v

o+ Add New Cortent ~

showing 1-40 of 41 Export X))
Official
Privecy Sreate Date and
Yitke URL Tithe Setting  Motification Time Last Editor Last £dit Date
- ™ (en_us Test 171h Jan Minutes test - 1 21 Jan-mrvates prteate rue vivan? Ny Jan 1772017 10:S6AM

_ Search + #§ Cear Search

® Mienus Regression Test 26eh (e5resssan-1est- 264N -On s true

Advanced

Dec « Test Minutes Lest rraautes S.00M

Figure 42: Navigating to the Content page within the Admin site will show all the Minutes pages that have already been created.

4. Select the Add New Content button on the top right.

Observe  Site Browser Content
Ctserve Poges, Folders & Fles Marage v
& 9¥00ev0 Content Search Change She (v
o+ Add New Cortent ~
~ GAL = showing 1-40 of 41 Export 5]
Official
Privecy Sreate Date and
Titke URL Titke Setting  Motification Time Last Editor Last £dit Date
- ™ (en_us Test 171h Jan Minutes test - 1 21 Jan-mrvates prteate rue vivan? Ny Jan 1772017 10:S6AM
_ Search + #§ Cear Search 3:000M
. = 35800 Te ,- Secretar ~
Advanced e et Minutes - - ~

5. Complete the following required fields:
a. Title
b. URL Title (automatically created based upon the Title)
c. Privacy Setting (defaults to Private)
d. Official Date and Time
e. Agenda — GAC Relationship
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Observe  Site Browser Content
Comerve Fages, Folders & Fles  Marage your Ste
 Gobal Page pacdev0 Conternt Search Add/Edit Minutes - GAC

Content Mistory

4 Misutes - GAC

Tithe:
SUEngish (US) -
ICANN 101 Meeting Mnutes
Workflow
URL Tithe:
Step: Intial State icann-101-meeting-mimnutes
Assignee: Nodody
Introduction:
Actions
Fle~ Edt~ Inset~ View~ Format~ Tools ~
A Lock for Eduing Fomas* B 7 Y S E X A B - -3 3 ® B & 2 v~
& Cancel

M Foks,
ICANN is thanikdul 10 you for making ICANN1O1 a successiul moeting. Here are details about Phe points decussed.

Observe  Site Browser Content
e e Pagen, Folders & Fles  Masage your Sae

& Global Page Pacoe Cannent Search AGA/EAn Minutes - GAC

Content  Mistory

Privacy Setting:
£ Minutes - GAC Private
. Eagish (US) = @ Publc
Wi Create Notification:
No
Stepe Initial State . Ve
Assignee: Nobedy
Official Date and Time:
Actions 12/16/2016 = 12:00AM | ~
A Lock for Editing Relate the event Agenda for which you would like to create a Minutes document:
& Concel
1 Agenda - GAC: Parent (AgendaGac-MinutesGac) Relate +
Tith URL Tith Privacy L th Official Date and  Start Date and  End Date and
Setting Time Time Time
& @0EE@
X KA Kana101 oubn London, United 12/8/16 12:00 AM 1917 12:00 AM VINIT 12:00 AM
®

6. Select Cancel to negate adding the content.
Actions

kd Save
& Save / Publish

Assign Workflow

& Cancel
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OR

Select Save which will save the content and not publish it.
Actions

kd Save

& Save / Publish
Assign Workflow

& Cancel

OR

Select Save / Publish which will save and publish the content.
Actions

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Minutes will be published in the Meetings &
Records section of site.

Relating Content to Meeting Minutes

While creating the Meetings Minutes content, the Secretariat can relate the Minutes to an
Agenda so the Minutes can be associated to the Session in which they were taken.

NOTE: In order for the Minutes to be associated to the Session in which they belong, the

Session will need to be related to the same Agenda so there is a relationship between the
Agenda, Session and Minutes.

RELATING NEW CONTENT TO MEETING MINUTES
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To relate a new Agenda to Minutes, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site

& gacdevO Site Browser

3. Select Minutes - GAC from the Type dropdown list.

Observe  Site Browser Content

.....

Change Sae (-~

o+ A w C
....... g 1-4 port )
official
Privecy Sreate Date and
Yitke URL Tithe Setting  Motification Time Last Editor Last £dit Date
P ™ a
Search + g Clear Search SE]
o N
Advanced

et Minute: et - O

Figure 43: Navigating to the Content page within the Admin site will show all the Minutes pages that have already been created.

4. Double click the Minutes Name in the right pane to open the live editor interface for the page.

Observe  Site Browser Contenmt
coerve w0t . & Pk Marage

& osctevo Content Search

Change Ske [~

+ Add New Content ~

port X)
official
Privacy Create Date and
Titie VKL Tile Setting MNotification  Yime Last tditor Last Edit Date
- - T 20 2:45AM
orch = 4 Clear Search .
- < " misctes  private 17 10:58AM
Advanced
- - e 2 v
De “ 44

NOTE: You can refine your search by doing the following:

e Selecting any of the column headings to sort ascending and
descending
AND /OR
[ ]

Enter additional data in the Search field on the left and click the Search
button

5. After selecting the Minutes that you would like to modify, the editor will be displayed.
Lock the page for editing by clicking on Lock for Editing under the Actions menu.
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Observe  Site Browser Content
Ctamrve Pages, Folders & Fles  Masage your Soe
Glosal Page Gaccedd Connent Search Add/Ban Minstes - GAC

Content Mistory

£ Minutes - GAC
Title:
W Engish (US) -
ICANN 101 Meeting Minutes

Workfow
URL Title:
Step: Initial State

Assignes: Nobody

Kkann-101-meeting-minutes

Imtroduction:
Actions

Fle ~ Edn ~ Insert ~ View ~ Format « Tools «
[ Look tor eaming | fomas~ B Z U S |E X 3 B |E-E-3 3 |B B |lL 2lv-
@ Cancel

Hi Folks,

6. Once the Minutes content has been locked, select the Relate dropdown list.

Observe  Site Browser Content

Oteerve Pagen, Foiders & files  Mamage your Ste

Giotel Page Qectevd Cartent Search ASS/EER Minutes - GAC

Content History

wvs:vei - Language Variables
£ Minutes - GAC
W Engish (US) -
’ Privacy Setting:
Private
Workfow & Pubic

Stap: [nitial State

A : Nobady Create Notification:

Locked: GAC Secretariat No
2 . Yo
Actions Official Date and Time:

£ Release Lock 12/16/2016 ' * 12:00AM |~

b Seve Relate the event Agenda for which you would like to create a Minutes document:
@ Seve /Pudins

Assign Workfow

& Concal Agenda - GAC: Parent (AgendaGac-MinutesGac)

URL Privacy L " Official Date and Start Date and End Date and Time

TRie Title Setting Time Time

7. Select Relate New Content from the Relate dropdown list.
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Observe  Site Browser Conten
Oteerve 2 ciders & 7

o Pagea. Foid s Marage your Ste
Giotel Page qectes Cortert Search Add/EaR Minutes - GAC
Content  History

WYSIWYG | » Language Varables
£ Minutes - GAC

Wi Crghsh (US) .
Privacy Setting:

Private

Workflow ® Pubic

Stepe [nitial State

Assignee: Nobody Create Notification

Locked: GAC Secretarat No
® Yes
i Official Date and Time:

12/16/2016 ~ 12:00AM ~

- Save Relate the event Agenda for which you would like to create a Minutes document:
& Save
Asss Work ~
& Cancel A . Pares - 0 PP )
genda - GAC: Parert (AgendaGac-MinutesGac) . Relate| =
URL Privacy Official Date and Start Date and
Title Setting Location Time Time End Date and Time

8. Complete the following required fields to create a new Agenda to relate Minutes to:
Title

URL Title (automatically created based upon the Title)

Privacy Setting (defaults to Private)

Location

Official Date and Time

Start Date and Time

End Date and Time

@ ~oapow
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Observe  Site Browser Content

Ctnerve Pages, fokders & Fles  Manage your Ste

oy Gecoert Cortert Search Add/Edn Agenda - GAC

Comtont Relationships

Agends - GAC

Wi English (US) -

Workflow

Step: Intial State

Assignee; Nobody

Actions

e Save

@ Seve/ Publsh

Aswgn Workflow

& Cancel

9. Select Cancel to negate creating the Agenda and relating it to Minutes

A

ctions

kd Save

& Save / Publish

Privacy Setting:
® Private
Public

Official Date and Time:

Start Date and Time:!

End Date and Tiee:

Assign Workflow

¢ Cancel

OR

Select Save which will create the Agenda, relate it to Minutes and not publish

Actions

kd Save

& Save / Publish

Assign Workflow

¢ Cancel
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OR

Select Save / Publish which will create the Agenda, relate it to Minutes and save /
publish the Minutes

Actions

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE:
e Once Save / Publish is selected, the Minutes will be published in the Meetings &
Records section of site.
e Relating a new Agenda will create the Agenda content that is attached to Minutes but is
also independently accessible and will display in their respective site section.

RELATING EXISTING CONTENT TO MEETING MINUTES

To relate an existing Agenda to Minutes, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe

Site Browser

Content

Observe Pages, Folders & Files | Manage your Site

& gacdevO Site Browser

3. Select Minutes - GAC from the Type dropdown list.

Observe  Site Browser Content

.........

official
Privecy Create Dete and
Setting  Motification Time Last Editor Last £dit Date

Tt URL Tithe

Advanced Det + Test Minete: v S:00M

Figure 44: Navigating to the Content page within the Admin site will show all the Minutes pages that have already been created.
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4. Double click the Minutes Name in the right pane to open the live editor interface for the

page.
Observe  Site Browser Contenmt
Seerv o ar Marage
& oscdev0 Content Search

port X)
official
Privacy Create Date and
Titie VKL Tile Setting MNotification  Yime Last tditor Las E4it Date

- % - SAM
earch ~ £4 Cear Search e

- W (en_US Test 17th Jan Minutes | test-17th-jan-minctes  privats 20 W17/2017 10:56AM
Advanced i

- . T 2 -

NOTE: You can refine your search by doing the following:

e Selecting any of the column headings to sort ascending and
descending

AND / OR

e Enter additional data in the Search field on the left and click the Search
button

5. After selecting the Minutes that you would like to modify, the editor will be displayed.
Lock the page for editing by clicking on Lock for Editing under the Actions menu.

Observe  Site Browser Content
Add/Ban Minstes - GAC

Mistory

£ Minutes - GAC

Title:
-
ICANN 101 Me
Workflow
URL Title:
Step
Assignee
Imtroduction:
Actions
Fle* Edt~* Inset~ View~ Format~ Tools >
[[& tockfor Eaming ] foras- B / Y 5 E X A M E-iE-W W R B L B -
@ Cance
Hi Folks,

6. Once the Minutes content has been locked, select the Relate dropdown list.
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Observe  Site Browser Content
Oteerve Pogen, Foiders & fies  Mamage your Ste
Giotel Page Qectevd Cortent Search ASS/EaR Minutes - GAC
Content History
WYSIWYG | » Language Varables
&1 Minutes - GAC :
Wi Engish (US) -
Privacy Setting:
Private
Workfow & Pubic

Step: [nitial State

Assignes: Nobody Create Notification:

Locked: GAC Secretariat "o
" . Ves
Actions Official Date and Time:

§ Relesse Lock 12/16/2016  * 12:00AM | =

e Save Relate the event Agenda for which you would like to create a Minutes document:
@ Seve [ Pubins

Assign Workfow

& Concel Agenda - GAC: Parent (AgendaGac-MinutesGac)
URL Privacy Official Date and Start Date and
Title  ritte Setting Location rie Time

7. Select Relate from the Relate dropdown list.

Observe  Site Browser Content
Frierve Fages, Folders & Fles  Manage your Ste
Giobal Page pacdev0 Content Search Add/Edit Minutes - GAC

Conmtent History

WYSIWYG | Language Variables
£ Minutes - GAC )
M Engiish (US) -
Privacy Setting:
Private
Workflow & Public

Step! Intal State

Assignee: Nobody Creste Notification:

Locked: GAC Secretariat : o
o Yeos
Actions Official Date and Time:
4§ Release Lock 121672016 | = 1200 AM |~
i Save Relate the event Agenda for which you would like to create a Minutes document:
& Save/ Pubish
Assign Workflow
& Cancel Agenda - GAC: Parent (AgendaGac-MinutesGac)
URL Privacy Official Date and Start Date and
Tte  rite Setting Location  rime Time

End Date and Time

End Date and Time

4 Relate) ~
Retate

4 Retete New Content

8. Once Relate is selected, a Search pop-up will display. Select the Search button to
return all results or enter criteria in any of the Search fields to refine the Search results

returned.
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Search:

Language A ~
Title:

Host Folder: .

Private
) Public

Privacy
Setting:

Location:

Introduction:

GAC: |+ Accountability & Transparency f|

+ ATRT 1

+ ATRT 2

+ ATRT 3

+ ATRT 4

+ AoC Review

+ CCT Review

+ Specific Reviews
+ WHOIS Review

@ Clear Search

Figure 45: You can refine your search by entering additional criteria in the Search pop-up and then selecting the Search button.

9. Once the Search button is selected, the results will display in the right side of the Search

POp-up.
Search:
|Matching Results (54)
Host Folder: -
Privacy
Language Title URL Title ing Location
Privacy () Private
Setting: () Public _ . -17th-
9 C Wl English (US) Test Agenda 17th Jan U-S0end-17t | ivare | 20R8NF
jan Tech
Location:
Vijay Agenda from BQ vijay-agenda- Hyderabad
S English (US) script10-01- from-bg-script10- public tndie ‘
Introduction: 17::21:02:264 01-17-21-02-264
Vijay Agenda from BQ vijay-agenda- Hyderabad
GAC: [+ Accountability & Transparency §| Sl English (US) script10-01- from-bg-script10-  public iia g
+ ATRT 1 17::19:28:467 01-17-19-28-467
+ ATRT 2
+ ATRT 3 vijay-icann-102- New York,
+ ATRT ¢ Wl English (US) Vijay ICANN 102 Agenda agenda public NY, USA
+ AoC Review
+ CCT Review . vijay-
) ) Vijay_ICANNS7H, H
+ Specific Reviews Wl English (US) Jay_ICANNS7Hyderabad | | anSThyderabad- = public yderabad,
+ WHOIS Review Agenda agenda India
regression-test-
Sea . R ession T 26th Zensa
= rch) @ Clear Search Sl English (US) egression Test D8 6th-dec-test- public !
- test agenda Tech
agenda
.|
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10. Select the checkbox next to the Agenda that you would like to relate to Minutes.

Search:
Matching Results (54)
Host Folder: -
Privacy
Language Title URL Title ing Location
Privacy () Private
Setting: () Public _ . . .
9 C ] ®engish us) Test Agenda 17th Jan ;: agenda-i7th- o ivate f:::‘"
Location:
Vijay Agenda from BQ vijay-agenda- Hyderabad
S English (US) script10-01- from-bg-script10- public tndie ‘
Introduction: 17::21:02:264 01-17-21-02-264
Vijay Agenda from BQ vijay-agenda-
) . . Hyderabad,
GAC: |+ Accountability & Transparency Sl English (US) script10-01- from-bg-script10- public tndis
+ ATRT 1 17::19:28:467 01-17-19-28-467
+ ATRT 2
+ ATRT 3 z vijay-icann-102- New York,
+ ATRT ¢ Wl English (US) Vijay ICANN 102 Agenda agenda public NY, USA
+ AoC Review
+ CCT Review ) vijay-
+ Specific Reviews W English (US) Vijay_ICANNS7Hydersbad | 1 annSThydersbad- | public | | Yderabed,
+ WHOIS Review Agenda India
agenda
regression-test-
-« Sea N R Test 26th Dec Z
& Clear Search Sl English (US) egreasion tes 26th-dec-test- public ensar
- test agenda Tech
agenda
11.0nce the checkbox next to the Agenda that you would like to relate to Minutes is
selected, select the Relate button at the bottom of the page.
D)
- o =102~ New York
Search: W English (US Vijay ICANN 102 Agenda  *D3Y-icann biic "
(us) Jay Soanis pu NY, USA
Language ! iay-
guage || — Vijoy_ICANNSTHyderabag "2 Myderabad,
B English (US) icannS7hyderabad-  public
Agenda Incia
Title: agenda
. regression-test-
Regression Test 26th Dec Zensar
Host Folder: . Sl English (US) - baot S0enda 26th-dec-test- public L
agenda
Privacy () Private w 22nd-dec-test-
- English (US' 22nd dec test agenda blic Zensar
Setting: () Public oeh (U5) 9 agenda ey
Location: Wl English (US) Test agenda - 21st dec test-agenda-21st- | o i Zensar
dec Tech
meeting-55- Marrakech,
Introduction: W English (US) Meeting 55 - Agenda sgende public Moroeeo
GAC: [+ Accountability & Transparency W English (US) ICANN100 Agenda icann100-agenda public Pune, India
+ ATRT 1
+ ATRT 2
+ ATRT 3
+ ATRT 4 Next ©
+ AoC Review
+ CCT Review
+ Specific Reviews
. —
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12.Select Cancel to negate adding the content.

Actions

{' Release Lock
kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will save the content and not publish it.

Actions

{' Release Lock

kd Save

& Save / Publish
Assign Workflow

& Cancel

OR

Select Save / Publish which will save and publish the edits.

Actions

{' Release Lock

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Meetings Minutes will be published in the Meetings
& Records section of site.

Updating Meeting Minutes
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To update Meeting Minutes content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site
& gacdevO Site Browser

3. Select Minutes - GAC from the Type dropdown list.

Observe  Site Browser
wve e —Y

Content

@ 9%00ev0 Content Search

Change She |~

+ Add New Cormtent

showing 1-40 of 41 Export X))
Official
Privecy Sroate Date and
Yitke URL Tithe Setting  Motification Time Last Editor Last Edit Date
_ Search +  #a Clear Search * ™ - e e poion "
Advanced ¢ = ¢ Yout Minates S kv AC Secret o
Figure 46: Navigating to the Content page within the Admin site will show all the Minutes pages that have already been created.
4. Double click the Minutes Title in the right pane to open the live editor interface for the
page.
Observe \‘n. 'NW Contemt

[T Content Search Change Site |~
+ Add New Content

" - . = howing 1-4( 4 Export 5]

Officlal
Ses Privacy Create Date and
Titie VL Thie Setting Notification  Yime Last tditor a1 E4it Date
Search ~ £4 Clear Search ‘ b 0PM e
Advanced ® - " 7/ 7 10:S6AM

NOTE: You can refine your search by doing the following:

e Selecting any of the column headings to sort ascending and

descending

AND / OR

e Enter additional data in the Search field on the left and click the Search

button
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5. After selecting the Minutes that you would like to modify, the editor will be displayed.
Lock the page for editing by clicking on Lock for Editing under the Actions menu.

Observe  Site Browser Content
Ctaerve Pages, Folders & Files  Manage your Ste
Glosal Page Gacoevs Cartent Search A/ Ean Minutes - GAC

Content Mistory

%1 Minutes - GAC
Title:
W Engish (US) -
ICANN 101 Meeting Minutes

Workfiow
URL Title:

Steps Initial State .
Kann-101-meeting-minutes

Assignee: Nobody

Imtroduction:
Actions
Fle ~ Eon ~ Insert » View * Format « Tools
[ Look tor eaming | fomas~ B Z U S |E X 3 B |E-E-3 3 |B B |lL 2lv-
& Cancel

Hi Folks,

6. Modify any of the following fields:
a. Title
b. Introduction
c. Privacy Setting
d. Create Notification
e. Official Date and Time
f. Agenda — GAC Relationship
g. Topic

Site Browser Content
Ctaerve Pagas. Foers A Fies o3¢ your Sine
Glonal Page Gaccevs Cantent Search AGS/FOx Minutes - GAC

Content Mistory

%1 Minutes - GAC

Title:
W Engish (US) -
ICANN 101 Meeting Minutes

Workfiow

URL Title:
Steps Initial State

Assignee: Nobody

kann-101-meeting-minutes

Introduction:

Actions
Fle* Edt~* Joert~ View~s Fomat~ Tools~

) Lack o Gdisg Fonts~ B 7 ¥ 6 E X A B =- -3 A @ E &L 2 ¢~
& Cancel

i Folks,

ICANN is Bankiul 15 you for maling ICANN101 & successiudl meoting. Here are dotals about the poInts decussed.

I |
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Observe  Site Browser Content
Oteerve Pogen, Foiders & files  Masage your Ste
b Giobel Page Qecdevd Cortent Search ASS/LER Minutes - GAC

Content History

Privacy Setting:
%1 Minutes - GAC Private
& Pubic
Wi Enghsh (US) -
Create Notification:
Workfow
No
Step: [ntial State . Yes
Assignee: Nobody
Official Date and Time:
Acticns 12/16/2016 | * 12:00AM |~
A Lock for Editing Relate the event Agenda for which you would like to create a Minutes document:
& Cancel
Agenda - GAC: Parert (AgendaGac-MisntesGac)
Privacy Official Date and  Start Date and  End Date and
This URLTItle o tving SaCation Time Time Time
& @0-@E=
K ICANNI0L arm101 pubinc London, Usied 12/8/16 12:00 AM LO/17 12:00 AM 113717 12:00 AM @
Tople:

Click Here to Select Categories

7. Once modifications have been made, you can either select Cancel to negate the edits.
Actions

o' Release Lock
kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will save the edits and not publish them.
Actions

o' Release Lock

kd Save

& Save / Publish
Assign Workflow

& Cancel

e — —
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OR

Select Save / Publish which will save and publish the edits.

Actions

Release Lock

Save

@ Save/ Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Minutes will be published in the Meetings &
Records section of site.

Work Efforts

The Work Efforts section allows site visitors to be informed of Work Topics, the Activities
associated to the Work Topics and GAC Working Groups preforming those Activities. The
major content included within Work Efforts includes:

e Work Topics
e Activities
e GAC Working Groups

Introduction Header

The Introduction Header is meant to orient site visitors to the Work Efforts page and give them
a basic understanding of Work Topics, Activities, GAC Working Groups and their related
artifacts.

The following screenshot illustrates the contents of the Work Efforts Introduction:
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‘.\"3 ICANN.org English 4ual Espafol Francais Pycckwit X Welcome Alex £93

LAV S

ICANN I G A c NEWS ABOUTTHEGAC GACADVICE MEETINGS & RECORDS WORK EFFORTS

l 4 Work Efforts [®]«—-« l
At any given time, the GAC works to examine Y- S = r
a range of issues related to the functions and GAC WORKING GROUP PROCEDURES
responsibilities of ICANN, GAC Members use & g R
the information to develop policy positions | | BXPLORE THE Ié IPIES & WORK
within their own administrations and the | | EFFORTS DRIVING GAC ADVICE
GAC as a whole may try to reach a consensus - p ’ Y e
position on particufar matters, Having | | LEARN “f\)k!"\‘,\_m VT POLICY
reached a consensus view, the GAC usually DEVELOPMENT @ICANN.ORG
then provides advice to the ICANN Board.
This section of the GAC website provides the I

GAC Working Group Members tools to
manage their work, meetings, rescarch and
collaborative documents. It also provides an
anthology of previous GAC work cfforts
related to cach 1CANN topic of interest,
which is available to any uscr to review.

Note the following elements of the Work Efforts Introduction:

¢ Introduction Text: Brief informational section that informs the user of the Work Efforts
section
e Introduction Links: Links to resources to help educate the user about GAC Working
Group Procedures, Topics & Work Efforts driving Advice as well as Policy Development.
The links and destinations are listed below:
o GAC Working Group Procedures: Selecting this link will automatically open
https://gacbeta.icann.org/member-resources/working-group-procedures.
o Explore the Topics & Work Efforts Driving GAC Advice: Selecting this link will
automatically open https://gacbeta.icann.org/work-efforts/work-topics.
o Learn More About Policy Development @ ICANN.org: Selecting this link will
automatically open https://www.icann.org/policy.
e Collapse Introduction: Selecting “X” will collapse the Introduction section
e Expand Introduction: Selecting “i” will expand the Introduction section

Updating the Introduction Header Contents

To update the Introduction Header content, follow the steps below:
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Log into dotCMS Admin.
2. Click the Site Browser tab from the top navigation.

Site Browser Content
Pages, Folders & Files Manage your Site

Figure 34: Navigating to the Site Browser page within the Admin site will show all the editable pages that you are able to modify.

3. On the Site Browser page, within the left pane, click on the work-efforts folder.

Site Browser Comtent
Poges, Pokders B Fies  Marage your Ste

- e Site Riowser Change Site |~

Sites and Folders M Engiah (US) - o+ Add New ~
Name Meny  States Mod. User Mod. Date
0 etion
b " rdex . W (en_US) Work Boms Ame Maty 1002016 05:32:03 P
COPLRNT-Qanerns-mirated
fie easet
home
mages
yon o) Shaw Movives
nguage-Mataged-services
Bjuspe-mataged-serv
eoal
recting-vervicos
Peetngs-TeOr0s
Merrber resources
mindtes
rews-rotf Cations.
Sperating prnoples
prenentations
POTCOes- a0 guadelres
’ transcripts
» WOrkng-9roww
Figure 47: Clicking the meetings-records folder in the left pane will show the folders contents in the right pane. Notice that it
includes the index html file.

4. Double click the index html page in the right pane to open the live editor interface for the
page.
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o Bries  Marege your

- e Site Rrowser —-
$ites and Folders W Englah (US) -

------ - Hemu States Mod.Mser

apprcation

triety

Ot -ganenc-migrated T gec-working-groces . W (en_US) GAC Werking Geoups A M

fie easet

home

mages
o o) Shaw Movives

angusge-managed-services
BNjusje-Mataged-senvi
eyl
recting-vervicen
Feetings - eOs
Merrber resources
mindtes
rews-rotfcatons
Sperating prnoples
proventations
PATCOies-ane-guidelres
renscripts
| work-efforts
3 WOrng- 9o
Figure 48: Double clicking index from the right pane will open the page in its Live Editor which allows the Secretariat to modify the
contents of this page.

5. From the live editor mode, first lock the page for editing.

Preview Live

“  Lock for Editing

(= 9

@& Publish Page

=2 Remote Publish Page
& Add To Bundle

6. Click on the Edit Content button in the part of the Introduction section that needs to be
edited.
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() ICANN.org g Ay nll Frangais PycCKWi

ICA N N I G A C NEWS ABOUTTHEGAC GACADVICE MEETINGS &RECORDS WORKEFFORTS

Work Efforts ®

CS T I ANN oD
analysis and advice to the ICANN Board on THE ICANN ADVICE
policy matters within ICANN’s mission that TRACKER
concern governments and may affect public
policy outcomes. The GAC has been
providing advice to the ICANN Board since
1999 when it held its inaugural meeti You g y - c -
can learn more about !ll\% role of thncg(i.-\( y»7 LEARN MORE AB( UTPOLICY
how the GAC operates and who is in the GAC l)l':\ l"l',( I ;\""\ I, & K,“'\,'\}'OR(' INTRO
from here. * WORK EFFORT TABS INTRO ~ HEADER FOR WORK EFFORT

TEXT™*

Welcome to the GAC WOR - SPONSES IN| ] E3)
EFFORT page. The GAC provid I'RACK BOARD RESPONSES IN |

EXPLORE THE TOPICS & WORK
EFFORTS DRIVING GAC ADVICE

Figure 49: Clicking the Edit Content button will open a text editor that allows the Secretariat to change the contents of the
Introduction section.

7. After clicking Edit Content, the editor will be displayed. Lock the page for editing by
clicking on Lock for Editing under the Actions menu.

Actions

& Lock for Editing

& Cancel

8. Modify only the Body editor’s content as shown by the figure below.
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Observe Site Browser  Content

Oteerve Pagen, Folders & fies  Manage your Ste

& Giodel Page gectevd Ste Browser Add/tdit Content (Generic)

Content History

&1 Content (Generic)

Title:
Wi Englsh (US) -
Work Effort Intro text
Workfow
URL Title:
B work-effort-intro-text
Assignee: Nobody
Locked: GAC Secretarat Tople:
Seconds A
Qick Here to Select Categories
Actions
of Release Lock Body:
o Seve Fle~ Edt~ Inset~ Vew~ Fomat~v Tools v
@ Seve/Putin fomus B /7 Y S5 E X 3 B -iE-30 A B & & B v~
Assign Workfow
Weicome 10 the GAC WORK EFFORT page. The GAC provides analysis and advics % the ICANN Board 0n policy matiers within ICANN'S
& Cancel mission that concern governments and mary affiect public policy ouicomes. The GAC has been providing advice 1o the ICANN Boand since 1959
whan it held s inaugural meeting. You can loam maone about the sole of the GAC, how the GAC operates and who is in the GAC fom here. **
WORK EFFORT TABS INTRO TEXT **

Observe  Site Browser Content
Oteerve Pagen, Folders & fies  Manage your Ste

& Giotel Page gecdevd Ste Browser Add/tdit Content (Generic)
Content  History

£ Content (Generic)

Title:

Wi Englsh (US) -
Work Effort Intro Links

Workflow

URL Title:

e work-effort-intro-links

Assignee: Nobody

Tople:
Actions Qlick Here to Select Categories

A Lok for Editing
Body!

& Carcel
Fle* Edt~ Inset~ View~ Format~v Tools v

foms> B /7 U 5§ E X 3 B -iE-0 A B & & B v~

LEABN MORE ABQUT POLICY DEVELOPMENT £ ICANN CRG ™ INTRO HEADER FOR WORK EFFORT

9. Once the edits have been made, you can either select Cancel to negate the edits.
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Actions

kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will save the edits and not publish them.
Actions

kd Save

& Save / Publish
Assign Workflow

¢ Cancel

OR

Select Save / Publish which will save and publish the edits.

Actions

kd Save

& Save / Publish

Assign Workflow

¢ Cancel

10. Select Release Lock to release the lock on the content.
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Edit Preview Live

Release Lock

Publish Page
Remote Publish Page
Add To Bundle

By ®|N

Assign Workflow

Work Topics

The Work Topics content type is a list of topics that work is taking place around. A site visitor
will be able to traverse a list of work topics to stay up to date with the type of work that is taking
place.

The following screenshot illustrates the contents of the Work Topics:

Work Topics  Activities = GAC Working Groups

. Formal ICANN Structures )
Accountability & Transparency ICANN Meetings
GAC Activities
——— | Contracts & Agreements Other ICANN Stakeholders
. ETLD Programs X
Domain Names Policy Development
ICANN Governance

L —— Accountability&Transparencyl Actey Stat

RECENT ACTMITHS LEAD ; STATUS: LATEST UPDATES:
GAC Website Introduction Videos Corinna Ace Active NA
Implement New GAC Website GAC TTF Active NA
~—#|Establish Technology Task Force GACTTF Completed NA

Draft survey to GAC Members from all around the world Julia Charvolen Active NA

GAC Working Group on
Early Warning Discussions Earty Wamning and New | |Active NA

RTLD Advice Procedures

Note the following elements of the Work Topics:

All GAC Work Topics: List of all Work Topics

Work Topic Title: Title specified on the Work Topic content

Related Activities: Activities that have been related to the Work Topic

Activity Lead: Lead specified on the Activity content related to the Work Topic
Activity Status: Status specified on the Activity content related to the Work Topic
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o Activity Latest Update: Latest update on the Activity content related to the Work Topic

Creating Work Topics
To create new Work Topics content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site

& gacdevO Site Browser

3. Select Work Topics - GAC from the Type dropdown list.

+ Add New Content ~

showing 122 of 22 Export X)
Official
Date and
Tnie URL Titke Time Last Eater Last Ea% Date
B - 5 o WY 1N 1 /irne LaM
Search * 2 Oeor Search 3-000M
. W (o US Test WY 261 Goc regression Des2 - Wt JHTN-GeC- regress D016  GAC Secretaniat I2016 10N

Advanced

Figure 50: Navigating to the Content page within the Admin site will show all the Work Topics that have already been created.

4. Select the Add New Content button on the top right.

= [ b=
@ o0, Content feaech Change site
Work Topks - GAC .= showing 1:22 of 22 Export §)
OMicial
nie URA Tithe ?l:: - Last Eater Last Ea% Date
Seard fa Clear Search * ™ ’ - -
Advancex @ - W - - ¢ “ A ~
5. Complete the following required fields:
a. Title
b. URL Title (automatically created based upon the Title)
c. Official Date and Time
I |
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Observe  Site Browser

Ctnerve Pages, Tokders & Fies

& Gobal Page pacdev0

Comtant Hstory

£ Work Topics - GAC

Wi English (US) .

Workflow

Step: Intial SZate
Assignes: Nobody

Actions

A ‘ock for Edung

& Canced

Observe  Site Browser

Ctasve Pages, Folders & Fies

o Global Page Qacoe

Content Mistory

£ Work Topics - GAC

S Engish (US) =

Workflow

Steps Initial State
Assignee: Nobody
Actions

R Lock for tditing

& Coarcel

Content

Mansge your Ste

Contentt Search Add/Edit Work Topics - GAC

Tithe:

Policy Development

URL Tithe:

policy -development

Yopic:
Click Here to Select Categories

% poe | ® pubiic Comment

Description:
Flo~ Edt> Inset> View~> Format~ Tools ~
Fomas~ B 7 Y & E X A B - -3 3

Content

Marage yiur Sae

Cantent Search ASS/BEx Werk Topics - GAC

P

WYSIWYG | » Language Varables

Offickal Date and Time:

12/2/2016 v 12:200MM | -

6. Select Cancel to negate adding the content.

® E &L &R

v -
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Actions

kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will save the content and not publish it.
Actions

kd Save

& Save / Publish
Assign Workflow

& Cancel

OR

Select Save / Publish which will save and publish the content.
Actions

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Work Topic will be published in the Work Efforts
section of site.

Relating Content to Work Topics
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After the Work Topics content has been created and published, the Secretariat can relate

Activities to a Work Topic so site visitors can be informed of Activities pertaining to a specific
Work Topic.

To relate Activities to a Work Topic, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site

& gacdevO Site Browser

3. Select Work Topics - GAC from the Type dropdown list.

Observe  Site Browser Content

@ oscden0 Content Search Change Site [~

= Add New Content

Export X))
Qfficial
Date and
Thie URL Tithe Time Last Eater Last Ea% Date
Advanced ¢ = v GAC Secretanat 1
Figure 51: Navigating to the Content page within the Admin site will show all the Work Topics that have already been created.
4. Double click the Work Topics Title in the right pane to open the live editor interface for
the page.
Observe  Site lmmuvv fontm
& oscdev0 Content Search Change Site [~
+* A -
. = owing ) Export ‘:

Last £dit Date

Tithe URL Title Official Date and Time Last Ednor

NOTE: You can refine your search by doing the following:

e Selecting any of the column headings to sort ascending and
descending

AND / OR

e Enter additional data in the Search field on the left and click the Search
button
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5. After selecting the Work Topic that you would like to relate an Activity to, the editor will

be displayed. Lock the page for editing by clicking on Lock for Editing under the
Actions menu.

Observe  Site Browser Content
Cenerve Fazer

Tokdens & Fies Marage your Ste
Gicbal Page pacdev0 Contert Search Add/Edit Work Toplcs « GAC
Caontont History

Tithe:
Policy Development

Workflow

URL Tithe:
Step: Intial State
policy -Sevelopment

Assignes: Nobody
Yopic:
Actions Click Here to Select Categories
[ ) Lock for Edting ] N poe % pubiic Comment
v Ca

Description:
Filo* Edte Inset~ Vew~ Format «  Tools ~

Fomas+ B 7 ¥ & E X A B :=- -3 W W E &L 2 ¢~

6. Select the Click Here to Select Categories link.

Home Site Browser Content
Tosks B Deshdosd  Peges, Poiders B Fies  Marage your Ste
Guobal Page Jecoevd Conters Seanch AGd/EdIt Work Tophes - GAC

Content Mistory

&1 Work Topics - GAC
Tithe:
Mnghish (US) -

Alex Work Topic

Workflow
URL Tithe:
Step: Intial State
aex-work -10pK
Assignee: Nobody

Locked: GAC Secretariat Yopic:

IC":E Mere to Select Categories I

Actions
Description

d Save Fle> Edt~ Insert~ View~ Fomat~ Tools ~

& Save/ Putiie

forats~ B / U & E X A B - -2 A W E L &2 -
AsSQn Workfow

Nex's Test Work Topc

7. Add a Topic to the Work Topic content by selecting the green + next to the Topic name.
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Categories Q

Top Level >
Type Filter Here -, Search ¥y Clear Delete All
Name Key Variable Added

Accountability & accountabilityTr

+ | Accountability & Transparency
Transparency ansparency

Contracts & contractsAgree
+ Contracts & Agreements
Agreements ments
* Domain Names Domain Names domainNames
Formal ICANN |formallcannSt
Structures ctures
*  GAC Activities GAC Activities  gacActivities
* TLD m gTLD Programs gtldPrograms
* ICANN icannGovernanc
ICANN Governance
Governance e
+ ICANN Meetings ICANN Meetings icannMeetings

Other ICANN otherlcannStak

¢ Other ICANN Stakeholders
Stakeholders holders

Figure 52: Once the Topic has been added and the Categories pop-up is closed, the Topic will display in the editor under the
Topics title.

8. Select Cancel to negate adding the Topic the Work Topic content.
Actions

o' Release Lock

kd Save

& Save / Publish
Assign Workflow

& Cancel

OR

Select Save which will save the Topic to the Work Topic content and not publish it.
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Actions

o' Release Lock

d Save

& Save / Publish
Assign Workflow

4 Cancel

OR

Select Save / Publish which will save and publish the Topic to the Work Topic content.
Actions

o' Release Lock

d Save

I & Save / Publish

Assign Workflow

4 Cancel

9. Select Activity - GAC from the Type dropdown list.

Home Site Browser Content
Tawks & Dosbbcare  Pages, Folders & Fles  Manage your Ste
& oscden0 Content Search Change Site |-
# Add New Content ~
Type showing 1-38 of 38 Export %)
Official
Search Cache Privacy  Actheity Astivity Oate and
Inie LU ALY Setting  Lead Status Time Discwssion Archive Subscribe To Ust
®  W(e_us) Alex's Test ahex - test 0 st Alex actrve sYya?
\ Search +  §§ Oeor Search Activity activity 9 A5AM
® Mo us) GAL Barty gac-earty- 0 P ™o Active WIN3
Advanced Warrings ~amings £ 05PN

Figure 53: Navigating to the Content page within the Admin site will show all the Activities that have already been created.

10.Double click the Activity Title in the right pane to open the live editor interface for the

Home Site Browser Content
Taks & Dostbcare  Pages, Folders & Fles  Manage your Ste
& oscden0 Content Search Change Site (v
+ Add New Content  ~
Type: | acenmy - GAQ = showing 1-38 of 38 Export %)
Officiad
Search Cache  Privecy  Activity Astivity Oate and
Tnie LU . Setting  Lead Status Time Ouscwssnan Archive Subscribe To Ust
®  N(e_us) Alex's Test shex s test 0 pune Alex Active yya?
\ Search ~ €4 Cear Searcth Actity activity P 45AM
® M us) GAL Rarty Fac-earty- 0 pubic ™o Active
Advanced Warrings wamings £ 0SeM
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NOTE: You can refine your search by doing the following:

e Selecting any of the column headings to sort ascending and
descending

AND / OR

e Enter additional data in the Search field on the left and click the Search
button

11. After selecting the Activity that you would like to relate to a Work Topic, the editor will be
displayed. Lock the page for editing by clicking on Lock for Editing under the Actions

menu.
f‘w' s". Browser Content

ASd/ Edit Activity - GAC

Advanced Properties Mistory

™ Activity - GAC

Tithe:
M tngish (US -
A Activity
Workflow
Url:
Step: Intial State
Assignee: Nobody
Yopic:
Actions
Qiick Here to Select Categorie
R GAC Activities
& Cance

12.Select the Click Here to Select Categories link.

Home Site Browser Comtent
eks & Casndoad  Pages, Foders & Fles  Marage v

Gicbal Page secsevd Contert: Search Add/Edit Activity - GAC

Advanced Progerties  History

* Activity - GAC

Title:
W Engiish (US -
Ae A
Workflow
url
Step: Inual State
alex-$ Y
Assignee: N
Locked: GAC Secretanat
Topic:
[l ok Here >eiect Cotegories
Actions
Privacy Setting:
= ¢
.0
» S
A ~
Activity Lead:
¥
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13.Add the same Topic to the Activity content that was added to the Work Topic content by
selecting the green + next to the Topic name.

Categories
Top Level >
Type Filter Here 4, Search | &y Clear
Name Key _
- Accountability &
+ | Accountability & Transparen
parency Transparency
Contracts &
¢ Contracts & Agreements
Agreements
* Domain Names Domain Names
* GAC Activities GAC Activities
* TLD rams gTLD Programs
* ICANN
ICANN Governance
Governance

ICANN Meetings

® ICANN Meetings

Other ICANN
Stakeholders

v her holder:

Variable

accountabilityTr
ansparency

contractsAgree
ments

domainNames

formallca .
ctures

gacActivities
gtidPrograms

icannGovernanc
e

icannMeetings

otherlcannStak
holders

Delete All

Added

(X

Figure 54: Once the Topic has been added and the Categories pop-up is closed, the Topic will display in the editor under the

Topics title.

NOTE: If the same Topic is not added to both the Work Topic and Activity content, the
Activity content will not be related to the Work Topic content.

14.Select Cancel to negate adding the Topic the Activity content.

Actions

o' Release Lock
kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will save the Topic to the Activity content and not publish it.
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Actions

Release Lock

Save

& Save / Publish
Assign Workflow

& Cancel

OR

Select Save / Publish which will save and publish the Topic to the Activity content.
Actions

Release Lock

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Activity will be related to the Work Topic and
display on the Work Topics page in the Work Efforts section.

Updating Work Topics
To update Work Topics content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site

& gacdevO Site Browser

3. Select Work Topics - GAC from the Type dropdown list.
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Observe  Site Browser Content

& oscdev0 Centent Search

Change Site -

o+ Add New Content =

Export X)
Qfficial
Date and
Thie URL Tithe Time Last Eater Last Ea% Date
— ~ - * Wi s Test WY 171h Jas 122t M
Advanced * s f e o £ 45AM GAL Secretanat .
Figure 55: Navigating to the Content page within the Admin site will show all the Work Topics that have already been created.
4. Double click the Work Topics Title in the right pane to open the live editor interface for
the page.
M Site Browser C‘mtm
& oscdev0 Content Search Change Site [~
+ Add New Content ~
, = owing ( ) Export )
N Tithe URL Titke Official Date and Time Last Ednor Last (it Cate
Advanced e W N narw AM o

NOTE: You can refine your search by doing the following:

e Selecting any of the column headings to sort ascending and
descending
AND / OR
[ ]

Enter additional data in the Search field on the left and click the Search
button

5. After selecting the Work Topic that you would like to modify, the editor will be displayed.
Lock the page for editing by clicking on Lock for Editing under the Actions menu.
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Observe  Site Browser Content

Ctnerve Pages, fokders & Fles  Manage your Ste

w Gobal Page pacdevO Contertt Search Add/Edit Work Topics « GAC

Content Hstory

£ Work Topics - GAC
Tithe:
W English (US) .
Policy Development

URL Tithe:

Step: tal State
— policy -development

Assignes: Nobody
Yopie:
Actions Click Here to Select Categories
[ A Lotk for Eduing l % poe  ® pubiic Comment
& Cancel
Description:

Flo» Edt~ Wnset~ View~ Format~ Toos =
Fomats+ B 7 ¥ § E X A B - -3 3 & B &L &2 -~

6. Modify any of the following fields:
a. Title
b. Topic
c. Description
d. Official Date and Time

Observe  Site Browser Content
Oteerve Pagen, Foiders & fies  Marage your Ste
 Glodel Page Qecdevd Cortent Search Add/Ean Work Topics - GAC

Content History

£ Work Topics - GAC

Title:
W Dnghsh (US) -
Policy Development
Workfow
URL Title:
Step: [ntial State
e polcy-development
Assignee: Nobody
Locked: GAC Secretarat Topic:
o Qlick Mere to Select Categories
cthons % p0p| ® pubic Comment

o Release Lock

o Seve Description:
& Save / Publish Fle~ Edt~ Inset~ View~ Format~ Tools ~
Assign Workfow fomas~ B / M S E X 3 B -iE-0 3 W & &£ @2 v~
& Cancel
| |
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Observe  Site Browser Content

Oteerve Pogen, Foiders & files  Macage your Ste

Giotel Page Qectevd Cortent Search A4S/ BER Weork Topics « GAC

Content History

. Work Topics - GAC

Wi Engish (US) -

Workfiow
Step: Initial State
Assignee: Nobody
Locked: GAC Secretanat

Actions

£ Relesse Lock

ey Save
& Save [ Pubinh
Assign Workfow
& Cancel P %
wvs:wvcl - Language Variables

Offickal Date and Time:

12/2/2016 * 12:00M | -

7. Once modifications have been made, you can either select Cancel to negate the edits.

Actions

o' Release Lock
kd Save
& Save / Publish

Assign Workflow

4 Cancel

OR

Select Save which will save the edits and not publish them.
Actions

o' Release Lock

kd Save

& Save / Publish
Assign Workflow

4 Cancel
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OR

Select Save / Publish which will save and publish the edits.
Actions

Release Lock

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Work Topic will be published in the Work Efforts
section of site.

Activities

The Activities content type is an action taking place pertaining to a topic and provides site
visitors a comprehensive understanding of all the information that makes up an Activity. A
relationship can be established between an Activity, Activity Update, Advice, Correspondence

Incoming, Correspondence Outgoing, Sessions and File Assets so there is a comprehensive
view of all related actions and artifacts pertaining to an Activity.

The following screenshot illustrates the contents of the Activities Index:

Work Topics  Activities =~ GAC Working Groups

WORK TOPICS = ACTIVITY STATUS : SEARCH ACTIVITIES :
/ [SELECT AWORK TOPIC :] / [sn:cusmws :] / ENTER KEYWORD Q
LATEST
ACTIVITY NAME ~ LEAD ¢ STATUS e UPDATE B
—
Draft survey to GAC Members from all around the world Julls Chanveien Ave B0

] ,T i

Note the following elements of the Activities Index:

e Work Topics Dropdown: Allows the user to filter the index by Work Topic
e Activity Status Dropdown: Allow the user to filter the index by Activity Status
e Search Activities: Search field that allows the user to search for Activities by keyword(s)
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Activity Name: Title specified on the Activity content

Activity Lead: Lead specified on the Activity content

Activity Status: Status specified on the Activity content
Activity Latest Update: Latest update on the Activity content

The following screenshot illustrates the contents of an Activity:

Work Topics  Activities GAC Working Groups

ransion B [ Sendfor Tonstation | f S

in ccNSO PDPs

Vijay Early GAC engagement

STATUS: On Hold | M Actiiy Sl

LtAD:CCNSOChaIr|<—— Activity Lead

Latest Updates

Background, Relevance & Goal
Related Meeting and Records
Related Correspondences
Outcomes & Outputs

Additional Resources

GENERATED ADVICE: I

RELATED TOPICS: T .

:. I

Vijay Early GAC engagement in ccNSO PDPs

Latest Update: December 01, 2016| PAST UPDATES % I

iContact information is usually submitted in local script(s) and language(s), which can make it difficult to contact a
registrant, e.g. for law enforcement or intellectual property rights holders. On the other hand, translation and
transliteration of gTLD contact information raises issues of cost, accuracy and effectiveness.

Background, Relevance & Goal

The GAC-GNSO Consultation Group on GAC Early Engagement in Policy Development Processes is a joint effort by
the GAC and the gNSO to explore ways of engaging the GAC early on in GNSO policy development activities,

mcxcaouuooocuu:ms:l<—&-w xground Documents N, iy

Related Meeting and Records

09:30- 14:30 UTC  Vijay_Public Session_31May1434_GNSO Standing
Committee for Improvements Implementation (SCI)

09:30-10:30 UTC  Meeting with the GNSO

ICANN |TYPE THE DOCUMENT TITLE | MONTH YEAR

| 237



Related Mailing List Discussions

DISCUSSION ARCHIVE
SUBSCRIBE TO LIST:
DISCUSSION ARCHIVE

SUBSCRIBE TO LIST

. Related Correspondence

Outcomes & Outputs

The expected outcome from the GNSO Meeting is to build robust policies.

The GAC has advised the Board to ensure the protection of IGO names and acronyms at the top and second levels
in successive communiques, stating that implementation of such protection is in the public interest given that
IGOs, as created by governments under international law, are objectively different right holders.

> Outputs of This Activity

Additional Resources

Note the following elements of an Activity:

Send for Translation Button: This element is the button will package the html page and
prepare it to be translated

Activity Title: This element is the title specified on the Activity content

Activity Status: This element is the status specified on the Activity content

Activity Lead: This element is the Lead specified on the Activity content

Anchor Links: This element is the link that will automatically navigate the user to the
section that corresponds with the selected link

Generated Advice: This element displays the Advice that was generated from the Activity
Related Topics: This element is the topics that have been tagged to the Activity

Latest Update: This element is the latest update on the Activity content

Past Updates Dropdown: This element allows the user to select past Activity updates
Background, Relevance & Goal: This element displays the Background, Relevance &
Goal specified on the Activity content

Background Documents: This element allows the user to relate a background document
to the Activity content

Related Meeting and Records: This element allows the user to relate meetings and
records to the Activity content

Related Mailing List Discussions: This element is the main section that displays
Discussion Archive and Subscribe To List

Discussion Archive: This element allows the user to specify a discussion archive
pertaining to the Activity
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e Subscribe To List: This element allows the user to specify a list where site visitors can
subscribe to follow the Activity

¢ Related Correspondence: This element is Correspondence that has been related to the
Activity content

e Outcomes & Outputs: This element allows the user to specify outcomes & outputs
related to the Activity content

e Outputs of This Activity: This element allows the user to attach outputs related to the
Activity content

o Additional Resources: This element allows the user to attach any additional resources
that are relevant to the Activity content

Creating Activities
To create Activities content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site
& gacdevO Site Browser

3. Select Activity - GAC from the Type dropdown list.

Observe  Site Browser Content
e - Y Moo

@ orctev Content Search Change She (v

Officiad

New Comtent
s St e

Cache Privacy Activity Activity Date and
Tivle "] I Settisg  Lead ety Time Discussion Archive

4 Clear Search

Advanced
Figure 56: Navigating to the Content page within the Admin site will show all the Activities that have already been created.

4. Select the Add New Content button on the top right.
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Observe  Site Browser Content
St ve apes, Folders & Fles  Marag
& 9¥00ev0 Content Search

showing 1-40 of 73

Search ~ &4 Chear Search

Advanced

5. Complete the following required fields:

-0 a0 oD

Title

URL Title (automatically created based upon the Title)

Privacy Setting (defaults to Private)
Activity Lead

Activity Status (defaults to Active)
Official Date and Time

Observe  Site Browser Conten
Ctasrve Pages, Folders & Flles  Masage your Sne
& 9¥dev0 Content Search Add/Edit Activity - GAC
Content Advanced Properties
Title:
* Activity - GAC
i Enghsh (US) -
url:
Workflow
Step: [nitlal State
Assignee: Nobod
- Topic:

Actions

rey Save
@ Seve [/ Pubins
Assign Workfiow

@ Cancel

6. Select Cancel to negate adding the content.

Qlick Here to Select Categories

Privacy Setting:
® Private
Pubiic

Activity Lead:

Activity Status:

Active -

Offickal Date and Time:

ICANN |TYPE THE DOCUMENT TITLE | MONTH YEAR

Change She |v|
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Export %)
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Actions

kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will save the content and not publish it.
Actions

kd Save

& Save / Publish
Assign Workflow

& Cancel

OR

Select Save / Publish which will save and publish the content.
Actions

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Activity will be published in the Work Efforts
section of site.

Relating Content to an Activity
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After the Activity content has been created and published, the Secretariat can relate File
Assets, Sessions, Correspondence Incoming and Correspondence Outgoing, to an Activity so
information from the related content displays in the Activity. In addition, the Secretariat can
relate Document Sections to various sections of the Activity which will allow them to add a free-
form section that they can used to add documentation / information as needed.

RELATING NEW CONTENT TO AN ACTIVITY

To relate new Activity Updates, File Assets, Sessions, Correspondence Incoming,
Correspondence Outgoing and Document Sections to an Activity, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Site Browser tab from the top navigation.

Site Browser
Pages, Folders & Files

Content
Manage your Site

Figure 34: Navigating to the Site Browser page within the Admin site will show all the editable pages that you are able to modify.

3. On the Site Browser page, within the left pane, click on the activity folder.

Site Browser Contemt
@ oscdev Site Browser

Sites and Folders

g e

o

o

= advice

agerdas
sopheation
briefs
COMment-gererc-migraned
e asset
home

images

larguege mansyed servies
Larguage-managed-uery
e

meetng services

meetngs-records

Change Site [~

A = + Add New
Nome Meny  Status Mod. Vser Med, Dme
privat
P
T GAC-tecology tase force 1 - = A P,
" GAC techeciogy task force 4 - 9 | > Ax -
¥  GAC-techrciogy-task-forcet - B (01 PT) Implementar nove $e 00 GAC  Asshay -
¥ GAC-sechrciogy-task-forcet - - ~
" GAC-oechnclogy-task-force-t - - e = -
T GaC-tetvology-tase force 1 B I= (es_15) Implementacén del Nueve S...  Acshay Y
" GAC-techeciogy task force - W (en_US) Implement New GAC Website Amt Mot 02/34/2017 11:02:22 P
¥ gec-wetate-ntroduction vl - - "
¥ GAC-tachrciogy-task-force - . (e -
T Erat-survey-10-gac-members. - B (0n_US) Draft survey v e -
~es . W (on_US) Work Eforts Amit Mitta 1/01/2016 05:13:29 PM

T eerty marning ducussons - " (e 5) Darty Wa

Figure 57: Clicking the activity folder in the left pane will show the folders contents in the right pane. Notice that it includes a list

of Activities.

4. Double click the Activity Name in the right pane to open the live editor interface for the

page.
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Site Browser Contemt
Page

u, Folders & Fles  Manage your Ste

@ oscdev0 Site Browser

Sites and Folders

. fre asset

& heme

8 mages
o

Moetng services

s mestings-records

(AR -

private

D

T GAC-techeciogy-tase force 1

GACtecheciogy task force 1.

GAC-sachnciogy-1ask-force-t
GAC - Ohogy-Lase -force-t

GAC -t ology-tase - force 1

™ GACtecheciogy task force ...

Fec-wetate-rroduction i
¥ GAC-techeciogy-task-force-t
ST -BIVEY G- MemDers.
~des

carty marning Sncuasons

GAC-techeclogy-task-force-t..

Status

B (a

SA) s g Wi GAC wed

BROV_FR) Mige en aeovre du nowvesy o

B (0UPT) mplementar nove site 00 GAC

(P RU) Beetpowme woecrs seb-cadva GAC

B (:h_ON) MR GAC N3

I= (es_I5) Implementacdn del Nueve S

W (0n_US) Implement New GAC Website

W (o

L 10

. (o

. (o

W (o

US) GAC Website [noroduction V/
US) Estabinh Techaclogy Task P
US) Draft survey 2o GAC Memers.
US) Work Eforts

US) Barty Warning Discussions

Mot Wser

Ame Mt

Vijay Phake

Jeft Salern

At Mttal

Amit Mittal

Soeve Nbgon

Change Site |+

& Add New ~

Med, Date

Figure 58: Double clicking the Activity Name from the right pane will open the page in its Live Editor which allows the Secretariat

to modify the contents of this page.

NOTE: You can sort the Activity Name column (ascending or descending) by clicking on

the column heading.

Preview Live

(4 Lock for Editing

@& Publish Page

= Remote Publish Page

¥ Add To Bundle

6. Select the Add Content button on the page.
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Eox | Preview | Uve

£ Releawe Lock

B aveoe v s

3¢ To Bundie
A Werkion Implement New GAC Website

STATUS: Active

@ Pege Propwties LEAD: GAC Technology Task Force to Create
New GAC Website

Poge Stansncs

rdt Terrpiate
Latest Updates

5% Create New Page
Background, Relevance & Goal
Viewng as Related Meeting and Records
Related Correspondences
Outcomes & Outputs
Additional Resowrces
Detakt Visnor -

GENERATED ADWVICE

RELATED TOPICS:

Domain Names

Wy Enghsh (US)

& Admin Screen

Work Topics

Activities  GAC Working Groups

Implement New GAC Website

Background, Relevance & Goal

As ICANN matures as a community, there is a need to improve the processes and tools that support the various
organizations that participate in the community. To this end, the GAC Website represents an opportunity to:

create a website that has greater flexibility in the creation and management of content; and
better align with the wary the GAC performs its daily functions,

The following background documents provide the initial research that this Technology Task Force is using to drive
the creative process of developing a more new GAC website that will meet our future expectations.

DACKGROUND DOCUMEINTS:

Related Meeting and Records

Related Mailing List Discussions

DISCUSSI0N ARCHIVE:

SURSCRIDE TO LIST:

7. Select New Content from the Add Content dropdown.

=T~

of melease L

@ Putinh Page

sk

L i Asd Content

B 201 Yo bundie o —
Rasicn Workfiow Implement New GAC Website
STATUS: Active
Page Properties LEAD: GAC Technology Task Force 1o Create
New GAC Website

Page Statistics

£on Template

Latest Updates

5 Creste New Page
Background, Relevance & Goal
Viewing aa Related Meeting and Records
Related Correspondences
Outcomes & Outputs

Additional Resources

DU Vs GENERATID ADVICE:

RELATED TOPICS:

DRomain Names

W Engish (US)

@ Asrmin Screen

Work Topics

Activities GAC Working Groups

& Ade Content

Implement New GAC Website =l

€ A0 wepnt

N 2t reew

Background, Relevance & Goal

As ICANN matures as a community, there Is a need to improve the processes and tools that support the various
organizations that participate in the community, To this end, the GAC Websi an ity 10

L L

creste a website that has greater flexibility in the creation and management of comtent; and
better align with the wary the GAC performs its daily functions.

The following background documents provide the initial research that this Technology Task Force is using to drive
the creative process of developing a more new GAC website that will meet our future expectations.

§ 4 Add Contert

DACKGROUND DOCUMENTS:

& Ads Content

Related Meeting and Records

Related Mailing List Discussions

DISCUSSION ARCHIVE
SUBSCRIBE TO LIST:
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8. An Add New Content pop-up will display allowing you to add content to sections. The
following content can be added to the following sections:
a. Generated Advice section
i. Advice content
b. Activity Update section
i. Activity Update content
c. Background Documents section
i. File Asset content
d. Related Meetings and Records section
i. Sessions content
e. Related Correspondence section
i. Correspondence Incoming content
ii. Correspondence Outgoing content
f. Outcomes and Outputs section
i. Document Section
g. Outputs of This Activity section
i. File Asset content
h. Additional Resources section
i. File Asset content
ii. Document Section

9. Select the content type you would like to add to the Activity.
10. Complete the required fields (headings in red) for the content type selected.
a. Advice
i. Title
i. URL Title (automatically created based upon the Title)
iii. Privacy Setting (defaults to Private)
iv. Consensus Setting (defaults to Consensus)
v. Official Date and Time
vi. Advice Statement
vii. Rationale
viii. Reference Number
b. Activity Update
i. Title
i. Body
iii. Official Date and Time
c. File Asset
i. Title
ii. File Asset
d. Session
i. Title
i. URL Title (automatically created based upon the Title)
iii. Type (defaults to GAC Meeting)
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iv. Status (defaults to Open)
v. Privacy Setting (defaults to Private)
vi. Time Zone (defaults to UTC+00:00 — Coordinated Universal Time (UTC))
vii. Official Date and Time
e. Correspondence Incoming
i. Title
ii. Correspondence File
iii. Privacy Setting (defaults to Private)
iv. Received
v. From
vi. To
vii. Official Date and Time
f. Correspondence Outgoing
i. Title
ii. Official Date and Time
iii. Privacy Setting (defaults to Private)
iv. From
v. To
g. Document Section: This content does not have required fields however, the Title
and Body must be completed so the Document Section added has a Title and
support text (Body)

11.Select Cancel to negate adding the content.

Actions

kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will save the content and not publish it.
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Actions

kd Save

& Save / Publish
Assign Workflow

& Cancel

OR

Select Save / Publish which will save and publish the content.
Actions

kd Save

& Save / Publish

Assign Workflow

& Cancel
NOTE:
e Once Save / Publish is selected, the Activity will be published in the Work Efforts section
of site.

e Selecting Session, Advice, Incoming Correspondence or Outgoing Correspondence will
create a piece of content that is attached to an Activity but is also independently
accessible and will display in their respective site sections.

e Selecting Document Section, Activity Update or File Asset will create content in the
Activity, not an independently accessible piece of content.

RELATING EXISTING CONTENT TO AN ACTIVITY
To relate existing Activity Updates, File Assets, Sessions, Correspondence Incoming,
Correspondence Outgoing and Document Sections to an Activity, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Site Browser tab from the top navigation.

Site Browser Content
Pages, Folders & Files Manage your Site
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Figure 34: Navigating to the Site Browser page within the Admin site will show all the editable pages that you are able to modify.

3. On the Site Browser page, within the left pane, click on the activity folder.

Site Browser Content
@ rctev0 Site Browser Change Sie |~
Sites and Folders W Engish (US) - o+ Add New =
9 oscdevd Name Meny  Status Med, User Mok, Date
" aveut prvane
x prvene *  GAC-technclogy-task-force-t . W (en_US) Implement New GAC Webshe Arvit My U7 1102102
putic TG-St rSAKTON -V L S (on_US) GAC Webalte Istroduction Vi Vijry Pralee o2/0 /207 6:23 ™
Figure 59: Clicking the activity folder in the left pane will show the folders contents in the right pane. Notice that it includes a list
of Activities.

4. Double click the Activity Name in the right pane to open the live editor interface for the

Site Browser Content
Pages, Facers & Fles  Marage your Sie
& oscden0 Site Browser Change Site |~
Sites and Folders ™ English (US) - & ASd New ~
9 gacdevd Neme Meny  Status Mod User Med, Date
aveut privie
1 activity PudsC
prvate ¥ GACtechnoiogy-task-force-L - L O Arns M 32 P
Pubic " gac-webare- ntroduction-vi *A Wi wy e
saven T GACsecrnoiogy-task-4orve-t - (e -
pendas
T erat-survey-Lo-gac-members. B o (on_US Ami M
azpiCalion
¥ ndex . ™ (o Work [ Amiz M 6 329 P
Briefy
CONtene-genenc-mQrated " earty-maming-dacussions - ™ (e [: * g Dis ve Al 4035 M

Figure 60: Double clicking the Activity Name from the right pane will open the page in its Live Editor which allows the Secretariat
to modify the contents of this page.

NOTE: You can sort the Activity Name column (ascending or descending) by clicking on
the column heading.

5. From the live editor mode, first lock the page for editing.

Preview Live

{4, Lock for Editing

@ Publish Page
=2 Remote Publish Page
& Add To Bundle

6. Select the Add Content button on the page.
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Bax § Preview | Uwe

£ Relesse Lock
W e Page

B A% To Bundie

Implement New GAC Website

Assgn WirsSow
STATUS: Active
& Page Proparties LEAD: GAC Technology Task Force to Create
New GAC Website

A Peoe Sunsncs

Cdt Terrplate
Latest Updates

% Creats New Page

Background, Relevance & Goal

Viewng as Related Meeting and Records
Related Correspondences
Outcomes & Outputs
Additional Resowrces
ke 2 GENERATED ADVICE
W Enghsh (US) - RELATED TOPICS:

Domain Names

@ AdTun Screen

Work Topics

Activities  GAC Working Groups

=

Implement New GAC Website

Background, Relevance & Goal

,
:

As ICANN matures as a community, there is a need to improve the processes and tools that support the various
organizations that participate in the community. To this end, the GAC Website represents an opportunity to:

create 3 website that has greater flexibility in the creation and management of content; and
better align with the wary the GAC performs its daily functions.

The following background documents provide the initial research that this Technology Task Force is using to drive
the creative process of developing a more new GAC website that will meet our future expectations.

i | 4 Acd Content

:

DACKGROUND DOCUMEINTS:

Related Meeting and Records

Related Mailing List Discussions

DISCUSSI0N ARCHIVE

SURSCRIDE TO LIST:

7. Select Reuse Content from the Add Content dropdown.

.(almlw.

Reloase Lock

@ e
[

A Peoe Statmca
Eot Tempuate

Latest Updates

T Create New Page

Background, Relevance & Goal
Viewiny) as: Related Meeting and Records
Related Correspondences
Outcomes & Outputs
Additional Resowrces
GENERATED ADVICE

W Englad (US) = RELATED TOPICS:

Domain Names

& AGTen Soreen

Work Topics

h Page
L o Asd Cortent
Implement New GAC Website
STATUS: Active
& Py Mrepetes LEAD: GAC Technology Task Force to Create
New GAC Website

Activities  GAC Working Groups

L o Asd Cortent

® o Conon

Implement New GAC Website

Background, Relevance & Goal

As ICANN matures as a community, there Is a need to improve the processes and tools that support the varlous
organizations that participate in the community, To this end, the GAC Website repeesents an opportunity to;

create a website that has greater flexibility in the creation and management of content; and
better align with the way the GAC performs its daily functions.

The following background documents provide the initial research that this Technology Task Force Is using to drive
the creative process of developing a moee new GAC website that will meet cur future expectations,
L i Asd Cortent

BACKGROUND DOCUMENTS:

i o Asd Cortent

Related Meeting and Records

8. A Reuse Content pop-up will display allowing you to add content to sections. The
following content can be added to the following sections:

a. Generated Advice section
i. Advice content
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b. Activity Update section
i. Activity Update content
c. Background Documents section
i. File Asset content
d. Related Meetings and Records section
i. Sessions content
e. Related Correspondence section
i. Correspondence Incoming content
ii. Correspondence Outgoing content
f. Outcomes and Outputs section
i. Document Section
g. Outputs of This Activity section
i. File Asset content
h. Additional Resources section
i. File Asset content
ii. Document Section

NOTE: The Search pop-up allows you to refine your search by specifying additional search
criteria. Search criteria differs based upon the content type being searched.

9. Select the Search button at the bottom of the Search pop-up to execute your search or
select the Clear Search button to clear your search criteria.

Search: Activity Update - GAC
Content Type: Activity Update - GAC
Language [ A [+]

Title:

Body:

I . Search I I @ Clear Search ]

Figure 61: You can refine your search by entering additional criteria in the Search pop-up and then selecting the Search button.

10.Once the search results display, click the Select button to select the content you would
like to reuse.

ICANN |TYPE THE DOCUMENT TITLE | MONTH YEAR | 250



Search: Activity Update - GAC

hi I
Content Type: Activity Update - GAC Matching Results (19)

Official Date
. sy Language Title
Language Al = and Time
1
« TTF Rev 121/
Wl English (US) lt}cs.r;n New GAC Website - TTF Reviews Work 4/21/2016
Title: Efforts and Advice Registry 12:00AM
S site - W fforts 4/19/ 5
SELECT - English (US) Design New GAC Website - Work Effo /19/2016
Body: Wireframes Delivered 12:00AM
b - 0 C 4/5/
SELECT W English (US) Des.?n New [(J;Alc Website - Correspondence v,fczﬂif
L Search & Clear Search Wireframes Delivered 12:00
SELECT % English (US) Design New GAC Website - Advice and Groups 2/16/2016
Wireframes Delivered 12:00AM

Figure 62: Once the content you would like to reuse has been selected, it is attached to the Activity and you will be automatically
navigated back to the content editor.

NOTE: Once Save / Publish is selected, the Activity will be published in the Work Efforts
section of site.

Updating Activities
To update Activity content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Site Browser tab from the top navigation.

Site Browser Content
Pages, Folders & Files Manage your Site

Figure 34: Navigating to the Site Browser page within the Admin site will show all the editable pages that you are able to modify.

3. On the Site Browser page, within the left pane, click on the activity folder.

Site Browser Comtant
Poges, Poders B Fies  Marage your Ste
& 9200 Site Browser Change Site |~
Sites and Folders W Engish (US) - & Add New =
~9 gacdevd Name Meny  States Med, User Mok, Date
" ot privane
- prvene ¥ GAC-technclogy-2ask-force-t. . W (en_US) Implement New GAC Wetsne Arvot st QAUNT 1102132 MM

publc " G- weDStE-NESAKTON v ® i WM (o _US) GAC Webae Jatroduction V oy P 0270772017 11:16:28 P4

Figure 63: Clicking the activity folder in the left pane will show the folders contents in the right pane. Notice that it includes a list
of Activities.

4. Double click the Activity Name in the right pane to open the live editor interface for the
page.
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Site Browser Content
Pages, Fucers & Fles  Manage your Ste
& oscden0 Site Browser Change Site |~
Sites and Folders W English (US) - & ASd New ~
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Figure 64: Double clicking the Activity Name from the right pane will open the page in its Live Editor which allows the Secretariat
to modify the contents of this page.

NOTE: You can sort the Activity Name column (ascending or descending) by clicking on
the column heading.

5. Select Page Properties to access the content backend so the content properties can be
modified.

Preview Live

4 Lock for Editing
@& Publish Page
" 4 Remote Publish Page
" ]

Add To Bundle

%.‘

What's Changed?

4 Page Properties

Page Statistics

e Create New Page

6. After clicking Page Properties, the editor will be displayed. Lock the page for editing by
clicking on Lock for Editing under the Actions menu.

Actions

2 Lock for Editing

& Cancel

7. Modify any of the following fields:
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Title

Topic

Privacy Setting
Activity Lead

Activity Status
Official Date and Time
Discussion Archive
Subscribe To List
Discussion Archive I
Subscribe To List Il
Create Notification

AT T SQ@ 00000

Observe  Site Browser Comtent
- s, Pokers & 7 Maraze
Gode Page oeitevs She Broeser AG/ 1R Aty - GAC

Content Agvanced Properties History

Tithe:
» Activity - GAC

Implement New GAC Website

WEngish (US)

urh
Workfow

GAC technoiogy Lk fOrce- Lo Create- few-OaC websRe-mple
Step: 1nmal State

Assignee ooy
Locked: GAC Secretarist

Topic

o ere S Select Categocies

B Doms Namses

Actions
Reloase Lotk Privacy Setting:
o Seve Private
& Pubic
@ Seve/
Assign Workfiow
Adtivity Lead)
& Carcel
GAC Technology Task Force 10 Create New GAC Website
Activity Status:
Active
Official Date and Time:
07 * 1200AM |-
L] |
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Observe  Sie Browser Costent
o Pages, Folens & Fies  Manage your Sae
Gose Page gacoevd Sne Drowser Add/ Bt Activity - GAC

Contect Advanced Properties Mistery

= Activity - GAC Activity Lead:
Wingwh (US) - GALC Technology Task Force to Create New GAC Wedalte
Workfom Activity Statwsi
Active -

Step: 1amal State
Assignee: Nosody

Locked: GAC Secretariat

Official Date and Time:

017 - 1200AM | =
Actions
Discussion Archive:
{ Rewsse
- 5
@ Save/ Punies Subscribe To List:
Assign Workfiow
& Carcel

Oiscussion Archive BT

Subscribe To List II:

Create Notification:

. o

8. Once the edits have been made, you can either select Cancel to negate the edits

Actions

i’ Release Lock
kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will save the edits and not publish them
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Actions

Release Lock

ke Save

& Save / Publish
Assign Workflow

& Cancel

OR
Select Save / Publish which will save and publish the edits

Actions

Release Lock

ke Save

@ Save/ Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Activity will be published in the Work Efforts
section of the site.

Activity Update

The Activity Update content type allows the Secretariat to provide an update of the most recent
work that has taken place on an Activity. An Activity Update can be related to an Activity so
when the Activity is viewed the latest update displays.

NOTE: When referencing an attachment on the Activity, specify where the attachment can be
located on the Activity Detail page.

The following screenshot illustrates the contents of an Activity Status:
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Work Topics  Activities =~ GAC Working Groups

Send for Transtation Establish Technology Task Force

Establish Technology Task

FOI’CQ Activity Update =g
STATUS: Completed

/,_,[Latest Update: June 30, 2015| PAST UPDATES ¥

Latest Update Date ="

LEAD: GAC TTF
Past Updates Dropdown
he TTF has drafted the first version of the Terms of Reference for the group.] e iy Updiate Tout
Latest Updates ctivity J
Background, Relevance & Goal Background, Relevance & Goal
Related Meeting and Records The purpose of this activity is to establish the Technology Task Force whose goal is to create a new GAC website to

meet their future needs. In order to complete this activity, the following goals will be met:
Related Correspondences

Creation of the Working Group
Outcomes & Outputs Establish Chair/Co-Chair
Call for Volunteers
Additional Resources Form Member List
GEMERATED ADVICE: Develop WG Mailing List
) Schedule First Meeting
Publish Minutes of First Meeting
RELATED TOPICS: Create Activity to Draft Terms of Reference

BACKGROUND DOCUMENTS:

Note the following elements of the Activity Update:

e Latest Update Date: This element is the Official Date specified on the Activity Update
content

e Past Updates Dropdown: This element allows the user to select past Activity Updates
that have been published

e Activity Update Text: This element is detail of the Activity Update specified on the Activity
Update content

Creating an Activity Update
To create new Activity Update content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site

& gacdevO Site Browser

3. Select Activity Update - GAC from the Type dropdown list.
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Observe  Site Browser Content

Ctasve Pages, Pk & F ey

.OXM Content Search

Marage prs Ste

Type: | Activity Update - GAC -

Search

4 Search ~

Advanced

4 Clear Search

showing 1-19 of 19

Titse
W (en_us) Design New GAC Webwte - TTT Reviews Work Efforts and Advice
Ragiury
W (en_us) Design New GAC Website « Weork EMorts Wireframes Delvered
N (en_us) Design New GAC Website - Cormespondence Wireframes Delvered

A/19/2016 12:00AM

AV016 17:00AM

Corinna Ace

Conena Ace

Carinng Ace

Change Site [~
+ Add New Content ~

Export )

1/2/2016 11420

10516 1141

Figure 65: Navigating to the Content page within the Admin site will show all the Activity Updates that have already been created.

4. Select the Add New Content button on the top right.

Observe  Site Browser Content

Ctas e Pages, Fokders & Fies

W 9rse0 Content Search

Marage pres Ste

Type:  Activity Update - GAC | »

Search

4 Search ~

Advanced

4 Clear Search

showing 1-19 of 19

Titse
W (en_uS) Denign New GAC Webute - TTT Reviews Work Efforts and Advice
Ragistry
W (en_us) Design New GAC Webste - Work Eforts Wireframes Delvered
S (en_us) Design New GAC Website - Cormespondence Wireframes Delvered

5. Complete the following required fields:

a. Title
b. Body

c. Official Date and Time

Observe  Site Browser

Ctasmve Pages, Folders & Fies
& 9¥0e0 Content Search
Content

%1 Activity Update - GAC

W Englsh (US) v

Workfiow

Steps [nvtial State
Assignee: Nobody

Actions
o Seve
@ Sove/ Pubinn
Assign Work®ow

& Cancel

Content

Marage yiur Sne

Add/Edit Activity Update - GAC

Corinna Ace

Conena Ace

Carinna Ace

Title:
Body:

Fle~ Edt~ Ikmset~ View~ Fomat~ Tools ~

fomats~ B / U4 S E X A B =S-E-3 A W & L 2 v~

Change Sie (|

4 Add New Comtant =

Export )

Last £dn Date

12/2/2016 11:439M

12/2/2016 11420

2056 11410

Crange She [+
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Observe  Site Browser Content

Ctasrve Pages, Folders & Flles  Masage v
& ov00ev0 Content Search Add/Edit Activity Update - GAC
Content

. Activity Update - GAC
i Engish (US) -
Workfow
Stepe [nitial State
Assignee: Nobody
Actions

i Sove
& Save [ Publish
Assign Workfow

& Cancel

P

wv-,:wv(,‘; - Language Varables

Official Date and Time:

6. Select Cancel to negate adding the content.

Actions

kd Save
& Save / Publish

Assign Workflow

¢ Cancel

OR

Select Save which will save the content and not publish it.

Actions

kd Save

& Save / Publish
Assign Workflow

¢ Cancel
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OR

Select Save / Publish which will save and publish the content.
Actions

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Activity Update will need to be related to the
Activity it pertains to so it is visible on the Activity in the Work Efforts section.

Updating Activity Updates

To update Activity Update content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site
& gacdevO Site Browser

3. Select Activity Update - GAC from the Type dropdown list.

[T Content Search Change Ste |~

Official Date and
Tithe Time Last E@ter Last €071 Date

earch ~ &y Clear Search
®  Wien us

Advanced - . (en_uS

Figure 66: Navigating to the Content page within the Admin site will show all the Activity Updates that have already been created.

4. Double click the Activity Update Name in the right pane to open the live editor interface
for the page.

e —— —
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Observe  Site Browser Content
Poges, Folders & Fles  Marage

@ 9c0ne Contant Search Change She [+
o+ Add New Comtent =
T Py Py - showing 19 Export X))
Official Date and
Tnie Time Last Eoner Last £di Date
e n Cegn A 4 SAM A 6 11:430M
P
, Search + ¥4 Oecar Search
. - or 4 L 6 1142
Advanced « N o 4 N2/I016 11419
. = vere AM =

NOTE: You can refine your search by doing the following:

e Selecting any of the column headings to sort ascending and
descending

AND / OR

e Enter additional data in the Search field on the left and click the Search
button

5. After selecting the Activity Update that you would like to modify, the editor will be

displayed. Lock the page for editing by clicking on Lock for Editing under the Actions
menu.

Observe  Site Browser Content
seerve ogen, Foiders & files  Masage your Ste
Page gectievd Cortent Search Add/EaR Activity Update - GAC

Content  History  Referances

& Activity Update - GAC

Tithe:
W Enghsh (US
E gy Ta Activity to Draft Terms of |
Workfow
Body:
Step: [nitial State
Assignee: Nobody File » Edt ~ sert v View > Format ~ Tools ~
foonas~ | B 7 U & |E X A B |E-E-3 A 8 B | &L 2|V~
Actions
The TTF has deafied the first version of the Yerms of Radarences for the group.
[& oo or ean
-

6. Modify any of the following fields:
a. Title
b. Body
c. Official Date and Time
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Observe  Site Browser Content
Ctasmve Pages, Folders & Flles  Masage your e

@ 9vtev0 Content Search Add/Edit Activity Update - GAC Crange She ()

Content

£, Activity Update - GAC

Wi Enghsh (US) -

Workfiow Body:
Step: [nitial State Fle> Edt~ Iset~ View~ Fomat~ Tools ~

Assignee: Nobady fooats~ B /7 U S E E A B E-E-3 3 W E L @2 -~

Actions

o Seve
@ Sove / Pubinn

Assign Work®ow

& Cancel

Observe  Site Browser Content
Ctamve Pages, Folders & Files  Masage your e

@ 9vtev0 Costent Search Add/Edit Activity Update - GAC Crange She ()

Content

£, Activity Update - GAC

. Enghsh (US) -

Workfiow

Step: [nitial State
Assignee: Nobody
Actions

i Sove

& Save [ Publish
Assign Workfow

& Cancel

P Words: 0

WV’S:WYGi - Language Variables:

Date and Time:

12.0nce modifications have been made, you can either select Cancel to negate the edits.

e — —
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Actions

o' Release Lock
kd Save
& Save / Publish

Assign Workflow

I & Cancel

OR

Select Save which will save the edits and not publish them.

Actions

Release Lock

Save

& Save / Publish
Assign Workflow

& Cancel

OR

Select Save / Publish which will save and publish the edits.

Actions

Release Lock

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Activity Update will need to be related to the
Activity it pertains to so it is visible on the Activity in the Work Efforts section.

GAC Working Groups

The GAC Working Groups content type allows the Secretariat to create a group that is tasked
with conducting work based upon their Terms of Reference. The work that is conducted by the
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Working Groups are Activities that are assigned to the Working Groups. A relationship can be
established between a Working Group, Activity, Sessions and File Assets so there is a
comprehensive view of all related actions and artifacts associated to a Working Group.

The following screenshot illustrates the contents of the Working Groups Index:
Work Topics  Activities GAC Working Groups

SEARCH WORKING GROUPS: €@———————————— Search Working Groups
ENTER KEYWORD Active Groups Date Formed

ACTIVE WORKING GROUPS & OTHER GROUPS: DATE FORMED:
GAC Technology Task Force to Create New GAC Website Jun 01,2015
GAC Underserved Regions Working Group Feb 12,2015
GAC Working Group on GAC participation in NomCom Sep 22,2015
GAC Working Group on Human Rights and International Law Feb 08, 2015
GAC Working Group on Public Safety Sep 09, 2016
GAC Working Group on Revisions to the GAC Operating Principles Jun 25,2015
GAC Working Group on Under-Served Regions Apr 14,2015
GAC Working Group to Examine the Protection of Geographic Names in any Future Expansion of gTLDs Aug 09, 2013
CLOSED GROUPS: DATE CLOSED:
GAC Working Group on Government Engagement Strategy ¢ Closed Groups Dec 02,2015
GAC Working Group on gTLD Related Issues Aug 09, 2013
GAC Working Group on Capacity Building and Outreach Date Closed =——————>p>| Jun 25,2013
GAC Working Group on Early Warning and New gTLD Advice Procedures Apr 13,2013

Note the following elements of the Working Groups Index:

e Search Working Groups: Search field that allows the user to search for Groups by
keyword(s)

e Active Groups: This element is a list of currently active Working Groups and Other
Groups

e Date Formed: This element is specified on the Working Group content as the date the
Group was formed

e Closed Groups: This element is a list of currently closed Working Groups and Other
Groups

e Date Closed: This element is specified on the Working Group content as the date the
Group was closed

The following screenshot illustrates the contents of a Working Group:
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Work Topics  Activities GAC Working Groups

ton I_Send Tor Translation | ,/ \ GAC Technology Task Force to Create New GAC Website
GAC Technology Task Force

to Create New GAC Website A GAC sponsored and ICANN supported project to redefine and reimplement the necessary components of the
/ GAC Website on a more mature content management platform, Within this space, you will find all the materials

Description needed to become informed on the project, track our progress, and share any feedback you may have.

Work Stream & Deliverables m—rre—r—

ISeeTcrmsofRelcrmce. ]—» Terms of Reforence Link o )

Meetings & Records
Chair Name CHAIR: - SUPPORT:

Members & Country ’ Tracy Hackshaw, Trinidad & Tobago| =< Tracey Independent Secretariat

\l K 10 o Support]l><)
Terms of Reference STATUS: .a

Suppont

Active, Group formed 01 Jun, 2015

Miscell R = =
eeTantous Tesoures Work Stream & Associated Deliverables
TIVITIES: e At iae STATUS:
Establish Technology Task Force Completed
nks . . . ATty Slalus s— .

o / GAC Website Introduction Videos Active

Work Stream & Assocated Debverables Section Meetings & Records

Mee A Re 4 s '4//'
Members
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Chak Name & Counyy s

L e ——

oc-,(.—\«,—’

Torms of Reforence Section ee——pp

Torms of Referance Text

CHAIR: |
Tracy Hackshaw, Trinidad & Tobago

Uink %0 email Chair

SUPPORT:
Tracey Hind, Independent Secretariat Support

MEMBERS: * 4
Miguel Ignacio Estrada, Argentina Chris Gift, ICANN Staff
Tepua Hunter, Cook Islands Jeff Salem, ICANN Staff
Rika Tsunoda, Japan Steve Allison, ICANN Staff
Nicolas Caballero, Paraguay Jackie Moyer, ICANN Staff
Choon Sai Lim, Singapore Alex Hutson, ICANN Staff
Gary Hunt, United Kingdom Karine Perset, ICANN Staff
Ryan Caroll, United States Julia Charvolen, GAC Support Staff
OBSERVERS: Support Name
& Tdle
Jon This Group Bution e Join This Group Uink 10 email Support
Terms of Reference

verview

ICANN matures as a community, there is a need to improve the processes and tools that support the various

nizations that participate in the community. To this end, the GAC Website represents an opportunity to create
website that has greater flexibility in the creation and management of content as well as to better align with the
ay the GAC performs its daily functions.

urrent Situation

jSers.

ruppon staff.

The existing GAC website (Confluence Wiki) was established without clear business requirements and the key

udiences were not well defined. The existing wiki platform does not perform well as a website and as a result, it
difficult to organize and find information, not intuitive, and prone to errors. The GAC secks to upgrade their web
esence based on a set of recommendations that followed a set of interviews with GAC members and general

The following comments about the GAC website were provided during ACIG's consultations with ICANN IT and
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[Reported strengths:

“User-friendly, ability to collaborate, feature-rich, nice appearance.”

“Useful as a collaborative tool, with spaces for [collaboration] dedicated to each Working Group for example
Terms of Relerence Section s Im]"”’m"mmmu‘hxm’h‘-

“The wiki is 3 good dox t rmanagement system if used properly.”

|Reported weaknesses:

“It's not actually a website and has a hard time functioning as one.”

“[The GAC website is] not particularly appealing and welcoming.”

“The graphics don't work well, there are only specified styfes and templates you can use to do page design,
and it's not very pretty to look at.”

“Custom-theme makes some customization options difficult or not possible; custom-theme has been
buggy.”

“Links have an unwieldy structure (some are unpresentable as other than hyperlinks) and also break for no
apparent reason. [This lack of] permanence is not really ideal for a repository.”

“The current structure of the website is far from intuitive when looking for information - and some
[information] is stored on multiple pages, without links.”

“Not user friendly. You have to go through too many steps to access one page [in order to update it]. Each
time you go onto another page you have to re-enter your credentials even if you are logged in already.”
“There is no SEARCH function.”

Terms of Fofroon Tex] ee— _’

n coordination with the GAC TTF on the new website, ICANN has documented the following as a summary of the
re issues with the website in support of the GAC's website needs:

The information architecture of the website has become unorganized making it difficult to find important
information or documentation

The existing functionality fails to adequately support online collaboration and revision of work

The static nature of content within the wiki requires significant overhead by support resources to maintain
the website often leading to content that becomes out-dated or conflicting across the website

bjectives

he GAC TTF Work on the new GAC website has been leading the effort, with support from ICANN staff, to architect
new GAC website that will resolve the issues laid out above. The main objective of the project is to, in
onsideration with the new CMS platform, reimagine the processes and approaches the GAC has taken in the
rganization, creation, and publication of content across the entire website such that:

e — —
ICANN |TYPE THE DOCUMENT TITLE | MONTH YEAR | 266



Content is easier to find

Content is presented in more legible formats (both online and offline)
Content duplication is reduced or eliminated completely

Enhance the collaborative nature of the GAC

The day-to-day maintenance on support staff is reduced
Terms of Raforecn Soction sl

These objectives, summarized, are to deliver a website that provides the GAC with an environment that enhances
[::r productivity and organization through improved processes, workflow and has efficient platform support.

ion for the GAC Website

The vision for the GAC Website is one in which GAC support can quickly author and publish content without
aving to reinvent the wheel each time, One of the major hurdles with the wiki-style approach to a website is that
s requires extremely careful planning on a page-by-page basis... for as long as the wiki exists,

For the new GAC website, the plan is remove some of the flexibility provided by a wiki platform and replace with a
re traditional CMS approach. With the CMS approach, it's important that all content be thoroughly considered:

Page Layouts

Terms of Reference Text » Content Templates

Business Logic & Process Flows
Relational Content

These are some of the steps involved with constructing the important content the GAC needs long term, If thought
ut properly, the day-to-day operations of managing the site become less overwhelming: the GAC can focus on
he content itself, not the presentation or organization of it as the site will facilitate those tasks.

This is the vision for the GAC website: one where support staff can create the most important elements of content
r the GAC quickly and consistently every time, So what are those important elements of content? The TTF has
efined the following areas of the site:
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1. News and Notifications - At a minimum, this section of the site is dedicated to surfacing important
documents or other artifacts being published throughout the site that are worth aggregating into a single
location. In addition this section of the site can be used to broadcast important news to the GAC. Longer
term, this section of the site can be fully integrated into email based notifications/alerts tied to
Member/Observer profiles so that user's can get tailed digests of content suited to their needs.

2. About the GAC - At a minimum, this section of the site is dedicated to providing important contextual
information to new members of the GAC and experienced GAC members alike around the Role of the GAC,

Yorms of Refernce Section sm———— the Operating Principles, Leadership and Members & Observer profiles.

3. Advice Registry - At a minimum, this section of the site is dedicated to providing the core documents that
the GAC publishes: Communiques, Advice Statements, Correspondences (Incoming/Outgoing) in an
organized manner. It's critically important to the function of the GAC that this content be organized in a way
that allows better tracking in the future. Longer term, it is expected that the Advice content generated from
this part of the site can be automatically integrated into ICANN's Board Advice tracking system under
development. A full 360 degrees lifecycle for Advice is the ultimate goal, giving the GAC the ability to send
Advice, track that advice and see the impacts and relationships of that Advice in the context of the entire
ICANN ecosystem.

4. Meetings & Record - At a minimum, this section of the site is dedicated to publishing the sessions (whether
remote or in-person) that take place within the GAC. The section will support sessions that are tied to the
broader ICANN Meetings (supplemented by artifacts such as the Agenda) as well as ad-hoc or WG related.
This section will aggregate all this content with the tools to focus on the meetings that are most important.
As the sessions take place, the artifact that come out of those sessions will be able to be captured and
presented throughout the site where appropriate (e.g. Presentation/Briefs, Session Notes, Advice
Statements, Transcripts, etc.). This will give support staff a centralized location to create and publish the
session and any resulting artifacts from those sessions, keeping content organized throughout the site.

5. Work Efforts - At a minimum, this section of the site will facilitate the creation of Groups doing work on
projects. The vision includes a Topic taxonomy and Projects that the GAC wishes to complete that relate to
those Topics. From there, Groups can be associated to those projects. This section of the site is dedicated to
defining the scope of the work to be done, and tracking the progress of that work through to completion. As
documents are created within the GAC to progress a project they should be able to be published quickly.

Terms of ROMO0rCn Tox] se—

Other core functions/considerations in scope:

Site Navigation

GAC Member Profiles / Account Management
Search

Translation

Security

Accessibility

How We Work

The GAC TTF and ICANN Staff are working in collaboration to define and implement the vision of the new website
lor the GAC. ICANN Staff meet at least once a week with the GAC secretariats (internal and external) to show
ogress/status updates on new designs and implementation. From there, the secretariats take our work and
esent to the TTF (ICANN Staff to support discussion/presentation to TTF when appropriate). Feedback is

Terms of Reference Section s———p

Torms of Reteconce Text lected from the TTF and the broader GAC community when appropriate and worked back into sessions with
Secretariats/Staff,
hrough this approach, an iterative process takes shape where ICANN staff can incrementally design, build and
t out functionality and adjust as new feedback informs the discussion. Meeting Minutes are collected in this
oject work space for those interested in a more detailed understanding of the topics under discussion from
i ion.
Miscellaneous Resources
Miscollanoous RISOUOES  e—

Note the following elements of Working Groups:

e Send for Translation Button: This element is the button will package the html page and
prepare it to be translated
e Title: This element is the title specified on the Working Group content
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e Topics Discussed: This element is the topics that have been tagged to the Working
Group

e Anchor Links: This element is the link that will automatically navigate the user to the
section that corresponds with the selected link

e Description: This element if a high-level description specified on the Working Group
content

e Terms of Reference Link: This element is a link to the Terms of Reference section;
similar to the Terms of Reference anchor link

e Chair Name & Country: This element is the Chair Name and Country specified on the
Working Group content

e Link to email Chair: This element is a link to the Chair’'s email specified on the Working
Group content

e Support Name and Title: This element is the Support Name and Country specified on the
Working Group content

e Link to email Support: This element is a link to the Support’s email specified on the
Working Group content

e Status & Date Formed: This element is the Working Group Status and date the Working
Group was formed that is specified on the Working Group content

e Work Stream & Associated Deliverables Section: The elements of this section contain
the Activities that have been related to the Working Group content and their associated
status’

e Activities: This element is the Activities that have been related to the Working Group
content

e Activities Status: This element is the status’ that are associated to the Activities that have
been related to the Working Group content

e Meetings & Records Section: The elements of this section contain Sessions that have
been related to the Working Group content

e Members Section: The elements of this section contain the Chair, Support, Members &
Observers that have been specified on the Working Group content

e Chair Name & Country: This element is the Chair Name and Country specified on the
Working Group content

e Link to email Chair: This element is a link to the Chair’'s email specified on the Working
Group content

e Support Name and Title: This element is the Support Name and Country specified on the
Working Group content

e Link to email Support: This element is a link to the Support’s email specified on the
Working Group content

e Members: This element is a list of the Members and their Countries specified on the
Working Group content

e Observers: This element is a list of the Observers and their Countries specified on the
Working Group content
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e Join This Group Button: This element is a button that will send an email to GAC Support
Staff notifying them a GAC Member would like to join a Working Group

e Terms of Reference Section: The element of this section is the Terms of Reference
related to the Working Group content

e Terms of Reference Text: This element is the Terms of Reference that have been
related via a Document Section to the Working Group content

e Miscellaneous Resources Section: The elements of this section are the File Assets that
have been related to the Working Group content

Creating a Working Group
To create new Working Group content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site
& gacdevO Site Browser

3. Select Working Group - GAC from the Type dropdown list.

Observe  Site Browser Content
e - Y o

& Orcdev Content Search Change She |~

1 E
Official
h Growe Privecy Omeand Dse Date Chair Chair
Title Wl Status Setting Time rormed Cleand Name Cauntry Chair Emall

Figure 67: Figure 50: Navigating to the Content page within the Admin site will show all the Working Groups that have already
been created.

4. Select the Add New Content button on the top right.
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Observe  Site Browser Content
Ctaerve Panpes, Foiders B b ey

& oev0 Content Search Change She |~

o od - showing 1-12 of 12 Export W)
Official
Growe Privacy Dseand Dae Date Chair Chalr
Tithe () Status Setting  Time formed = Name Country Chair Emall
® i us G JOC-wirting Active Py WIS WIS Oiga Cavas Argesting
, Search + & Cear Search Acreng r— 12/ 004M 12:004M
Advanced

5. Complete the following required fields:
Title

URL Title (automatically created based upon the Title)
Group Status (defaults to Active)
Privacy Setting (defaults to Public)
Official Date and Time

Date Formed

High Level Description

Chair Name

Chair Country

Support Name

Support Country

AT T SQ@ 00000
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Observe  Site Browser Content
Ctamve Pages, Folders & Fles  Masage your Se

@ o%dev0  Costent Search

Add/Edit Working Group - GAC

Content  Advanced Properties

* Working Group ~ GAC

W Engish (US) -

Workflow

Step: [nitial State
Assignee: Nobody

Actions
b Sewe
@ Sove/Pusins

Assign Work®ow

& Cancel

Observe  Site Browser
Oteerve Pages, Foiders & fies

@ oscdev0 Content Search

Url:

Tople:
Click Here to Select Categiries

Group Status:

& Active
Closed

Privacy Setting:
& Pubic
Private

(Official Date and Time:

—

Manage your Ste

Add/tdit Working Group - GAC

Content  Advanced Properties

* Working Group - GAC

Mitagish (US) -

Workfiow

Stepe Initial State
Assignee: Nobody

Actions

 Seve
@ Sove [ Pubin
Assign Work®ow

& Carcel

High Level Description:
Fle~ Edt~ Iwert~ View~ Fomat~ Tools ~
forats~ B / N & E X 3 B =

A ® E L 2 v~

e —
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Observe  Site Browser Content

Ctserve Pages, Folders & Flles  Masage v

& 9rsev0 Content Search Add/Edit Working Group - GAC

Content Advanced Properties

Chair Name:
* Working Group -~ GAC
W Englsh (US) -
Chalr Country:
Workfiow
Step: [nitial State
Assignee: Nobody oh [r—
Actions
o Seve Support Name:
@ Seve [ Pudins
Assign Workfiow
& Cancel Support Country:

6. Select Cancel to negate adding the content.
Actions

kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will save the content and not publish it.
Actions

kd Save

& Save / Publish
Assign Workflow

¢ Cancel

OR

Select Save / Publish which will save and publish the content.

Crange Shte (|
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Actions

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Working Group will be published in the Work
Efforts section of the site.

Relating Content to a Working Group

After the Working Group content has been created and published, the Secretariat can relate
Activities, Sessions & File Assets to a Working Group so information from the related content
displays in the Working Group.

RELATING NEW CONTENT TO A WORKING GROUP

To relate new Activities, Sessions and File Assets to a Working Group, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Site Browser tab from the top navigation.

Site Browser Content
Pages, Folders & Files Manage your Site

Figure 34: Navigating to the Site Browser page within the Admin site will show all the editable pages that you are able to modify.

3. On the Site Browser page, within the left pane, click on the working-group folder.

e ——— —
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Site Browser Comtent
Pages, Foicers & Fles  Marage your Site
& 9cdev0 Site Drowser Change Site |~|
Sites and Folders W Engish (US) - o+ Add New ~

ST Name Status Mod User Mod. Date
w arpiwation

prvate
& Sriety
w CONRNG - Qaners - migrated . pubic
® fie-aaset OG- LO-SEVeioD- 3N~ na-Stew . S (en_US) CWG 1o Develcp an LANA Stew. Cobun Oy 04/04/2017 07:32:19 MM
B home QRC WORING Qroud- on: publc. .. . W (n_US) GAC Working Group on Public Amit Mttal O4/00/2017 06 18:54 PM
. mages QOC-WOrking-Qrous-on-gud-r. .. . W (en_US) GAC Working Growp on gTLD R Marr Sabvatierra  O/29/2017 08136149 MM
- ¥ G- WOrKING-GrouG-on-revisl . W (en_US) GAC Working Group on Revis Mace Salvatierra  O3/29/2017 08:36:49 MM
w ANGUAge- MANIONT-servCes

QI WO QFOuUd- O UADEr ... . B (en_US) GAC Working Group on Under- Macc Sahvatierra  QI/23/2017 08:36:49 P
“w engusge: masaged-serv....

foh-mg- framewort - of <rterpr. . W (en_US) Fol WG - Framework of Inter Maor Sabvatierrs OL/29/2017 08136149 P
[ foga
@ [ meeting: GAC-WOrKIng-Grous- to-examin . W (en_US) GAC Working Group to Exarmin Mace Sabvatierrs  O3/29/2017 08:36:48 M
B meetings-records QO WO NG OFOuD-ON- (RS0 .. . S (en_US) GAC Working Group on Capac Marc Sahvatierra  Q/29/2017 00:36:48 MM
w Member-resources QAL WOrING QroUR-ON- QB Pa . . W (on_US) GAC Working Growp on GAC pe. Mars Sabvatierra Q292017 083644 M
. e PIC-WOrking-grous-on-hurman.-... . W (en_US) GAC Working Group on Humen Mo Sabvatierra  ON/29/2017 08:35:48 M
- e QAT WO NG TGS - wOrking . {en_US) GAC Working Methods Working Macc Sahvatierra  O1/25/2017 08:36:48 P
w OPEraIng- prnviples

QR WORING- Qroud-on-Qavern. . W (en_US) GAC Working Group on Gowern. Marc Sahatierrs  Q/25/2017 08;36:48 P
B presertations

PEC-UNderIerved-regionm-war... . W (en_US) GAC Underserved Regions Wer Mt Charvolen 127292016 10:59:30 MM
[ BrACpies- ang-gudelres
w ancnsts Gac-technology-task-force-t . W (en_US) GAC Techaclogy Task Force t Sheve Alson
- work-efforts QA WORING Qroud-On ety . - B (en_US) GAC Working Group on Tarly Jof¥ Salem 1L 016 10:50:49 MM

Figure 68: Clicking the working-group folder in the left pane will show the folders contents in the right pane. Notice that it
includes a list of Working Groups.

4. Double click the Working Group Name in the right pane to open the live editor interface
for the page.
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Site Browser Comtent
Pages, Foicers & Fles  Marage your Site
& oscdev0 Site Browser
Sites and Folders W Engish (US) -
ST Name Menu  Status
w arpiwation
B Briety
w CONRNG - Qaners - migrated P
" Mo paset T owg-to-Seveiop-an-na-stew .
B home T QM WONG Qroud- On Pl .. .
w mages T gac-working-grous-on-ged-r. .. .
b Ll * gac-working-groug-on-revisl .
w ANGUage-MaTagd-services
O WONNG QrOuD- N UNDer . .
“ engusge: managed-serv...
= folowg-framewort-of irterpr. .
o gl
-
® GAC-WOrKIng-Grous- to-examin .
i meetinga-recorth A WONNING OrIuD- 0N CR0N0. .
w Member - resnTes T Oatworing Qrous-on-ac-pa... .
W minstes = gac-working-groug-on-huran-... .
- et T GAC-wOr NG MethOds - wOrking .
w VPeraLNg-prnOples -
DA WORING Qroud- O Qawerm. .
B presertations
= gac-underserved-regicnn-wer.... .
Ll PrnCpies-ans-gusdelres
e - T gac-technology-task-forcet .
B work-efizets M wOrng-Qroud-oneary-. . .

& werking-grovp

- (e

(o v

(e
. (e
- (o
(e
(e

- (o

(o

(e

{en

. (o

(e

- (e

g (on

us)

us)

CWG 1o Develop an LANA Stew.
GAC Working Group on Public

GAC Working Group on gTLD R

) GAC Working Group on Revis

) GAC Working Grosp on Under-

Fol WG - Framework of Inter

} GAC Working Group Lo Exarmin,
5) GAC Working Group on Capac

) GAC Working Growp on GAC pa.
) GAC Working Group on Human
) GAC Working Methods Working
) GAC Working Group on Gavern
) GAC Underserved Regions Wer
) GAC Techaclogy Task Force ¢

%) GAC Working Group on Garty

b Oy

Amit Mt

Marg Sabvatierms

Mace Salvatierra

Marc Sabvatiorra

Marc Sahvatiera

Mare Salvatierra

Marc Salvatierra

Marc Sabvatierra

Mare Sabvatierra

Marc Salvatierra

Marc Sahvatiorrs

A Charvolen

S2eve Alson

Jof¥ Salem

Change Site |~|

4 Add New
Mod. Date

04/04/2017 07:32:19 MM
O4/00/2017 06 18:54 PM
ON/29/2017 08136149 P
O/29/2017 08:36:49 MM
OW/25/2017 08:36:49 MM
ON29/2017 083649
OW29/2017 08:36:48 M
OW/29/2017 00:36:48 PM
Q292017 08;36:48 PM
ON/29/2017 08:36:48 M
OW29/2017 08:36:48 M
OW292017 08;36:48 PM
LU/29/2016 10:59:30 M
12/02/2016 06:57:38 MM

1/29/2016 10:50:49 MM

Figure 69: Double clicking the Working Group Name from the right pane will open the page in its Live Editor which allows the

Secretariat to modify the contents of this page.

5. From the live editor mode, first lock the page for editing.

Preview Live

{4 Lock for Editing

& Publish Page
= Remote Publish Page
& Add To Bundle

6. Select the Add Content button on the page.
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Send for Translation
GAC Technology Task Force
to Create New GAC Website

Work Stream & Deliverables
Meetings & Records
Members

Terms of Reference

Work Topics

Activities  GAC Working Groups

GAC Technology Task Force to Create New GAC Website

A GAC sponsored and ICANN supported project to redefine and reimplement the necessary components of the
GAC Website on a more mature content management platform, Within this space, you will find all the materials
needed to become informed on the project, track our progress, and share any feedback you may have.

See Terms of Reference,

i) | » Add Content
Tracey Hlnq, Independent 3
Support <

Tracy Hackshaw, Trinidad & Tobago 1)

STATUS:

Active, Group formed 01 Jun, 2015

Miscell R e e
eetianeous Resourees Work Stream & Associated Deliverables

TOPICS DISCUSSED

ACTIVITIES: STATUS:

Establish Technology Task Force Completed

GAC Website Introduction Videos Active
Meetings & Records

7. Select New Content from the Add Content dropdown.
Activities

Work Topics GAC Working Groups

GAC Technology Task Force to Create New GAC Website

A GAC sponsored and ICANN supported project to redefine and reimplement the necessary components of the
GAC Website on a more mature content management platform. Within this space, you will find all the materials
needed to become informed on the project, track our progress, and share any feedback you may have.

Send for Translation
GAC Technology Task Force
to Create New GAC Website

Work Stream & Deliverables

See Terms of Reference.
Meetings & Records ; [(RI=TE
i« Add Content
Members Tracy Hackshaw, Trinidad & Tobago == Tracey Hind, Independent S
Support =5
Terms of Reference STATUS: -

Active, Group formed 01 Jun, 2015

Miscell. R . -
feeeflaneous Resources Work Stream & Associated Deliverables

TOPICS DISCUSSED

8. An Add New Content pop-up will display allowing you to add content to sections. The
following content can be added to the following sections:
a. Work Stream & Associated Deliverables section
i. Activity content
b. Meetings & Records section
i. Session content
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c. Miscellaneous Resources section

File Asset content

9. Select the content type you would like to add to the Activity.
10. Complete the required fields (headings in red) for the content type selected.

a. Activity
i. Title
ii. Url (automatically created based upon the Title)
iii. Privacy Setting
iv. Activity Lead
v. Activity Status
vi. Official Date and Time
b. Session
i. Title
i. URL Title (automatically created based upon the Title)
iii. Type (defaults to GAC Meeting)
iv. Status (defaults to Open)
v. Privacy Setting (defaults to Private)
vi. Time Zone (defaults to UTC+00:00 — Coordinated Universal Time (UTC))
vii. Official Date and Time

c. File Asset

Title
File Asset

11.Select Cancel to negate adding the content.

Actions

kd Save

@ Save/

Publish

Assign Workflow

Cancel

OR

Select Save which will save the content and not publish it.
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Actions

kd Save

& Save / Publish
Assign Workflow

& Cancel

OR

Select Save / Publish which will save and publish the content.
Actions

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE:

e Once Save / Publish is selected, the Working Group will be published in the Work Efforts
section of site.

e Selecting Activity or Session will create a piece of content that is attached to a Working
Group but is also independently accessible and will display in their respective site
sections.

e Selecting File Asset will create content in the Working Group and is not an independently
accessible piece of content.

RELATING EXISTING CONTENT TO A WORKING GROUP
To relate existing Activities, Sessions and File Assets to a Working Group, follow the steps
below:

1. Log into dotCMS Admin.
2. Click the Site Browser tab from the top navigation.
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Content
Manage your Site

Site Browser
Pages, Folders & Files

Figure 34: Navigating to the Site Browser page within the Admin site will show all the editable pages that you are able to modify.

3. On the Site Browser page, within the left pane, click on the working-group folder.

Site Browser Content
Pages, Foicers & Fles  Marage your Sioe
& oscden0 Site Browser Change Site (=)
Sites and Folders W Engish (US) - & Add New ~
- Name Meny  Status Mod.User Mod, Date
w appicaion
peivane
Briety
U COMENG-Genen-migrated o
e pavet b OG- LO-SEVEC0- 3N - BNa-STew L B (en_US) OWG 1o Develop an LANA Stew. O Oy 04/04/20 07:32:19 ™
2 home T 0at wOrng 9roud-on- pubic... . B (on_US) GAC Working Group on Public. At Mttal D4/0N/2017 06: 19:54 PM
‘ mages " Qac-wOrking-grou-on-gEd-r... . W (en_US) GAC Working Growp on gTLD R Marr Sahvatienrs  ON/29/2017 08136149 M
N ¥ ® gac-working-groug-on-revisl . B (en_US) GAC Working Group on Revis Mat Setvatierra
g BNGUBgE- MANaQnT-servces
QM WONING QruD- ON - UADeY . B (on_US) GAC Working Group on Under- Mac Sabvatierra
RNgusge: Mataged- serv.
™ fol-wg-framewort-of <rerpr. . W (en_US) Fol WG - Framework of Inter Mo Sabvatiena
= g
o meeting - P gac-working-grous-to-examin . W (en_US) GAC Working Group 1o Examn Mace Sabvatierra  ON/29/2017 06:36:48 M
meetinga-recorts T M- working-9roud-on-capso . S (on_US) GAC Working Group on Capac Macc Sahvatierra
o Membar - esrTes Qe wOring 9rous-on-Qac-pa. . W (en_US) GAC Working Growp on GAC pa Marc Sahvatiera
e = gac-working-groug-on-hurran.... . W (en_US) GAC Working Group on Humen Mo Sabvatierrs  ON/29/2017 08:36:48 M
- o T R WOrRNg- MethOds-working . S (en_US) GAC Working Methods Working Marc Sehvatierra
v VPErILNG- DrNOples = e
T oacrworing groud-on-gavem. . W (on_US) GAC Working Group on Gavern Marc Sahvatierra  QI/25/2017 08:36:48 P
presertations
" gac-undenerved-regicrn-wor. .. . W (on_US) GAC Underserved Regions Wor s Charvolen LU 292016 10:59:30
-] PONCpies- NS Gudelres
. " gac-technolgy-task-force-t . W (en_US) GAC Techaclogy Task Force ¢ eve Abson
& work-efizety QM WOrENG Qroud- On ety . B (on_US) GAC Working Group on Barly Jof¥ Salem
_ werking-grovp

Figure 70: Clicking the working-group folder in the left pane will show the folders contents in the right pane. Notice that it

includes a list of Working Groups.

Double click the Working Group Name in the right pane to open the live editor interface

for the page.

ICANN |TYPE THE DOCUMENT TITLE | MONTH YEAR

| 280



Site Browser Comtent
Pages, Foicers & Fles  Marage your Site
& oscdev0 Site Browser
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Figure 71: Double clicking the Working Group Name from the right pane will open the page in its Live Editor which allows the

Secretariat to modify the contents of this page.

5. From the live editor mode, first lock the page for editing.

Preview Live

{4 Lock for Editing

& Publish Page
= Remote Publish Page
& Add To Bundle

6. Select the Add Content button on the page.
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Send for Translation
GAC Technology Task Force
to Create New GAC Website

Work Stream & Deliverables
Meetings & Records
Members

Terms of Reference

Work Topics

Activities  GAC Working Groups

GAC Technology Task Force to Create New GAC Website

A GAC sponsored and ICANN supported project to redefine and reimplement the necessary components of the
GAC Website on a more mature content management platform, Within this space, you will find all the materials
needed to become informed on the project, track our progress, and share any feedback you may have.

See Terms of Reference,

i) | » Add Content
Tracey Hlnq, Independent 3
Support <

Tracy Hackshaw, Trinidad & Tobago 1)

STATUS:

Active, Group formed 01 Jun, 2015

Miscell R e e
eetianeous Resourees Work Stream & Associated Deliverables

TOPICS DISCUSSED

ACTIVITIES: STATUS:

Establish Technology Task Force Completed

GAC Website Introduction Videos Active
Meetings & Records

7. Select Reuse Content from the Add Content dropdown.
Activities

Work Topics GAC Working Groups

GAC Technology Task Force to Create New GAC Website

A GAC sponsored and ICANN supported project to redefine and reimplement the necessary components of the
GAC Website on a more mature content management platform. Within this space, you will find all the materials
needed to become informed on the project, track our progress, and share any feedback you may have.

Send for Translation
GAC Technology Task Force
to Create New GAC Website

Work Stream & Deliverables

See Terms of Reference.
Meetings & Records o [~T=T
L.« Add Content
Members Tracy Hackshaw, Trinidad & Tobago =% Tracey Hind, Independent Secre™
Support < —
Terms of Reference STATUS: -
Active, Group formed 01 Jun, 2015 -
Miscellaneous Resources - - —
Work Stream & Associated Deliverables E—

TOPICS DISCUSSED
X Cose

8. An Add New Content pop-up will display allowing you to add content to sections. The
following content can be added to the following sections:
a. Work Stream & Associated Deliverables section
i. Activity content
b. Meetings & Records section
i. Session content
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c. Miscellaneous Resources section
i. File Asset content

9. Select the Search button at the bottom of the Search pop-up to execute your search or
select the Clear Search button to clear your search criteria.

Search: Activity - GAC
Content Type: Activity - GAC

Language p -

Title:

Host or -
Folder:

Url:

Cache TTL:
Template:

Privacy Private
Setting: Public

Activity Lead:

Activity  None -
Status:

Discussion
Archive:

Subscribe To
List:

Discussion
Archive II:

Subscribe To

List II: No
Yes
Create
Notification:
| -

ICANN |TYPE THE DOCUMENT TITLE | MONTH YEAR | 283



Sort Order:
Friendly
Name:
Redirect URL:
SEO
Description:
SEO
Keywords:
Page
. FROOOUITIaUmILY o TTansparency
Metadata: + ATRT 1
+ ATRT 2
GAC: + ATRT 3
+ ATRT 4
+ AoC Review
+ CCT Review

+ Specific Reviews
+ WHOIS Review
+ WSIS

I A Search] |# Clear Search |

Figure 72: You can refine your search by entering additional criteria in the Search pop-up and then selecting the Search button.

10.Once the search results display, click the Select button to select the content you would

like to reuse.
Search: Activity - GAC

Friendly
Name:
Redirect URL:
SEO
Description:
SEO
Keywords:
Page
. Y RCCOUTT@UTY o TS parernicy
Metadata: + ATRT 1
+ ATRT 2
GAC: + ATRT 3
+ ATRT 4
+ AoC Review
+ CCT Review

+ Specific Reviews
+ WHOIS Review
+ WSIS

- Search | & Clear Search

Matching Results (11)

Language

B Arabic (SA)

SELECT U B French (FR)

Title

4y &l 35 GAC
PN

Mise en ceuvre
du nouveau site
Web du GAC

url

GAC-

technology-

task-force-
to-create-
new-gac-
website-

implement-

new-gac-
website

GAC-

technology-

task-force-
to-create-
new-gac-
website-

implement-

new-gac-
website

Cache

Privacy
Setting

public

public

Figure 73: Once the content you would like to reuse has been selected, it is attached to the Working Group and you will be
automatically navigated back to the content editor.

NOTE: Once Save / Publish is selected, the Activity will be published in the Work Efforts

section of site.
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Updating Working Groups
To update Working Group content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Site Browser tab from the top navigation.

Site Browser Content
Pages, Folders & Files Manage your Site

Figure 34: Navigating to the Site Browser page within the Admin site will show all the editable pages that you are able to modify.

3. On the Site Browser page, within the left pane, click on the working-group folder.

BN MITIGNT - ServiCes

emyuse mateged serv
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meetings-records
Member - resouTes
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PLTIUNG-PrNCiples
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work-efforts

GAC-WOrKING-GIouG-on-revisl
L WOrRING Orud- O Under
fokmg- framework. of rerpe
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DR WOrKING-Qroud-0n- a0

QAT WOrNG- Qrous-On-Qac-pa.

Qac-WOrking-groug-on-human-

GO WOk NG METNOds - workng
OB WOrRING- QrEud- On- Qe
Qac-underserved-regicrn-wor.
Gac-technology-task-force-t

QO WO Qroud- On- ety

Site Browser Content
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& oecdev0 Site Browser Change Site |~
Sites and Folders W Engish (US) - & Add New ~
Name Menu  Status Mod User Mod, Date
appication
peivane
Briety
CONLRNR-Ganerc-migrated L annd
fie-asset OG- LO-SEVEICD- 3N - BNa-Sew {en_US) CWG 1o Develcp an LANA Stew Chbun Oy 04/04/2017 07:32:19 MM
home QO WO NG QiU o0 Pl n_US) GAC Working Group on Public At Mttal DA/ON/2017 06: 10:54 PM
ges QO WOrking-Grous-on-gd-r. .. o
on

iR RRRRE

L werking-grovp

Figure 74: Clicking the working-group folder in the left pane will show the folders contents in the right pane. Notice that it
includes a list of Working Groups.

4. Double click the Working Group Name in the right pane to open the live editor interface
for the page.

ICANN |TYPE THE DOCUMENT TITLE | MONTH YEAR | 285



Site Browser Comtent
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& oscden0 Site Browser

Sites and Folders
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Sriety
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W Engish (US) .
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putic
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Figure 75: Double clicking the Working Group Name from the right pane will open the page in its Live Editor which allows the
Secretariat to modify the contents of this page.

NOTE: You can sort the Working Group Name column (ascending or descending) by
clicking on the column heading.

5. Select Page Properties to access the content backend so the content properties can be
modified.

Preview Live
Lock for Editing

Publish Page

Remote Publish Page

b‘l‘t‘;{

Add To Bundle

. What's Changed?

I 4 Page Prcpeniesl

dll Page Statistics

e Create New Page

6. After clicking Page Properties, the editor will be displayed. Lock the page for editing by
clicking on Lock for Editing under the Actions menu.
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Actions

4 Lock for Editing

& Cancel

7. Modify any of the following fields:
Title
Topic
Group Status
Privacy Setting
Official Date and Time
Date Form
Date Closed
High Level Description
Chair Name
Chair Country
Chair Email
Support Name

. Support Country
Support Email
Member Name & Country
Observer Name & Country
Create Notification

QTO33 T AT TTQTT0Q00D
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Obsarve Pages, Folders & Fles  Masage your Sae
& Global Page Qacced Ste Browser Add/Edit Working Group - GAC

Content  Advanced Properties

* Working Group « GAC

W Enghsh (US) -

Workflow
Step: [nitial State
Assignee: Nobody
Locked: GAC Secretanat -
Seconds Aga

Actions

o Refease Lock
 Sove

@ Sove / Publish

o Assign Workfow

& Cancel

Mistory
Title:

GAC Technology Task Force &

url:

goc-techrology-task-force-to-create-new-gac-website

Toplec:
Click Here to Select Categories

Group Status:

® Active
Closed

Privacy Setting:
& Pubiic
Private

|Offickal Date and Time:
6/1/2015 * 12:00AM | =

Date Formad:
6/1/2015 v 12:00M | -

Observe  Site Browser Content
Oteerve Pogen, Folders & Mies  Manage your Soe

& Giodel Page Qecdevd Ste Browser Add/tdit Working Group - GAC

Content  Advanced Properties  History

* Working Group - GAC

W Cnghsh (US) -

Workflow
Step: Initial State

Assignee: Nobody
Locked: GAC Secretaniat -

Second's Ao

Actions

of Refease Lock

W Save

@ Save/ Putiisn
Assign Workfow

& Cancel

Date Closed:

High Lavel Description:
Fle> Bt~ Ioet~ View~ Fomst~ Tools~
fForats B / N 6 E X A B =-E-3 W ® E L R V-~

A GAC sponsored and ICANN supportod project 10 redefine and tre of the GAC Webshe on a mone mature
Content management plasions. Withia s soace, you will find all the matenials NOSeS 1 DOCOMe INrmed O the SAOJECL, Rtk U PIOJress,

and shave sy leochack you may have

e —
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Obsarve Pages, Folders & Fles  Masage your Sae

& Global Page Qacoed

Ste Browser Add/Edit Working Group - GAC

Content  Advanced Properties  History

Chalr Name:
* Working Group « GAC
Tracy Mackshaw
W Enghsh (US) -
Chair Country:
Workflow
Trinidad & Tobago
Step: [nitial State
Assignee: Nobody Chair Email:
Locked: GAC Secretanat -
(Seconds Aga)
Actions r Name:
i Reease Lock Tracey Mind
 Sove
@ Save/ Pusisn Support Country:
¢ Assign Workflow Independent Secretariat Support
& Cancel
Support Email:
Site
Obsarve Pages, Folders & Fles  Manage your Sae

& Global Page Qacsed

Ste Browser Add/Edit Working Group - GAC

Content  Advanced Properties  Mistory

* Working Group -~ GAC
W Enghsh (US) -

Workfiow
Steps [nitlal State

Assignee: Nobady
Locked: GAC Secretariat ©

(Seconds Ago

of Refessa Lock

o Seve

@ Sove /[ Putinn
Assign Workfiow

& Cancel

Member Name & Country:
File* Edt~ laert~ \View~
Femats B 7 YU S E

Format = Tools «
E AR =-i=-3

3 R E &L R -
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Observe  Site Browser

Trierve Foges, Fosders b Fies

W Gobal Page pacdev0

Content

* Werking Growp - GAC

W Engiish (US) -

Workflow
Step: Intal State
Assigneel Nodody
Locked: GAC Secretariat :
Actions

Release Lock

Save

Save / Publsh

Assign Workflow

& Cancel

Observe  Site Browser
Ctaarve Pages. Foders & Fies

b Global Page Qaccevs

Content

* Working Group - GAC

My Engish (US) -

Workflow

Steps [nitial State
Assignee: Nobody
Locked: GAC Secretanat

Actions

o Refesss Lock

i Sewe

& Sove /[ Pubish
Assign Work®ow

& Cancel

8. Once the edits have been made, you can either select Cancel to negate the edits

Advanced Properties

Advanced Properties

Content

Mgt yous Ste

Sae Bromser Add/Ean Working Group - GAC

Mistory

Observer Name & Country:

Fie~ EdSt+ Insert> Vew~ Format~

Fomats- B /7 ¥ & E X A B

Tools

EE-3 A @ B | L R

v

Content

Marage yiar Ste

Ste Browser Add/Edit Working Group - GAC

Mistory

P

WYSIWYG | » Language Variables.

Create Notification:

e No
Yo'
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Actions

{' Release Lock
kd Save
& Save / Publish

Assign Workflow

I 4 Cancel

OR

Select Save which will save the edits and not publish them
Actions

{' Release Lock

kd Save

& Save / Publish
Assign Workflow

4 Cancel

OR

Select Save / Publish which will save and publish the edits
Actions

Release Lock

kd Save

& Save / Publish

Assign Workflow

4 Cancel

NOTE: Once Save / Publish is selected, the Working Group will be published in the Work
Efforts section of the site.
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Correspondent

The Correspondent content type is used to create Correspondent’s that are used to populate
the From, To and CC fields on the Outgoing Correspondence. Only Correspondent’s created
will be available to be used in Outgoing Correspondence.

Creating Correspondent

To create new Correspondent content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site

& gacdevO Site Browser

3. Select Correspondent - GAC from the Type dropdown list.

Home Site Browser Content
sis & Dashbos wrs A Fie v

& 9xcden0 Content Search Change Site [~

& Add New Content ~

Ty showing 1-40 of 381 Export 1)
Eiot Professicnal
Legacy Key Name st Name  Title Oraanization Comntry Last Rditor Last E4it Date
- - ’ w ’ ™ Arrit Matial 1213016 8:14MM
Soach ~ f2 Oear Search
¢ = Mg Marisnbre postes et Ces RegubAgue AT MITIM e
Advanced o

Figure 76: Navigating to the Content page within the Admin site will show all the Correspondents that have already been created.

4. Select the Add New Content button on the top right.

Home Site Browser Conten
ssns ree Pages, Foiders & Fuie Marage v
& oscdev0 Content Search Change Site |~
4 Add New Content =
T oA = howing 1-40 of 38
Eiot Professicnal
Legacy Key Name st Name  Title Oraanization Comntry Last Rditor Last E4it Date
- - ’ w ’ ™ Arrit Matial 1213016 8:14MM
Soach ~ f2 Oear Search
¢ = ey s Arvet Mta 2INI016 81130
Advanced
I |

ICANN |TYPE THE DOCUMENT TITLE | MONTH YEAR | 292



5. Complete the following fields:
First Name

Last Name
Professional Title
Organization

Country

Home Site Browser Content

aska & Dashdoad  Pages, folders A Fles  Manage your Ste

©ao oW

& Gecoevd Contert Search Add/tdn Correspondent - GAC

Content

& Correspondent - GAC

Legacy Key!
Wi Enghish (US) -
Workflow
First Name:
Step: Intial State
Assignes: Nobody
Last Name:
Actions
e Save
Aasgn Weerflow [Professionat Titie:
& Cancel
‘Organization:
iCountry:

6. Select Cancel to negate adding the content.
Actions

kd Save
& Save / Publish

Assign Workflow

¢ Cancel

OR

Select Save which will save the content and not publish it.

Change Shte |+
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Actions

kd Save

& Save / Publish
Assign Workflow

¢ Cancel

OR

Select Save / Publish which will save and publish the content.
Actions

kd Save

& Save / Publish

Assign Workflow

¢ Cancel

NOTE: Once Save / Publish is selected, the Correspondent will be available to be added to
Outgoing Correspondence.

Updating Correspondent
To update Correspondent content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Observe Site Browser Content
Observe Pages, Folders & Files | Manage your Site

& gacdevO Site Browser

3. Select Correspondent - GAC from the Type dropdown list.
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Home Site Browser Content
. > oce Pages, Folders & Files  Masage v
& oscdev0 Content Search Change Site |~
& Add New Cont
how 4 8 Export 1)
it Professicnal
Legacy Key Name st Name  Title Oraanization Comntry Last Kditor Last [4it Date
° e Mg Corwn, Co g Orain Co-Chaw Arvit Mitta 2132016 8:14M
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Figure 77: Navigating to the Content page within the Admin site will show all the Correspondents that have already been created.

4. Double click the Correspondent Name in the right pane to open the live editor interface
for the page.

Site Browser Content
2ot s & Miles  Marage v
& secoerd Content Search Change Site |~
o+ Add New en
—Gad = showing 1-40 of 381 Export X)
Pirst Professional
Ledacy Key Name Last Name Tnie Organizaticn Cauntry Lant Editer Last Edit Date
® M us Pring Corwin, € e Coown Co-Ona Ama Mary 12/1 /2016 81140
Search « 4 Clear Search
® M us Jedion Matson — Matson Mstéce postes e des Répubboue  AmE Maty 12/1 /2016 B;13PM
Advanced " .

NOTE: You can refine your search by doing the following:

e Selecting any of the column headings to sort ascending and
descending

AND / OR

e Enter additional data in the Search field on the left and click the Search
button

5. After selecting the Correspondent that you would like to modify, the editor will be
displayed. Lock the page for editing by clicking on Lock for Editing under the Actions
menu.
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Site Browser Content

Pages, Folders & Fles  Marage your St

Globa! Page pacdev0 Contern Searoh Add/Edit Correspandent - GAC

Content History

& Correspondent - GAC

Legacy Key:
| English (US) -
Philip Corwin, Co-Chair
Workflow
First Name:
Step! Intal State
Philip
Assignee: Nodody
Last Name:
Actions
Corwn
[ R Lock for Bating
& Canced Professional Title:
Co-Chalr

6. Modify any of the following fields:

a. First Name

b. Last Name

c. Professional Title
d. Organization

e. Country

Home Site Browser Content
Tanks & Dushdoasd  Pages, folders A Fles  Manage your Ste

& Gectevd Contert Search Add/tdn Correspondent - GAC

Content

& Correspondent - GAC

Legacy Key
Wi English (US) -
Workflow
First Name:
Step: Intal State
Assignee: Nobody
Last Name:
Actions
e Save
Assgn Werkflow [Professionat Titie:
& Cancel
I'B»Munum:
iCountry!:

7. Select Cancel to negate adding the content.
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Actions

kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will save the content and not publish it.
Actions

kd Save

& Save / Publish
Assign Workflow

& Cancel

OR

Select Save / Publish which will save and publish the content.
Actions

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Correspondent will be available to be added to
Outgoing Correspondence.
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Document Section

The Document Section content is added to other content types and published with those parent
content types. The Document Section content type is not published independently. Refer to
other content sections to determine which content types a Document Section can be added to.

File Asset

The File Asset content type allows the Secretariat to upload attachments to be used / attached
to other content types (parent). When the parent content type is published, the attached file
asset will display. When uploading a file, the Secretariat can define the file as a Brief,
Presentation and / or Transcript Document Type. The uploaded file can be as one or multiple of
the Document Types.

Creating a File Asset

To create new File Asset content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Site Browser Content
Pages, Folders & Files Manage your Site

3. Select File Asset from the Type dropdown list.

Home Site Browser Content

& oscdend Content Search Change Site |-

+ Acd New Contert

official

. showing 0 of 947 Export
e e — 5’
earch

VRL Date and Privacy Create
Itie Title Time Setsing  File Name Natfication  Last Editer Last £dit Date

* n

o n
Advanced

Figure 78: Navigating to the Content page within the Admin site will show all the File Assets that have already been created.

4. Select the Add New Content button on the top right.
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Home Site Browser Content
Tosks & Casndoard  Pages, Folders & Flles  Manage your Ste
& oxcoend Content Search
P Ty = showing 1-40 of 947
ornicial
Search VRL Dateand  Privacy
Title Title Time Setzing  Flle Name
® M us) o QUOm.Cs Cuntom vsya? Pubie Custon css
{ Search + &4 Cear Search o 12:00AM
® N us) & Deader.cw header- 1172056 publc header.ces
Advanced o8 12:000M

5. Complete the following required fields:
a. Title
b. Choose a File Asset to upload

Site Browser Content
Poges, Folders & Mies  Masage your Ste

Home
Tasks & Dashboard

& 9sctev0 Comert Search Add/Edit Fle Asset
Content Relationships
Tithe:
+ File Asset
Wi Enghsh (US) -
URL Title:
Workflow

Stepe Inkial State
Assigmee: Notody

Official Date and Timae:

1/1/2016 - 12200~
Acticns
Documaent Type:
i Save Select -

& Save/ Pubish
Assign Workflow Privacy Setting:
® Private
Public

& Carcel

Description:

File Assot:

Cnooss Fle  No fAle chosen

6. Select Cancel to negate adding the file.
Actions

kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Create
Natification  Last Editer

foise Rabest Weashar

faise Rahut Wagaskar

Change Site [+

& Add New Contert ~

Export 1)

AF28/2017 1:14MM

Change Site  «|
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Select Save which will save the file and not publish it.
Actions

kd Save

& Save / Publish
Assign Workflow

& Cancel

OR

Select Save / Publish which will save the file and make it available to be published.
Actions

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the File Asset will be available to be related to content
and published.

Relating Content to a File Asset

After the File Asset has been created and published, the Secretariat can relate Sessions to a
File Asset so the File Asset is available when viewing Session Details.

RELATING NEW CONTENT TO A FILE ASSET

To relate new Sessions to a File Asset, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.
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Site Browser Content

Pages, Folders & Files

Manage your Site

3. Select File Asset from the Type dropdown list.

Home Site Browser Content
aks & Dashdoand  Pages, Folders & Fike

@ osBev0 Content Search

........

L Search v Ba Cear Search

Advanced

W (on_US

e

Reacer.ces

VRL
Titke

officlal
Date and
Time

o~

Privacy
Setting  File Name

Pl

Create

Natification  Last Editer

Rates Wogasear

Rahudt Wagaskar

Change Site [~

& Acd New Cont

ot

Export )

Last Edit Date

4/28/2017 1:140

Figure 79: Navigating to the Content page within the Admin site will show all the File Assets that have already been created.

4. Double click the File Asset Title in the right pane to open the live editor interface for the

page.
Momre Site Browser Content
Tasks & Dashboars  Poges, Tolders & Pies  Masage v
& 9rcte0 Coment Search
Type » w

Thie

uny
Teie

Officiad
Rate and
Tine

NOTE: You can refine your search by doing the following:

e Selecting any of the column headings to sort ascending and descending

AND / OR

Privacy

Sefting fle Name  Netification  Last Editor

Creete

Change Sie [~

Expe

Last Bt Date

e Enter additional data in the Search field on the left and click the Search button

5. After selecting the File Asset that you would like to relate a Session to, the editor will be
displayed. Lock the page for editing by clicking on Lock for Editing under the Actions

menu.
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Home Site Browser Content
Tasks & Dashboars  Pages, Folders & Mies  Manage your Ste

Ghotal Page oa0dev0 Content Search Add/Ean Flle Asset

Content Relationships History

+ File Asset
Tithe:
Wi Enghsh (US) -
Alex's Test
Workflow
URL Tithe:
Step: [nnial State
slex-s-test
Assigmee: hotody
Official Date and Time:
Acticns 1/1/2016 v 12200PM ~*
B Lock for Eding
Type!
& Cancel
Select >
Privacy Setting:
o Private

Public

6. Once the File Asset has been locked, select the Relationships tab.

Home Site Browser Content

Tasks 8 Cushboad  Peges, Poiders B Fles  Marage your Soe

w Goba! Page Pecoevd Contert Search A4 /LI Fle Asset
Content | Relationships | Mistory
File Asset
Title:
W Enghsh (US) »
Alex's Test

Workflow

URL Tithe:

Step: Intial State .
alex-3-tost
Assignee; Nobody
Locked: GAC Secretariat Offickal Date and Tiese:

1/1/2016 * 12:00PM +

Actions
Document Type!
£ Release Lock
Select -
el Seve
Save / Publish
ol Privacy Setting:
Aawgn Workfiow & Privete
& Cancel Pudiic

7. From the Relationships tab, select the Relate dropdown list.

Home Site Browsar Contemt
Toses & Dasdbonsd  Pages, Fodders & Ples  Manage ponr Se

Global Page gaczev0 Content Search AGS/ Bt File Asset

Content Relationships History

Sesslon - GAC: Parent (MeetingGac-FlleAsset)

official Start S gng International
Title URL yype Privacy Time o oom Recording O™t Dt e Date oot Par Pant S
Title Setting Zome and and € and  OoM e e eote, Numbers
Time  Time Time limk
Titte
e —
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8. Select Relate New Content from the Relate dropdown list.

Home Site Browsaer Contest
Toshs 8 Dasdbonsd  Pages, Fodders & Pies  Manage »
Global Page geccev0 Content Search A/ Edit File Asset
Content  Relationships  History
Session - GAC: Parent (MeetingGac-FlleAsset) . Relate| «
Official  Start :‘::: tnd — — International
Tithe URL Type e y Thme Room Recording Oete Dete Time Date Participation Participation Participation Phone
Title Setting Zome and and URL and URL Phens Acoess O Numbers
Time Time Title Time limk

9. Complete the following required fields:

Title

URL Title (automatically created based upon the Title)

Type (defaults to GAC Meeting)

Status (defaults to Open)

Privacy Setting (defaults to Private)

Time Zone (defaults to UTC+00:00 — Coordinated Universal Time (UTC))
Official Date and Time

Observe  Site Browser Content
Otwerve Pages, fokders & Fles  Masage your Ste

@ ~oapoow

& a0 Connert Search AGG/E0R Sesson - GAC Change Site |~
Content Remote Participation Relationships
Title:

£ Sesslon - GAC

it (US) -

" Eng
Waorkflow -m

Step! Inval State

Assignee: Nobody

Actions
l Save atus:
& Save/ Pubish & Open
Assign Workflow Choo

& Canced

Privacy Setting:

@ Private

Public

Topic:

Cick Mere 1o Select Categories
Tkme Zone:

UTC+00:00 - Coordnate | ~
I |
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Observe  Site Browser Conten
Ctasrve Pages, Folders & Fles  Manage v
& sected Cortent Search ASd/Eait Session - GAC Change She [+)
Content Remote Participation Relationships

Official Date and Time:
£ Sesslon « GAC

M Engits (US) -

Start Date and Time:
Workflow

Step: Intial State

Assignee: Nobody End Date and Time:
. .
Actions
o Save Lead(s):
@ Save/ Publish Fle* Edt~* lset View~s Fomat~ Tools~
Assign Workfiow fomus> B /7 VY S E X A B - -3 WA B & &L 2 «-~

& Cancel

10.Select Cancel to negate relating new content to the File Asset
Actions

kd Save
& Save / Publish

Assign Workflow

& Cancel

OR

Select Save which will create the new content that was related to the File Asset and not
publish

Actions

kd Save

& Save / Publish
Assign Workflow
& Cancel

OR

Select Save / Publish which will create the new content, relate it to the File Asset and
save / publish
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Actions

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Session will be published in the Meetings &

Records section of site and the File Asset related to the Session will be published as well.

RELATING EXISTING CONTENT TO A FILE ASSET

To relate existing Sessions to a File Asset, follow the steps below:

—_—

Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Site Browser Content
Pages, Folders & Files Manage your Site

3. Select File Asset from the Type dropdown list.

Home Site Browser Content
Pages, Foiders A Fue

acax A Duastsoad

@ osBev0 Content Search

........

L Search v Ba Cear Search

Advanced

VRL
Titke

officlal
Date and
Time

o~

Privacy
Setting  File Name

Pl

Create
Natification  Last Editer

Rates Wogasear

Rahudt Wagaskar

Change Site [~

+ Acd New Contertt

Export )

Last Edit Date

A/28/2017 1: 140N

13PN

Figure 80: Navigating to the Content page within the Admin site will show all the File Assets that have already been created.

4. Double click the File Asset Title in the right pane to open the live editor interface for the

page.
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Moo Site Browser Content
Tawks & Dasbboare  Pages, Folders & Mes  Masnage v
& 0r0tev0 Contest Search Change She |~
+ Add New Conter
Tyor: [Foe Asset = showing 1-40 of 948 Export X)
Officiad
uRs Rateand  Privacy Craste
Thie Tnie Tine Setting  Flie Name Notification  Last Editor Last Bt Date
® Sien us Alex's Test sex-s V016 vate  Soreen Shot  false GAC Secretarat S/1/2047 61306
Search « 4 Cea 2ech ~
Advanced -
- - ) 1 “
LR . o 16 N ‘ -
. - M
.« W 916 ™ 8 -
ou
- - . ] M
4

NOTE: You can refine your search by doing the following:

e Selecting any of the column headings to sort ascending and descending

AND / OR
e Enter additional data in the Search field on the left and click the Search button

5. After selecting the File Asset that you would like to relate a Session to, the editor will be
displayed. Lock the page for editing by clicking on Lock for Editing under the Actions
menu.

Homne Site Browser Content
Tasks & Dashboars  Poges, folders & Mies  Masage v

odcde Cennent Search Add/Edn Flle Asset

File Asset
Tithe:

Wi Enghsh (US) ~
Alex's Test
Workflow
URL Tithe:
Step: [nnial State

Assigmee: Nobody
Official Date and Time:

/172016 - 1200~

Document Type

Privacy Setting
e Private

Public

6. Once the File Asset has been locked, select the Relationships tab.
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Home Site Browser Content
Tasks 8 Cushdosd  Pepes, Poiders B Fles  Marage v
Guoba! Page Jecoev) Contert Search ASd /LI Fle Asset
Content Relationships Mistory
File Asset
Tithe:
Mingish (US) -
Alex's Test
Workflow
URL Tithe:

Step: Intial State
Assignee: Nobody

Locked: GAC Secretariat

Actions

e Save
@ Save / Publish

Aawgn Workfiow

alex-3-test

Offickal Date and Tiese:

1/1/2016 - 12200PM | =
Docwment Type!
Select -

Privacy Setting:
@ Private
Puiic

7. From the Relationships tab, select the Relate dropdown list.

Home Site Browsar Contest

Toshs & Ousdbonsd  Pages, Fosders & Pies  Masape p
Global Page geccev0 Content Search AS2/Edit File Asset
Content  [Relationships|  History

Session - GAC: Parent [MeetingGac-FlleAsset)

Tithe

Official
Date
and
Time

URL Privacy Time

Title TYP® Setting Zome Room Recording

Start
Date
and

Time

8. Select Relate from the Relate dropdown list.

Home
Tasks & Dashbond

Global Page

Content

Session -

Site Browsar Contest
Pages, Folders & Fies  Manage v
geccev0 Cortent Search AS2/Edit File Asset
Relationships  History

GAC: Parent (MeetingGac-FlleAsset)

Official
Date
and
Time

URL Privacy Time

Title TYP® Setting Zome Room Recording

Start
Date
and

Time

9. Once Relate is selected, a Search pop-up will display. Select the Search button to
return all results or enter criteria in any of the Search fields to refine the Search results
returned or select the Clear Search button to clear your search criteria.
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URL URL Phene Access Code S
Time link
Title
—
|307



Search:

Minutes:
Action Items:

Remote
Participation
URL:

Remote
Participation
Phone:

Remote
Participation
Access Code:

International
Phone
Numbers link:

I 4 Search I I & Clear Search ]

Figure 81: You can refine your search by entering additional criteria in the Search pop-up and then selecting the Search button.

10. Select the checkbox next to the Session you would like to relate to a File Asset.

Search:

Language

Title:

Host Folder:

Type:

Privacy
Setting:

Room:

Recording:

Start Date
and Time:

GAC Meeting
GAC Working Group Meeting
GAC Break

Private
Public

Matching Results (592)

[ ™ engish (us)

11.0nce the checkbox next to the Session that you would like to relate to a File Asset is
selected, select the Relate button at the bottom of the page.
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GAC Working working«
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Test test-
Sesslon02-05-  session02-
17::00:11:539  05-17-00-
11-539
~test-
BQ Test : cor‘()l
i -
W English (US) Session01-05- 05”” 23 gac private uTC
17::23:50:878
50-878
gac-
GAC Working working-
Group group-
B enalieh 1116 MeetingBQ meetingbq- Axmwn nublie e Ma
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Search:

Language

Title:

Host Folder:

Type:

Privacy
Setting:

Room:

Recording:

Start Date
and Time:

Sl English (US)

S English (US)

) GAC Meeting
1) GAC Working Group Meeting
) GAC Break

") Private
) Public

Sl English (US)

12.Select Cancel to negate adding the content.

Actions

o' Release Lock

kd Save

& Save / Publish

Assign Workflow

& Cancel

OR

MeetingBQ
Test
Session26-04-
17::18:44:03

GAC Working
Group
MeetingBQ
Test
Session26-04-
17::17:02:512

GAC BreakBQ
Test
Session26-04-
17::18:36:988

Select Save which will save the content and not publish it.

Actions

o' Release Lock

kd Save

& Save / Publish

Assign Workflow

& Cancel

OR

meetingbq-
test-
session26-
04-17-18-
44-03

gac-
working-
group-
meetingbq-
test-
session26-
04-17-17-
02-512

gac-
breakbq-
test-
session26-
04-17-18-
36-988

gacwg

gacwg

gacbreak

public

public

public

uTcC

uTc

uTC

Hall A

Hall A

Next @
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Select Save / Publish which will save and publish the edits.

Actions

Release Lock

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the Session will be published in the Meetings &

Records section of site with the File Asset attached.

Updating File Assets

To update File Asset - Translatable content, follow the steps below:

1. Log into dotCMS Admin.
2. Click the Content tab from the top navigation.

Site Browser Content
Pages, Folders & Files Manage your Site

3. Select File Asset from the Type dropdown list.

Home Site Browser Content
nooad  Pages, Folders & File

@ osOe0 Content Search

........

, Search +* &4 Cear Search

Advanced

VRL
Titke

officlal
Date and
Time

o~

Privacy
Setting  File Name

Create
Natification  Last Editer

Rahudt Wagaskar

Last Edit Date

/2872017 1:14MM

Figure 82: Navigating to the Content page within the Admin site will show all the File Assets that have already been created.

4. Double click the File Asset Title in the right pane to open the live editor interface for the

page.
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Home Site Browser Content
Tasks & Dashboars  Poges, Tolders & Pies  Masage v
& 9r0tev0 Contemt Search Change Site -
o+ Add New Content =
Type: | Fie Asset = showing 1-40 of 948 Export X)
Officiad
Searce uRs Rateand  Privacy Crante
Thie Tl Tine Setting  Flie Name Notification  Last Editor Last Bt Date
PO - - A -
. Search ~ £ Cear Search [ 3 -
Advanced AM.png
L . 11/201 R g -
AM
. N . dercss 00 | hess < 16 ve J ‘ I
v
. N wee o ™
. n o M-hea 216 ~ 4 8:330M
ou
« W™ s > ve 4 2AM
12:00AM n
on >
2.

NOTE: You can refine your search b);:joing the following:
e Selecting any of the column headings to sort ascending and descending
AND /OR
o Enter additional data in the Search field on the left and click the Search button

5. After selecting the File Asset that you would like to relate a Session to, the editor will be
displayed. Lock the page for editing by clicking on Lock for Editing under the Actions

Homne Site Browser Content
Tasks & Dashboars  Poges, folders & Mies  Masage your S
+ Page 0900ev0 Cornest Search Add/Ean File Asset
Content Relationships Mistory
File Asset
Tithe:
Wi Englsh (US) ~
Alex's Test
Workflow
URL Tithe:

Step: [Nyl State
Assignee: hotody
Official Date and Time:
Acticns

& Carce

/172016 v 1200PM ~

Document Type

Privacy Setting:
@ Private
Public

6. Modify any of the following fields:
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a. Title

b. Official Date and Time
c. Document Type

d. Privacy Setting

e. Description

f. File Asset

g. Create Notification

Site Browser Content

Poges, Posders B Fles  Marage your Soe

o G0 Page Qa0dev0 Cornent Search Add/Ean Flle Asset

Content Relationships History References

Tithe:

. File Asset

GAC Website User Guide
Wi Enghsh (US) -

URL Title:

Workflow Qac-website-user-guide

Step: [nnial State
Assigmee: Nobody Official Date and Time:!
Locked: Alex Mitson N2/2007 =) [7:0AN | =

Document Type:

Activity Additions! Resow  »

£ Roease Lock

= Sewe Privacy Setting:
& Save [/ Pubish ® Private
Public
Assign Workflow
& Cancel
Description:

GAC Website User Guide

File Asset:
Cownioad
GAC User Guide.pd! 3¢ Remove @ info
Resource Link: [activity/orivate/GAC User Guide paanguage id=1
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Site Browser Content

Fages,

Gicbal Page Gecsevd

Folders & Files  Manage your Ste

Contert Search ASd/Edit File Asset

Coment Relatonships History References

metahithor

< Flle Asset
metaSaveOote
MEngish (US) ]
creationDate
w dcvermaCreated
orkflow
MleSire
Step: Intial State
PrOdacer

Assignee: Nobody

Locked: Alex Hutson

xmpCrestortoot

@cCreator

231Md Ned

Actions
metakeywors
£ Release Lock
o Save Show On Menwu:
@ Save/ Pubiish
Assgn Workfow
Sort Order:

& Cancel

Create Notification:

. No
Yes

U
Alex Mtson

2017-05-02716:16: 242
2017-05-07T16:16:242
2017-05-02716: 16242

24147038

Mac OS X 50.11.6 Quarntz POFContent
Word

Adex M tson

2017050271818 242

7. Once modifications have been made, you can either select Cancel to negate the edits.
Actions

4

@
-

' Release Lock

Save
Save / Publish

Assign Workflow

%

Cancel

OR

Select Save which will save the edits and not publish them.
Actions

4

' Release Lock

Save

o
-

%

Save / Publish
Assign Workflow

Cancel
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OR

Select Save / Publish which will save and publish the edits.
Actions

Release Lock

kd Save

& Save / Publish

Assign Workflow

& Cancel

NOTE: Once Save / Publish is selected, the File Asset will be available to be related to content
and published.

Translations

Search

Site Search
Local Search
Search Results

Refining Search
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Privacy Settings

Privacy Settings are managed separately for every piece of content. They can be specified at
the time the content is created and updated at any time within the Admin console.

Private

When content is published with a Privacy Setting of Private, only logged in GAC Members will
be able to view the private content.

Public

When content is published with a Privacy Setting of Public, any site visitor will be able to view
the public content.

Create Account

Disable Account
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